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General info

Please read the information on safe use of this software.

1.1

About Viewbox
Viewbox version 4.1.0.
Copyright © 2020 dHAL Software, Kifissia, Greece. All rights reserved.
No parts of this work may be reproduced in any form or by any means - graphic, electronic, or
mechanical, including photocopying, recording, taping, or information storage and retrieval systems without the written permission of the copyright holder.
Products that are referred to in this document may be either trademarks and/or registered
trademarks of their respective owners. The publisher and the author make no claim to these
trademarks.
We strive to offer prompt and comprehensive user support for this product. If you have any
problems, comments, suggestions or require more information, you may contact us at the following
addresses:
Mail address:
dHAL Software
6 Menandrou Street,
Kifissia 145 61,
Greece
Fax: +30-210-6233211
E-mail: dhal@dhal.com
Alternate e-mail: dhal@otenet.gr
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Web Site: http://www.dhal.com
Any comments, suggestions or bug reports are most welcome.
This software is designed for cephalometric analysis and is for professional use only. Maximum
resolution for landmark digitization is 0.1 mm (software limit). Recommended resolution for
scanning of cephalometric radiographs is 150 dpi, which will result in a pixel size of 0.17 mm (6
pixels / mm).
This Help Manual was last edited: 27/9/2020.

Acknowledgements
Supported by the EU FP6 Marie Curie Action MRTN-CT-2005-019564 (EVAN: European
Virtual Anthropology Network).
For installation, Viewbox uses the Inno Setup Compiler 6.0.2, Copyright © 1997-2019 by Jordan
Russell.
JPEG support is based on the work of the Independent JPEG Group.
Mean and Standard Deviation values for most of the measurements of the lateral cephalogram
were taken with permission from: Riolo ML, Moyers RE, McNamara JA Jr., Hunter WS. An
Atlas of Craniofacial Growth, Craniofacial Growth Series, Volume 2, Center for Human Growth
and Development, University of Michigan, Ann Arbor, MI (ISBN 0-929921-01-1). Linear
measurements have been adjusted for zero magnification.
Icons are based on the work of the Tango Desktop Project (http://tango-project.org/).

1.2

License Agreement
End User License Agreement.
BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE, YOU AGREE
TO BE BOUND BY ALL OF THE TERMS AND CONDITIONS OF THIS LICENSE
AGREEMENT.
dHAL Software hereby grants you, the user, a nonexclusive, limited license to use the software
according to the terms and conditions of this agreement.
This software is provided "as-is", without any express or implied warranty.
While every precaution has been taken in the preparation of this document, the publisher and the
author assume no responsibility for errors or omissions, or for damages resulting from the use of
information contained in this document or from the use of programs and source code that may
accompany it. In no event shall the publisher and the author be liable for any loss of profit or any
other commercial damage caused or alleged to have been caused directly or indirectly by this
document. In no event shall the author be held liable for any damages whatsoever arising from the
use of or inability to use this software. The software is not fault-tolerant and is not designed,
manufactured or intended for use in environments requiring fail-safe performance, in which the
failure of the software could lead to personal injury.
You will not sell, assign, rent, lease, distribute, export, import, act as an intermediary or provider, or
otherwise grant rights to third parties with regard to the Viewbox software or any part thereof.
You will not undertake, cause, permit or authorize the modification, creation of derivative works,
translation, reverse engineering, decompiling, disassembling or hacking of the Viewbox software or
any part thereof except to the extent permitted by law.
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The software may only be used by competent healthcare or dental care professionals.
Cephalometric analysis is to be used as an adjunct to other diagnostic methods and should not
constitute the main diagnostic criterion for treatment planning. No responsibility will be assumed for
any harm caused by treatment based on cephalometric analysis performed using Viewbox. The
normal values of the cephalometric measurements supplied with Viewbox may not be appropriate
for your patients. You should adjust these values to match the race and ethnic origin of your patient
population.

1.3

CE Certification

Viewbox is a certified Class IIa medical device in accordance with the 93/42/EEC, Annex V,
Medical Devices Directive.
Certification has been provided by the National Evaluation Center of Quality & Technology in
Health S.A., CE 0653.

1.4

Safe Use
Intended use
The main intended use of Viewbox is cephalometric analysis for diagnosis and treatment planning
of patients with orthodontic problems. Secondary uses are measurement of other diagnostic records
(2D or 3D), such as photographs, 3D facial scans, dental casts, and CBCT images.
To support the main and secondary uses, the software offers numerous features. Examples include
image processing and adjustment tools (e.g. brightness, contrast, gamma, histogram equalization,
etc.) and volume and mesh rendering tools (e.g. isosurface threshold adjustment, volume transfer
functions, mesh smoothing, mesh decimation, cropping, etc.).

End users
This software is for professional use only.
Intended user is the orthodontist specialist.
Diagnosis based on CBCT images requires special training. The 2012 EC guidelines
“RADIATION PROTECTION No. 172, CONE BEAM CT FOR DENTAL AND
MAXILLOFACIAL RADIOLOGY, Evidence-Based Guidelines” state that a dentist referring a
patient for CBCT and receiving images for clinical use should have “adequate theoretical and
practical training”.
Colour-impaired users
Measurements can be displayed in colour-coded format. Please make sure that the selected colour
scheme is appropriate for all users. It is strongly recommended to use a colour-impaired safe
scheme.
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Registration
If the word UNREGISTERED appears on the Viewbox title bar, then Viewbox has detected that it
is running on a non-registered computer. This happens when you first install Viewbox, or if you
transfer Viewbox to another computer, or if you upgrade your machine. If you are running in
unregistered mode, Viewbox will continually prompt you for the registration key number:

To register Viewbox, send us the Code number that appears in the Registration dialog box (this can
be accessed from the Help | Register... menu command). We will send you the key number that is
specific to your computer.
Registration entails purchasing a user's license. Please visit our web page (www.dhal.com) for
current prices and license policy. If you do not wish to purchase a user's license you may use
Viewbox in the unregistered (demo) mode by clicking on Later.
Some functions may be disabled in demo mode.

1.6

System requirements
Viewbox requires:
Microsoft Windows 7/8/10.
Viewbox is available in 32-bit and 64-bit versions. The appropriate version is automatically installed,
depending on the operating system.
A display adapter capable of at least 1024x768 and 24 bit colour (True colour, 16 million colours) is
recommended. Hardware acceleration of OpenGL 3D graphics is recommended. Viewbox
requires OpenGL version 2.1 or later.
Viewbox will also run on Intel-based Mac computers under dual-boot (Boot Camp) or Parallels
Desktop for Mac (Parallels, Inc.). However, some functionality may be lost. Viewbox is not
supported for Mac computers.
In order to digitize radiographs you will need one of the following: a digitizer, a scanner, a video
camera or a digital camera.
If you choose to use a video camera or scanner, Viewbox can connect to them using the TWAIN
standard. Otherwise, the image captured must first be saved to your hard disk. Almost all software
that comes with scanners and video cameras can accomplish this. Save the image as a BMP
(bitmap), JPG, or uncompressed TIFF file.
If you choose to use a digitizer, then one with a translucent area for placing a lightbox underneath is
recommended. Almost any digitizer available on the market should work with Viewbox. Viewbox
supports the WinTAB driver for digitizers, but can also communicate directly with any digitizer
using low level commands. Please note that some of the advanced features of Viewbox, such as
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auto edge locking, are not available when digitizing with a digitizer.
Viewbox supports the 3dconnexion SpaceNavigator device.

1.7

Basic concepts
Viewbox is patient-centric, i.e. it uses a hierarchy of objects in which the patient is at the top. Each
Patient can contain various diagnostic records, such as radiographic images and photographs, as
well as Datasets (digitized points for measuring the diagnostic records). The following picture
shows a Patient loaded into Viewbox:

The Patient contains four diagnostic records (a Mesh, a Point Cloud, a Volume and an Image) and
a Dataset. The Dataset is a cephalometric tracing.
Viewbox is not hard-wired to perform a pre-defined set of cephalometric analyses. Actually, no
cephalometric information has been programmed into Viewbox. Viewbox does not have any
knowledge of what a lateral cephalogram is, which points are digitized, which measurements to
perform. All the information regarding the cephalometric points, measurements, analyses,
superimpositions etc. is contained in a Dataset Definition file. Each time Viewbox needs to analyze
a radiograph, it reads the information from such a file. This gives Viewbox significant flexibility
because Dataset Definition files can be created and changed by the user. By far the most common
type of patient record that is used with Viewbox is the lateral cephalogram. However, it is possible
to use Viewbox on almost any kind of radiograph, 3D CT scan, MRI scan, photograph or
photocopy to analyze and measure cephs, panoramic radiographs, facial and profile pictures,
photocopies of dental casts, etc.

Dataset Templates
Each Dataset Definition file describes a Dataset Template. Dataset Templates are the various
records that can be used with Viewbox, such as the lateral ceph, the frontal ceph, the panoramic,
etc. The term 'Dataset Template' does not refer to a particular radiograph of a specific patient, but
to the concept of the Lateral Ceph, or the Frontal Ceph, etc. Dataset Definition files contain
information that describes the characteristics of each Dataset Template, e.g. the names of the
cephalometric points, the measurements and their normal values, the analyses, the superimpositions
that can be performed, etc.

Datasets
A Dataset is a particular instance of a Dataset Template, i.e. it is a specific radiograph of a
specific patient. Datasets are stored in Patient files or Dataset files. If a Dataset is contained in a
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Patient file, then it consists of the coordinates of the digitized points, otherwise it also contains some
information related to the patient.

Files
Dataset Definition files have the extension VBR or VBRX.
Dataset files have the extension CSV. Dataset files are old format files used in versions previous
to version 4. Although version 4 retains compatibility with such files, their use is not recommended.
Use Patient files instead.
Patient files have the extension XML. They contain data specific to each patient (e.g. name, date
of birth, etc.), the Datasets that belong to each patient and links to external files, such as images,
volumes, meshes, etc. Patient files are new to Viewbox 4.
The above files are plain text files and can be opened by any text editor. XML files can also be
opened by internet browsers (e.g. Microsoft Internet Explorer and Mozilla Firefox).
Note: File extensions may not be visible in Windows Explorer. There is an option
to hide file extensions, under the View | Folder Options... menu of Windows
Explorer.
Note: The CSV file extension is also used by other software, e.g. Microsoft Excel.
For this reason, the Viewbox CSV files may be reported as Microsoft Excel Comma
Separated Values files. If you double-click such a file, it will be opened in Microsoft
Excel. Do not save the file from within Microsoft Excel, because it will become
corrupted.

1.8

Screen layout

The main Viewbox window is divided into six parts:
1. The Toolbar is used to gain fast access to commonly used commands.
2. The Icon Area shows all the patients that are currently loaded in the program.
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3. The Display is where the radiographs are drawn and the analysis is displayed. The display takes
up most of the area of the main window.
4. The Objects Panel contains controls for working with objects (meshes, volumes, etc.).
5. The Information Panel shows relevant information and reminders.
6. The Status Bar is at the bottom of the window and shows helpful information, according to the
procedure that is being executed.
Additionally, auxiliary windows may be opened. These include:
Text analysis window. An analysis window may be opened for each radiograph to display the
results of the selected cephalometric analysis in text format.
Extended analysis window. This window can show the cephalometric measurements and
tracings of up to four radiographs in an easy to view comparative way. Extensive customization
options are available.
Movement window to display the translations and rotations that are performed during a surgical
or treatment VTO.
Interactive morph window. This window displays a warped image of a patient's photograph.
Warping is performed in real time, as the user performs a VTO.

1.8.1

Toolbar
The toolbar in Viewbox contains tool buttons for frequently used commands:

All toolbar buttons that have a black triangle at their lower right corner have a pop-up
menu associated with them. To open the menu, right-click on the toolbar button.

1.8.2

Display

2D Display
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The 2D Display represents a drawing surface of size 30 x 30 cm and is used to show twodimensional records (radiographs, images, etc.) and their tracings.
The 2D Display also shows:
The Rotation Center: This is the center around which all rotations take place, when performing a
VTO or when rotating an image. The Rotation Center can be set at any point on the Display by
using the Rotation Center tool

or the Move dialog box.

The Grid: Use the View | Show Grid menu command to show or hide the grid. The colour and
spacing of the Grid can be set from the View section of the Options dialog box. The grid covers
the whole 30 x 30 cm area of the Display.
The Page extents: The part of the Display that will fit on a printed page is shown by a dashed
rectangle. There are three rectangles, one for each of the Tracing, Text and Extended analyses.
You can show or hide each page extent by using the View | Show Print Area menu command.
The page extents will depend on your printer, the margin settings and the zoom values that are
specified in the corresponding options dialog box (Tracing, Text and Extended).
The lower right area holds the Object Widget and Grid tools, and the colour-coding scheme
for the measurements.

3D Display

© 2020 dHAL Software, Kifissia, Greece
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The 3D Display shows three-dimensional records (e.g. volumes from computed tomography).
Click here for information on viewing in 3D.

1.8.3

Icon area

This part of the Viewbox window displays an icon of each of the loaded patients. Viewbox can
show up to 10 patients at the same time. Each patient is represented by an icon in the Icon area.
The icons are arranged vertically in positions 0 (top) to 9 (bottom). Of all the loaded patients, only
one, the current patient, may be active, although all may be visible in the Display.
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Change the size of the Icon area.
Which tracing belongs to which icon?
Move an icon to another position.
Pop-up menu for fast access to commonly used commands.
Showing and hiding an object.
Change the information displayed under the icon.
Highlights and icons next to each object are used to show the Current Patient, the Reference
Dataset, the Morph Source and the Reference Object.
1.8.3.1

Change the size of the Icon area

You can resize the Icon area by dragging its right-hand border with the mouse.

1.8.3.2

Which tracing belongs to each icon?

If you have loaded more than one datasets into Viewbox, it may not be easy to differentiate which
icon belongs to which tracing. In such a case you can have Viewbox draw each tracing in a
different colour and line style and draw a similar line next to the corresponding icon. It then
becomes easy to associate each icon with the correct tracing.
The dataset corresponds to a tracing drawn with a red broken
line (see also Viewing Data for more details).

Icons that correspond to a Dataset Template have a small “T”
at the lower left corner.

Lines and Colours:
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You can select your preferred drawing style from the pop-up menu that appears when you rightclick the Dataset icon. These styles can be edited in the Dataset section of the Options dialog box.
1.8.3.3

Move an icon to another position

The icons of the loaded patients can be re-arranged in the Icon area by dragging with the mouse.
You can also move child objects from one patient to another. For example, to move the image of
the first patient to the second patient, drag it with the mouse:
Before:

1.8.3.4

After:

Icon area pop-up menu

Right-clicking on an icon in the Icon area opens a pop-up menu, which can be used to gain access
to frequently used commands. The commands that the pop-up menu contains depend on the object
that was right-clicked:
Pop-up menu for Patients:

Pop-up menu for Objects (Image, Volume, Mesh, Point Cloud):
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Pop-up menu for Datasets:

Pop-up menu for Dataset Templates:
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In View

If checked then the patient or object is shown in the Display. See Showing
and hiding a patient or object.

Analysis

If checked, Analysis is On, and the results are shown in the Display.

Properties...

Change the Properties of the patient or object.

Save

Save the patient or object to disk.

Pack and Save

Save the patient and all associated objects to disk. A folder is created for
saving the objects.

Close

Unload the patient or object from Viewbox (will not delete it from the disk).

Reference

Set this dataset as the Reference Dataset for cephalometric variables that
measure across two datasets.

Reference Object Set this object as the Reference Object.
Warped by TPS

This object will be warped by a Thin-Plate Spline field.

Reload from File

Reloads the object from the file.

Drawing Style

Select the Drawing Style for a Dataset. Drawing styles can be edited in the
Options dialog box.
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Dataset Templates can be edited from their own extensive pop-up menu.
Most of the above commands can also be accessed from the main menu.
1.8.3.5

Showing and hiding an object

A patient or object can be hidden from the Display by clicking on the eye button next to its icon in
the Icon area. Alternatively, you can use the View | In View menu command.

1.8.3.6

Change the information displayed with each icon

The title next to each icon in the Icon area can be configured to display various information relating
to the patient or dataset. Common options include the name of the patient or the patient's initials
and age.

This title displays the patient's name and age in years: months.
The Dataset was taken when the patient was 10 years 4 months
old.

To change the title of the icons, go to the Dataset section of the Options dialog box:

1.8.4

Objects Panel
The Objects panel shows information about the currently selected object and has controls for
modifying the object. The Objects panel changes, depending on the kind of object selected. The
picture shows the panel when an Image is selected. If the whole panel is not visible, then you can
scroll it into view by dragging on the scrollbar:
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The Objects panel can be hidden by clicking the button on its left side:

1.8.5

Information Panel
The Information panel displays important information and messages. The height of the panel can be
adjusted from its top border:

Messages that are informative only are displayed in black. Messages that may require the user's
attention are displayed in green. Error messages are in red.

1.8.6

Status Bar

The Status Bar consists of four sections:
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The first section shows various information depending on the tool and function selected:
It can show how much an area has moved, when performing a VTO.
The distance between two points, when measuring with the Ruler.
The angle between two lines, when measuring with the Protractor.
Alternatively, it shows a short text explaining the function of a menu item or a toolbar button.
The second section shows the area that has been selected with the selection tool.
The third section shows if sizing of datasets is set to LIFE or XRAY. See Dataset size and Scaling
for an explanation of Sizing. Double-click on this section of the Status Bar to change the setting.
The fourth section shows the coordinates of the mouse cursor in the Display.
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Viewbox Objects
Viewbox works with seven main object types:
Patients
Images
Volumes
Slices
Meshes
Point Clouds
Datasets (also called 'Radiographs' in previous versions)
Patients are at the top of the hierarchy of objects and can contain any number of each of the other
objects.
Images, Volumes, Slices, Meshes, Point Clouds and Datasets can only be loaded
as objects associated with a specific patient.

2.1

Patients
Viewbox can load up to 10 patients. Each patient is represented by an icon in the Icon area. A
patient can have other objects associated with it, as shown here:

Patient data are saved in Patient files, which are in XML format.

Create a new patient
To create a new patient, use the File | New Patient... menu command, or click the New Patient
button on the toolbar:

The Patient Properties dialog box will open, where you can enter the patient's data:
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The file into which this patient will be saved is shown next to the File for Saving... button. If you
wish to change it, click the button.
If you are going to digitize points for this patient, check the Also create new dataset box and
Viewbox will create a dataset for you (you can do this later).

Open a patient
Click here for information on loading patients from disk.

2.2

Images
To load an image, first load a patient, or create a new patient.
Images can be visible both in the 2D and the 3D Display.
Images are not saved in Viewbox files. Viewbox saves a link to the image file inside the Patient
XML file.
See Working with Images.

2.3

Volumes
Volumes are 3D data files created from Computed tomography machines. Viewbox can read
volumes in Analyze 7.5 format and it can create volumes from DICOM slices. Volumes are
external files; only a link to the volume file is saved by Viewbox inside the Patient XML file.
See Working with Volumes.

2.4

Slices
Slices are images that show a slice through a volume or a mesh. A Slice has a Path that it follows
through the volume, and at each position along the path, it shows a sectional cut of the volume (or
the mesh).
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See Working with Slices.

2.5

Meshes
Meshes in Viewbox are 3D triangular surfaces. They are saved in external files.
For information about meshes see Working with Meshes.

2.6

Point Clouds
Point Clouds are collections of points in 3D. They can be created from meshes or volumes and are
saved in external files.
See Working with Point Clouds.

2.7

Datasets
The term 'Dataset', as used in Viewbox, signifies a single tracing of a radiograph or other
diagnostic record. In everyday orthodontic practice, a 'Dataset' would be a tracing of a lateral
cephalogram. However, because Viewbox can work with any type of radiograph and even with
other diagnostic records, such as CT scans, photographs and scans of dental casts, the term
'Dataset' is used instead of 'Tracing'.
Datasets are saved in Patient files that have the XML extension. XML files contain their data in
plain text format, so it can be read by any text editor, such as Notepad. It is advisable however not
to edit the data in these files directly, because Viewbox requires the data to follow strict formatting
rules. If formatting is changed, the data may be unreadable by Viewbox.
Following is an example of the data contained in the Dataset field in a Patient file:
<dataset type="Lateral ceph">
<date>1991-03-11</date>
<magnification>6</magnification>
<comments>Initial</comments>
<points>
<point id="0" x="659.094970703125" y="361.72900390625" />
<point id="1" x="1329" y="244" />
<point id="2" x="1313.01403808594" y="867.223999023437" />
<point id="3" x="1208.65698242188" y="1169.92199707031" />
<point id="4" x="1227" y="1280" />
<point id="5" x="1212.22998046875" y="1323.77099609375" />
<point id="6" x="1169.18200683594" y="1339.17504882812" />
<point id="7" x="563.875" y="1030.82104492188" />
<point id="8" x="513" y="654" />
<point id="9" x="1184" y="545" />
<point id="10" x="1293" y="1060" />
<point id="11" x="1265" y="816" />
</points>
</dataset>

Note: In versions of Viewbox previous to version 4, datasets were saved together
with patient data in CSV files.

© 2020 dHAL Software, Kifissia, Greece

30

2.7.1

Viewbox Help

Dataset Templates
The term 'Dataset Template' is used to refer to the various kinds of diagnostic records. For
example, lateral cephalograms constitute one Dataset Template, frontal cephalograms another, and
profile photographs yet another. Viewbox can work with any kind of diagnostic record because it
holds all relevant information for each diagnostic record separately, in Dataset Definition files. The
information in these files tells Viewbox the names of the cephalometric points, the measurements to
perform, the various cephalometric analyses, superimpositions, etc. All this information can be
changed by the user, allowing almost unlimited flexibility.
Dataset Definition files have the VBR extension. They are plain text files and can be viewed and
edited by any text editor, such as Notepad. It is not advisable to change these files directly because
their structure may become corrupted.
Viewbox is supplied with a few Dataset Definition files to cover the basic cephalometric analyses.
However, if you prefer to set-up things differently, or if you wish to use Viewbox for analyzing
other data (e.g. mouse radiographs for research, TMJ tomograms, MRIs, etc.) you can change the
supplied Dataset Templates or create your own.
See Defining Dataset Templates for detailed information.
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Advanced features
Directional Cursor
Auto Edge Locking
Curves
Interactive Morphing
Aligning Image with Tracing
Morphometrics

3.1

Directional cursor
The problem
A large number of cephalometric points are defined by adjectives such as "the most anterior", "the
most posterior", etc. Examples include point A, point B, Pogonion, Gnathion, Gonion, Menton and
others. Implied in these definitions is a sense of direction. Usually, the Frankfurt plane is taken to
represent the antero-posterior direction, or, if the patient has been positioned in the natural head
position, the true vertical is marked on the radiograph by a vertical plumb line. However, when the
radiograph is scanned and presented on the screen for digitizing, it may not be positioned properly.
The Frankfurt horizontal may not be aligned with the horizontal axis of the screen, or, the true
vertical may not be vertically positioned. This makes it difficult to position the points accurately.
The pictures below show how B point may 'drift' when the radiograph is misplaced in a rotated
position.

The green line shows the vertical axis of the screen. The
radiograph has been positioned with the Frankfurt plane
(not shown) in a horizontal direction. Point B would be
digitized at the tip of the red arrow.

The radiograph has been scanned in a rotated position.
Point B would be digitized inferiorly.
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Opposite rotation. Point B would be placed at a superior
position relative to the true location.

The work-around
To avoid such problems one should make sure that the radiograph is scanned in the proper
orientation. Otherwise, one should try to adjust visually, which is obviously not easy.

The Viewbox solution
Viewbox has a cross cursor that rotates according to the orientation of the Frankfurt horizontal (or
any other reference plane that you specify). All you have to do is digitize Porion and Orbitale first.
This will tell Viewbox the orientation of the Frankfurt plane and it will then adjust the cross cursor
for digitization of the other points accordingly. The pictures below show how the cursor changes
direction and remains aligned to Frankfurt horizontal.

The cross cursor is shown in green.

The radiograph has been scanned in a rotated position.
The cross cursor remains aligned to the Frankfurt plane
and Point B can be digitized correctly.

The orientation of the cursor can be set at any angle. For example, for point Gnathion the cursor is
set at 45 degrees and for point Menton it is set at 90 degrees. The pictures below show this.
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The directional cursor for locating Gnathion.

The directional cursor for locating Menton.

See also:
Auto Edge Lock
Digitized points

3.2

Auto edge locking
The problem
Most cephalometric points are at the edges of skeletal structures. Accurate placement of these
points requires special effort along two perpendicular directions. For example, to digitize point B,
one has to pay particular attention to place the point correctly in the vertical direction along the
outline of the symphysis. Furthermore, care must be taken to digitize the point in the horizontal
direction, so that it falls exactly on this outline and not inside or outside it. This is particularly
important, because any error in this respect will significantly affect the assessment of the
anteroposterior position of the mandible by measurements such as angle SNB and the Wits
appraisal. Although the human eye can determine the edge of a skeletal structure with precision, it
is not always easy to position the mouse and click on the intended target with sufficient accuracy.

The Viewbox solution
Viewbox searches the image of the radiograph and locates the edges of skeletal structures
automatically. When digitizing, there is no need to position the mouse at the precise location of the
cephalometric point because Viewbox will detect the edge and digitize the point there, even though
the mouse cursor may be a few millimeters away. This feature is called Auto edge locking.
Auto edge locking is demonstrated in the animation below. The user is moving the mouse cursor
(the red circle) in the vicinity of Pogonion. The directional cursor is shown by the green and blue
lines. Notice how the blue line always remains snapped on the bony outline of the symphysis.
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To digitize Pogonion, you only have to place the mouse at the correct vertical position. Then click
the left mouse button and Pogonion will be digitized at the intersection of the green and blue lines,
as shown below:

To override auto edge locking, digitize using the right mouse button, and Pogonion will be placed at
the mouse cursor (the red circle in the animation above).
Auto edge locking can be used to snap on the most prominent edge, or on the edge that is closest to
the mouse cursor. Also, it can find the midpoint between two edges, a feature useful in cases
where we wish to digitize a double outline, as is frequently encountered at the lower border of the
mandible. The animation below shows the use of the double outline feature:
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See also: Digitized points

3.3

Curves
The problem
A number of cephalometric points are located by identifying special geometric properties along
skeletal outlines. For example, Pogonion is the most anterior point along the outline of the
symphysis, point B is deepest point in the concavity above the symphysis and point PM
(protuberance menti) is the point where the curvature changes from concave to convex. Such
points can sometimes be difficult to locate because the outline of the symphysis changes gradually
and it is hard for the human eye to pinpoint the correct location. Viewbox features the directional
cursor, which can help in this regard. However, an automated method is also available.

The Viewbox solution
Once it is recognized that points such as those described above, are defined by purely geometric
properties, it becomes evident that it is possible to have the software locate them automatically.
The only requirements are:
1. To identify the skeletal outline on which the points lie.
2. To let the software know the geometric definition of each point.
Viewbox uses curves to identify the anatomic outlines. Curves are line contours that can be
adjusted to follow the outlines of skeletal structures or soft-tissues. Curves are used during
digitization of a radiograph. When you digitize a radiograph, you position the curve close to the
appropriate outline and adjust it to follow the outline. Then Viewbox locates all cephalometric points
that belong to that outline automatically.

Details
Adjustment of curves, so that they follow an anatomic outline, can be done manually or
automatically.
The animation below shows how the user moves points along the curve until the curve takes the
form of the symphysis:
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Most of the times, Viewbox can adapt the curve to the outline automatically. Just click on the 'Fit'
button, as shown below:

After the curve has been adapted to the symphysis, click the Auto All button and Viewbox will
locate the points along the outline automatically. The recording below shows how points
Infradentale, B, Protuberance menti, Pogonion, Gnathion and Menton were located automatically
just by pressing the Auto All button:
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Curves and auto-digitization of points makes it easier and faster to digitize a radiograph, and it also
removes much of the subjectivity in trying to locate the points.
See also:
Curves - Details
Defining curves
Digitizing

3.4

Curves - Details
Curves are manipulated by using the Digitizer tool:
Curves have a 'head' and a number of points along their 'body'. The head and points are marked by
small markers. Around the curve there are icons for executing various commands:

To reposition a curve:
Right-click anywhere with the digitizer tool. The curve will be placed so that its 'head' moves to
the points where you right-clicked. You can also move a curve by dragging one of the small icons
with the double cross arrow.
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To rotate a curve:
Drag one of the markers with the double curved arrows.
To Auto Fit a curve:
Click the Fit button in the digitize dialog box. The curve will attempt to fit on the most prominent
edge along its body. The radiograph image is searched on either side of the curve's body up to a
distance defined by the Hot zone parameter.
Note: To use Auto Fit you need to have an image loaded and set as the Reference
Object.
To manually adjust a curve:
Drag on the markers that lie along its 'body'. When the mouse cursor is positioned on one of the
markers it should change into a thin double cross arrow. This shows that the marker can now be
moved.
To change the number of points:
You may wish to increase or decrease the number of points along the curve, in order to make it
easier to adjust its shape, or to allow better fitting. Use Number of Points in the digitize dialog
box.
To Reset a curve:
To Reset a curve to its original shape and position, click the Reset button in the digitize dialog box.
To automatically locate cephalometric points based on curves:
Use the Auto All or Auto... buttons in the digitize dialog box.
If the curve icons bother you:
Turn them off by right-clicking on the digitizer tool and selecting Curve Icons in 2D from the popup menu:

See also: How to change the appearance of the curve markers.

3.5

Interactive morphing
Viewbox includes an interactive morphing feature that lets you see the changes in your patient's
photograph as you move the skeletal or dental structures with the mouse. This happens in real time
as shown by the following screen recording:
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In the recording above, the user has opened the Morph window that appears on the left. Then, the
mandible is selected on the tracing and translated in a simulation of a sagittal split osteotomy.
Notice how the soft tissues automatically adapt on the tracing. At the same time, the photograph in
the Morph window is morphed so that it follows the soft-tissue outline of the tracing.
The following functions are available from the Interactive morph window:
The Morph Window will show the results of the morph only if the 'Morphing On/Off' icon is
depressed:
To scroll around the window, drag the mouse inside the window.
To zoom-in or -out, use the wheel of the mouse.
Apart from the Interactive Morph window, Viewbox includes four types of morphing algorithms
that can be used to prepare a high quality morph.
See Morphing.

3.6

Aligning an image with a tracing
The problem
When you scan a patient's photograph and try to register it with the tracing, it is a matter of trial
and error to adjust the size and position of the photograph or the tracing in order to achieve a
precise fit.

The Viewbox solution
Viewbox offers two methods of aligning a photograph with a tracing, which are better used
together.
First, try to get an approximate fit. This is accomplished by clicking on two points in the photograph
that correspond to two points of the tracing. This will let Viewbox adjust the photograph or the
tracing and superimpose them, but the fit will only be approximate, because it is very difficult to
locate the points on the photograph with the needed precision. For this reason, Viewbox offers an
automatic method to further refine the fit. This second method automatically detects the outline of
the soft tissue on the photograph and refines the fit in an iterative manner.
The whole procedure is shown below (in a Viewbox 4 beta version). Observe that the user uses
the digitizer tool to mark the Soft Nasion and Soft Menton points on the photograph, and Viewbox
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performs the rough fit. Then the user clicks the Auto Refine button to improve the fit.

For details click here.

3.7

Morphometrics
Viewbox features various functions for morphometric analysis of data. These include Procrustes
superimposition, Principal component analysis (PCA), Thin plate splines (TPS) and sliding
semilandmarks in 2D and 3D.
For more details see:
Superimpositions and Superimposition types
Procrustes and PCA export
PCA Viewer
Sliding groups and Sliding semilandmarks
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Patients are stored in XML files. Each file can contain many patients and each patient can have
many datasets, images, volumes, meshes and point clouds. To load a patient follow these steps:
Select File | Open Patient... from the menu, or click the Open Patient button
The Load Patients dialog window will appear:

To load a patient:
Double click on the list, or click once to select the patient and then click on Load button. The
tracing should appear in the Display. If the patient has Linked Objects, these will also be loaded.
If you do not want to load the linked objects, then click the Include Linked Objects button
to deactivate it.

To load two or more patients:
Hold down the Ctrl key and click on each patient to select. Then click the Load button. If you
select a patient by mistake, you can click again to de-select.

Further selection options:
Use the tool buttons to select all patients, de-select them, or inverse the selection:

To load patients from another file:
If your patients are located in another file, click the Open File button.

Other options

© 2020 dHAL Software, Kifissia, Greece

44

Viewbox Help

Sorting
Click on the heading of each column to sort the patients in ascending order.

Filtering
Use the Filter button to show the Filter area:

Using the Filter, you can select which patients to display, so that you can easily find the one you
want to load. For example, to display only those patients whose name contains 'Helen', enter
'Helen' in the Name box, and click Apply.
Filtering is case sensitive, so 'helen' will produce different results. Wildcards (* or $) are not
supported.
Note: Version 3 files (.CSV) can also be used. In such a case you have the option
to load the selected radiographs into a patient who is already loaded. Use the
Load Into Patient button.

Delete a patient
Deleting is done from the Load Patients dialog box (see above). To delete a patient, select the
patient and click the Delete button:
Deleted patients cannot be un-deleted and are permanently lost.
If the deleted patient had an associated folder for storing its objects, you will be presented with a
dialog box to delete that folder also, or to retain it. See the Pack and Save feature for more details.

Copy patients from one file to another
Use the Copy To... button to copy selected patients to another patient file:

First select the patients you want to copy, then click the Copy To button. You will then be asked
to select the file where you want to copy the patients. You can choose an existing file, or you can
enter a name to create a new file.

Convert to UTF-8
Older versions of patient files were saved in a character encoding that did not permit all foreign
characters to be displayed correctly. If you open such a file, Viewbox will show the Convert to
UTF-8 button:
Click the button to convert your old xml file to the new format that supports all Unicode characters
in the UTF-8 encoding format.
Note: It is recommended to backup your file first. In any case, Viewbox will leave a
copy of the original file and rename it to a file with extension .~1, .~2, etc.
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Digitize
Before digitizing please make sure that you have set the digitizing options correctly. Setting the
Input Device is recommended, although this can also be configured at a next stage.
1.
2.
3.
4.

4.2.1

Create a new Dataset
Acquire the image
Images and Magnification
Digitize the Points

Create a new Dataset
A Dataset needs a patient to belong to, so either create a new Patient or select an existing Patient.
To create a new dataset choose Dataset | New Dataset..., or, click the Create Dataset button:

The New Dataset dialog box will open. Enter the requested data:

1. Select the Dataset Template.
2. Enter the Date Taken (so that Viewbox can calculate the age of the patient for this dataset) and
the magnification (see below). Comments are optional.
3. After entering all data, press OK. The new dataset has been created and Viewbox will proceed
to the next step, which is the acquisition of the image for digitizing.

Notes:
The date format must be the same as that defined in the Microsoft Windows Control Panel. If
you use the wrong format, an error box will open, showing you today's date as an example of the
correct format:
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Magnification is entered as a percentage without the % sign. For example, if the magnification is
10%, enter 10. The magnification is used in case you receive radiographs from different
machines and need to superimpose them. Viewbox can display them by scaling each to life size
according to the magnification (see Dataset size and Scaling).
If you are not certain about the magnification value, you can have Viewbox calculate it later with
the Magnification tool, provided you are digitizing on-screen and a reference ruler has been
included in the radiograph.
The properties of a dataset can be changed later. However, now is the only chance to set the
Dataset Template.

Tip:
If you find yourself entering the same values for each new dataset (e.g. Magnification = 10), set
these as default values from the General section of the Options dialog box.

4.2.2

Acquire the Source
After creating the dataset, Viewbox will proceed differently, depending on the setting of the Input
Device. The default setting is 'Ask Me', and Viewbox will present the following choices:
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If you elect to use a scanner, Viewbox will attempt to communicate with the scanner, so that you
can scan the radiograph. If you elect to load the image from a file in your hard disk, Viewbox will
open the Open Image dialog box and ask you to select the appropriate file. If you wish to use a
digitizer, there is no image to acquire, so Viewbox will proceed directly to the next step, which is
the Digitization of the cephalometric points.

If you have elected to use a Scanner:
Viewbox will attempt to communicate with the scanner:

If the link is successful, Viewbox will open the scanner's interface and let you scan the radiograph
or photograph. Each scanner has a different interface, so you will have to read your scanner's
manual for detailed instructions. In general, the following settings should be set before scanning a
cephalometric radiograph:
Transparency mode (a transparency adapter is required, see System requirements)
Greyscale (8-bit grey)
Resolution: 150 dpi (this is the recommended resolution, however if you wish to digitize at another
resolution, you must set Image scaling accordingly, see Image options ... Image scaling.
Alternatively, use the Object | Resize... menu command after the radiograph has been scanned.)
After adjusting the above settings, click on the Scan button. When scanning is completed, the
scanner interface should close (otherwise close it yourself) and the image of the radiograph should
appear in Viewbox.
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If you have elected to load the image from a file:
Viewbox will open the Open Image dialog box and you can select an image from a file in your hard
disk. Viewbox can load most of the common file formats (e.g. BMP, JPG, JPEG, PNG), some
versions of uncompressed TIFF files (.tif, .tiff) and some versions of DICOM diles (.dcm). It is
assumed that the file has been created by scanning the radiograph at a resolution of 150 dpi,
otherwise, Image scaling should be set accordingly (see Image options ... Image scaling).
Alternatively, you can adjust the image's size after it is loaded by using the Object | Resize... menu
command.

4.2.3

Images and Magnification
Digitizing images is perhaps the commonest procedure. Such images are usually cephalometric
radiographs that have inherent magnification, i.e. the object depicted is larger than its true size,
because of the diverging x-rays of the machine. Magnification commonly ranges from 5% to 15%.
Since different machines produce different magnifications, it is imperative to correct for such
differences if proper superimposition of radiograph tracings is to be performed. Viewbox supports
numerous ways to achieve this, at different stages of the digitization and analysis procedure.
Following is a brief explanation of the common options.

Adjust image size before digitizing (recommended option)
(see also this tutorial)
Once the image has been scanned or loaded into Viewbox, and before starting to digitize points,
adjust its size so that the depicted object is at its true size. To do this, the image should contain an
object of known size that can be used for calibration. In cephalometric radiographs, this is a ruler
on the cephalostat:

1. Use the Ruler tool
to measure the ruler. In the example above, it is evident from the ruler
markings on the cephalogram that the actual size of this ruler is 40 mm, but the ruler measures 44.8
mm, because of magnification:
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2. Right-click on the Ruler tool and select Resize to Ruler...:

3. The Resize Object box will appear. Make sure that the correct value is shown, else correct it
(to 40, in this example). Then click OK:

The image will be resized so that distances correspond to true size. The following image confirms
this. Notice how the markings of the Ruler tool correspond to the marking of the ruler on the
cephalogram:
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4. Now you can digitize the points and all distances will correspond to true size.
Note the following details:
Resizing of the image is performed around the centre of the image. Therefore, the image will no
longer be positioned at the top left corner of the 2D Display. To reposition it, turn off the Ruler

tool, then select the Move Object tool
Display.

and double-click anywhere in the

Because the image is now at true size, if you print it and try to superimpose it on the original
radiograph that you scanned, it will not fit, it will be smaller. Similarly for the tracing.
For the same reason, you should enter zero for the magnification of the Dataset that is based on
this image. The Dataset will also have true size, therefore no magnification.
All measurements will be at true size. If your reference (normal) measurements are based on
magnified tracings, this should be taken into account.

Alternatively, do not adjust image size but set a magnification
for the Dataset
This is recommended if you wish to print a tracing and superimpose it on the physical radiograph.
1. Digitize on the image, without any modifications to it. It is assumed that Viewbox has been
notified of its correct size (i.e. dpi setting) after scanning, or after loading it from a disk file. See
Resizing an image for details.
2. After digitizing, select the Dataset in the Icon Area and use the Magnification tool
to
measure the ruler on the radiograph.
3. Make sure the correct values are in the Magnification box entries, then click Set this
Magnification. The calculated magnification will be placed in the Dataset's Properties. See The
Magnification tool for details of this procedure.
4. Anytime you wish to display the Dataset (tracing) at true size, double-click on the lower right of
the Viewbox window to change the box marked XRAY to LIFE. Viewbox will show all tracings at
their true size, as specified by the magnification of their Properties. See Dataset size for details.
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Digitize the points - Step 1
To digitize points you need to use the digitizer tool (the last tool on the Toolbar):

Note: To digitize a point in the 3D Display, right-click with the digitizer tool. In the
2D Display, both left- and right-click are functional.
Cephalometric points are digitized using the digitize dialog box. The digitize box changes
appearance depending on the point or curve being digitized:

Common features for all points and curves:
Before digitizing any points, select the desired Protocol:

The Protocol determines which points will be digitized and in what sequence.
The point or curve that will be digitized next is shown at the top of the digitize box. To digitize
another point or curve, use the mouse to select it from the drop-down list box, or use the
Previous and Next buttons:
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After you have finished digitizing, click the End Digitization button.

Features for normal points:
Normal points are those anatomic points that you digitize yourself, e.g. point A, Porion, Orbitale.
Multiple digitization
A normal point may be digitized more than once, the purpose of this being to reduce the error in
landmark identification. The number of times that a point has been digitized will appear with a red
number next to the point's name in the drop-down list box. Also, the relative locations of the
multiple attempts to digitize the point will appear in the Error box:

Using the Select next point button
and the Delete button, you can select and delete
any of these multiple digitization attempts. The final position of the point will be the average of the
multiple digitizations.
Auto edge lock
Some normal points may have Auto edge lock enabled and others may not. Usually, points that lie
on osseous boundaries (e.g. A point, B point, Pogonion) have Auto edge lock enabled; this is
determined by the definition of the points in the Template. If Auto edge lock is disabled, the lower
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part of the digitize dialog box will be disabled also:

If Auto edge lock is enabled for a point, e.g. Gnathion, then the lower part of the digitize dialog box
is enabled:

This part of the digitize box shows a graph of the edge response in the image along the long axis of
the directional cursor. The graph may plot the raw pixel intensities, the brightness (which is the
same as the pixel intensities, but smoothed), the first derivative of the brightness (i.e. the change in
brightness from one pixel to the next), or the second derivative, according to the selection in the
drop-down menu:

A strong edge in the image is shown as a high peak (or low trough) of the first derivative, or as a
zero crossing (the plot crossing the horizontal axis) of the second derivative. The red vertical line
shows the position of the mouse cursor. The blue line is the detected edge in the image.
Auto edge locking is used to snap on the most prominent edge in the image, but it can also snap on
the closest edge to the mouse cursor, or at the midpoint between two edges (use the toolbar to
select the appropriate function). This last feature can be used to digitized between a double outline,
such as the outline of the mandibular border:

In the example above, the green lines show the position of the two detected edges and the blue line
is drawn between them. The point will be digitized on the blue line.

© 2020 dHAL Software, Kifissia, Greece

54

Viewbox Help

To override Auto edge lock, use Ctrl+Right-click instead of Right-click.
Note: Auto Edge Lock works in the 2D Display only.

Transfer of coordinates:
Instead of clicking on the image of the radiograph to digitize a point, you can transfer the
coordinates of the point from another radiograph. Just click the Get button. This requires that
another dataset of the same Template is loaded in Viewbox and it is set as the Reference dataset.

Features for curves:
For a general description of curves see Curves. For more details see Curves - Details.
The controls for working with curves are as follows:

Curves can be adapted to the underlying image automatically. Clicking on Fit will adjust the curve
to best fit to the nearest edge in the image. Viewbox will search the image along the curve, detect
the strongest edges that lie close to the curve and then reposition the curve's points to lie on the
detected edges. Hot zone specifies the width of the zone that is search along the curve (in
millimetres). Decrease the hot zone if the curve is already close to the appropriate position in order
to avoid false matches.
Note: To Fit curves you need to have an image loaded and set as the Reference
Object. If possible, Viewbox will set a reference object automatically, otherwise it
will ask you to set it.
Number of points increases or decreases the number of points that make up the curve. If the
curve is smooth, decrease the number of points to make it easier to adjust it. Changing the number
of points repositions the points along the curve at equidistant positions.
Reset will reset the curve to the original shape, size and position.
Auto will calculate and position all digitized points that are dependent on curves. Use this function
after digitizing each curve. To selectively recalculate some points only, use the Auto-locate
Points... menu command from the drop-down menu of the Auto button. Setting the Auto-locate
Always On from the same menu will position the digitized points each time you finish digitizing the
curve and proceed to the next point or curve of the Protocol.
Project will project all curve points on a 3D mesh surface or image. This function is to be used for
3D datasets. If a Reference object is already defined then Project will use that. Otherwise it will
ask you to select the object from the Icon Area.
Delete will delete the last point of the curve. Use the drop-down menu of this button to delete all
points of the curve.

Auto Digitization:
Some points can be digitized manually, as described above, or can be located by Viewbox
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automatically. To locate a point automatically, the appropriate curve must be digitized first. Then,
click the Auto button.
The Auto button has a drop-down menu that can be used to update selected points only. This
opens the Select Points to Update dialog:

Automatic Digitization and other functions:
Clicking the Auto Digitize button will present a menu that includes the option for digitizing all
remaining points of the protocol. This is accomplished by doing a TPS warping of the Template or
the Reference dataset on the currently digitized dataset, using the points that have already been
digitized. Since this procedure does not take into account the radiographic image, the location of the
points will not be precise, but this is a quick way to roughly complete the procedure; precise
repositioning can be done later using the Chooser tool (see How to Perform a VTO).

4.2.5

Digitize the points - Step 2
After all points have been digitized, click the Finish button.
It is a good idea to click the Auto button before you close the digitize dialog box, to be sure that all
points are properly updated.
Before the digitize box closes, you will be presented with information about the digitization. If all is
OK, click the Yes button:

The information presented above shows that 78 points were digitized by the user, zero points were
located by Viewbox using curves, and 13 points were not digitized.
There are times when you may have accidentally clicked twice on the same location, thus digitizing
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two different points with the same coordinates. Or, the automatic digitization with the use of curves
may have resulted in points with the same coordinates. If this is the case, Viewbox will show you
which points are coincident. You can click No and go back to correct the errors:

Two points were digitized at the same location. The coordinates are shown in parentheses.

4.3

Save a Patient
Saving a 'Patient' entails saving different kinds of information. It is helpful to review this
information in order to better understand the saving options.
A 'Patient' may include:
Patient specific data, such as ID, name, date of birth and sex.
These data are saved in XML files.
Datasets
Datasets contain: the type of the dataset, i.e. the name of the Template, the date the dataset was
taken, comments, the magnification factor, and the coordinates of the points and curves. These
data are also saved in XML files, together with the Patient data.
Slices
Slices are also saved in the XML file, together with the Patient data.
Images, Volumes, Meshes and Point Clouds
These objects are not saved in XML files, but each object is saved in a separate file. These files
can be of various formats, specific to each object; they have different extensions to show their
format (e.g. OBJ, STL, DCM, JPG, PNG, TIFF).
Because these objects are not saved in XML files, they are called 'external' or 'linked' objects.
When loading a patient, Viewbox knows where to find and load the external objects because it
keeps a link to these objects in the XML file.
When saving a patient that has external objects, the links need to be valid at the time the patient is
saved to the XML file. Therefore, each object needs to be saved first, and only then can
the patient be saved to the XML file safely (together with the links).
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Viewbox presents two options for saving a patient, Save... and Pack and Save :

Save...
This option will save the patient data to the XML file, but will also show the external objects, in
case any one of them may also need saving. In the example below, there is one image which does
not require saving, so we can just click Save Patient. The patient will be saved in Sample.xml:

In the following example, the image has been modified. This is shown by the yellow warning icon.
In this case we should save the object first, then save the patient, to ensure that the link to the
image file is valid and updated.
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Pack and Save
This option will save all objects first, then the patient data. The objects are saved in a special folder
(objects folder), specifically created for this patient. Note that this is a newly created folder and
the objects will be saved there, even though they may already be present in other folders and
files. The patient data will be saved in the same XML file that would be used for the Save... option
described above. A backup copy of the patient data will also be saved in the objects folder, under
the file name 'Patient.xml';
Viewbox will create the new objects folder in the default folder for the XML files, irrespective of
the actual location of the XML file that is used for saving the specific patient. The name of the
folder will be unique and it consists of an abbreviated version of the ID and name of the patient
followed by a unique alphanumeric string.
If you wish to configure the name of the folder and its location, then select Patient - Save... from
the menu and click Alternatively: Save all objects in one folder, to get the following dialog
box:
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The Pack and Save option is a safe way to ensure that all objects are properly saved and the links
to them are valid. Since the objects are all in one folder, and not scattered across your hard disk, or
in removable storage, it is easy to backup your data or transfer them to another computer.
However, this method may take up more space in the hard disk, because the objects may be stored
in duplicate.
If a patient is deleted, the associated objects folder is not deleted; you will be
presented with a dialog box and an option to delete it or retain it. Before deleting,
make sure that the objects in the folder are not needed any more.
An example of an objects folder is shown below. The objects folder of patient Jane Smith contains
one mesh object (Obj001.obj), one image object (Obj002.png) and the Patient.xml file, which holds
the patient data, as backup. The patient data have been primarily saved in another xml file, in My
Documents/dHAL Viewbox4.

4.4

Viewing Data
Datasets, images, volumes and other objects can be viewed in the 2D or the 3D Display, or both.
Each Display has different controls for viewing:
Viewing in 2D
Viewing in 3D
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Viewing in 2D
The tracing of each loaded dataset can be viewed in the Display, or it can be hidden. To show or
hide a tracing:
Select the dataset in the Icon area and use the View | In View menu command, or use the menu
that pops-up when you right-click on the dataset's icon:

Alternatively, use the eye icon next to the icon:

Views
It is possible to show only part of a tracing in the Display. Use the View list box in the Objects
Panel to select which area should be visible:

Alternatively, right-click on the eye icon in the Icon Area to select the desired View from a pop-up
menu:
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Zoom
Zooming goes from 25% to 2000%. To Zoom-in or zoom-out use the roll wheel of the mouse.
Alternatively:

Zooming with the menu:
View | Zoom In: Zooms-in to the next zoom step, e.g. from 75% to 100%.
View | Zoom Out: Zooms-out to the previous zoom step, e.g. from 100% to 75%.
View | Best Fit: Automatically calculates the best zoom factor so that the whole tracing of the

currently selected dataset will fit into the Display.
View | Fit All: Adjusts the zoom setting so that the whole extent of the Display (30x30 cm) is
visible.

Zooming with the Zoom tool:
Select the zoom tool
. Click anywhere in the Display to zoom-in to the next zoom step.
Right-click to zoom-out. Click and drag to zoom-in on a specific part of the Display.
Zooming with the Zoom drop-down list box:

Select a value from the list box, or input a value from the keyboard (without the percent sign) and
press Enter:

See also: Dataset size
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Orientation of datasets

Viewbox enables you to position the tracing of a dataset at any place in the Display and to select
any orientation. For example, you may choose to view all tracings in such a way that the SellaNasion line is always inclined 7 degrees to the horizontal, or the Nasion-Pogonion line is always
vertical.
You can select any of the pre-defined orientations that are shipped with Viewbox from the Dataset
| Orientate... menu, or by clicking on the arrow next to the Orientate button

in the Objects

Panel:

To use the default orientation (the first on the list), click the Orientate button
.
If an image is loaded and it is linked to the dataset, then the image will be repositioned together with
the tracing. If the selected orientation entails rotation of the tracing, the image will be rotated as
well. If the orientation entails scaling of the dataset (change in size), the image is also scaled.

Note:
Some orientations may affect only part of the tracing. See Orientations.
4.4.1.2

Superimposition of datasets

To superimpose two or more datasets:
Select one dataset as the current dataset and then select Superimpose on Current from the
Dataset menu, or, click the Superimpose button in the Objects Panel:

All other datasets that are loaded and visible in the Display will be superimposed on the current
dataset according to the selected superimposition that is displayed next to the button. Changing the
selected superimposition will automatically superimpose again.
Superimposition will fail if the points needed for the superimposition have not been digitized. Also,
superimposition works only on datasets and is not available when the current selection is a Dataset
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Template.
To change the available superimpositions and to add new ones, see Defining Dataset Templates.
If an image (or other object) is loaded and is locked with a tracing, the image will be repositioned
together with the tracing. If the selected superimposition entails rotation of the tracing, the image
will be rotated as well, and this may be a slow process. If the superimposition entails scaling of the
dataset (change in size), the image is also scaled.
Viewbox can also perform structural superimposition of radiographs. For details see: Structural
Superimposition.

4.4.2

Viewing in 3D
To move around in 3D:
Left-drag: Rotate the view.
Middle-drag or Shift-left-drag: Pan the view.
Mouse-wheel or Ctrl-left-drag: Zoom.
Alt-left-drag: Roll the view (rotate around axis perpendicular to screen).
These controls work with whichever tool is selected.
Notice that the Right-mouse button is reserved for working with the tools.

Viewing Controls:
You can also change the view from the viewing controls at the edge of the 3D Display. These
controls allow small adjustments:

Viewing Options:
The lower right corner of the 3D Display contains buttons for switching on or off the Grid, the
Bounding box of objects, the Axes and the Orientation object. Right-click on the buttons for
a menu to set further options:
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The Light button can be used for changing the light direction. Drag on the button with the mouse
for interactive change, or right-click on the button to open a menu for selecting one of the
principal light directions:

Preset Views:
Select one of the Preset Views to view your objects from the top, left, right, bottom, front or back.
A special inverted view (XY - 2D) is available for viewing 2D tracings in the same orientation as in
the 2D Display:
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If the XY - 2D option is selected, then the Display is locked and 3D rotation is not possible, only
panning is allowed. This is to guard against accidental rotation, when the Display is supposed to
function as a 2D display. To lock or unlock 3D rotation, use the pop-up menu of the Preset Views,
or click the rotation button at the upper right corner:

Look At tool:

Select this tool and Right-click on a point in the 3D Display to move it to the center of the screen.
This tool will only work when you Right-click on a point that lies on a Surface or a Slice.
Another way to look at an object (i.e. place it at the center of the viewing area) is to right-click on
its icon in the Icon area and select Look at Object from the pop-up menu:

Custom Views:
It is often convenient to view an object from various angles and then return to a previous view.
Viewbox allows you to temporarily set-up custom views and easily switch between them. To use
this feature:
Click on the Custom Views icon:
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There are 8 placeholders for custom-defined views (shown here empty). In order to 'capture' a
view, click the Capture button at the top left.
The example below shows some captured views:

To switch to any of the captured views, just click on it. The options at the top of the window will
determine how Viewbox will switch to that view. The Camera option will change only the viewing
parameters, the Rendering option will only change the rendering parameters (e.g. Surface
threshold or slice position) and the Camera & Rendering option will change both.
Right-clicking will open-up a menu to replace a view or delete it:
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View the Analysis
Viewbox displays the results of the cephalometric analysis in three ways:
On the tracing
As plain text
As an extended analysis

4.5.1

View the Tracing Analysis
To display the analysis results on the tracing, click the Analysis button and select the desired
analysis from the Analysis drop-down list box:

Right-click on the Analysis button for selecting the Analysis Mode (see below).

Notes
Colours:
The measurements are colour-coded to show if the values are within normal limits or not. There
are three built-in colour schemes and one user-definable. These can be selected from the View
panel of the Options window:
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In each of the schemes, the central colour is used if the measurement is within one standard
deviation from the average (mean) value for the age and sex of the patient, and the colours to the
left and right are used when the value is more than one, two or three standard deviations from the
mean, respectively. The black colour is used when no normative data are available for the age and
sex of the patient.
Colour schemes that have the warning icon next to them may not be colour-blind safe.

Analysis Mode:
If two or more datasets are loaded, you can select to display the analysis results for the current
dataset only, or for all datasets. Use Options | Analysis Mode from the menu to select the desired
option:
Current only: Only the values of the current dataset are shown.
Comparative: The values of the current dataset are displayed. Next to these, Viewbox displays
the measurements of all other loaded datasets that are of the same template as the current.
All: Analysis results for all datasets are displayed.

4.5.2

View the Text Analysis
To display the analysis results as plain text, open the Text Analysis window by selecting the
appropriate entry from the Windows menu:

The Text Analysis window will appear:
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The first column (Measurement) shows the name of the cephalometric measurement.
The second column (Graph) displays a graphical presentation of the measurement in relation to the
mean value:
The vertical line represents the mean value. The doted lines on either side of the mean
represent one, two and three standard deviation intervals. The 'X' represents the patient's
value. This graphical presentation makes it easy to see how far away from the mean the
patient's value is.
A Graph is only shown if there exists a mean value and a standard deviation for the age range
and sex corresponding to the dataset.
The third column (Value) shows the value of the measurement.
The fourth column (Mean) shows the mean value for the age and sex of the patient.
The fifth column (St. Dev.) shows the standard deviation.
The sixth column shows with asterisks how many standard deviations the patient's value is from the
mean. A minus sign before the asterisks shows that the value is below the mean, otherwise the
value is above the mean.

Notes
Fonts and styles:
Each measurement in the Text Analysis window is displayed and printed using a certain style.
Styles specify the font used, the paragraph alignment, the indents, the colour and whether to show
asterisks or not. Each measurement is assigned a specific style from the 10 available. Styles are
assigned to measurements when defining a Dataset Template. See: Defining Dataset Templates.
To change the settings for each style go to the Styles section of the Options dialog box.

Text entry:
The Text Analysis window is a small text editor. You can enter your own text if you wish, and
change the text that is already there. However, any changes you make will be lost if you Update
the window (see below).
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Column widths:
You can change the width of each column by dragging the line between the columns with the
mouse:
This is useful if the names of the measurements are too long and spill over to the next column.
Column widths can be saved and remembered for future sessions by using the Options | Save
Layout menu command (see below).

Menu options
File | Update

The contents of the Text Analysis window do not change automatically. Use this menu command
to update them so that they reflect the tracing, in case a VTO has been performed, or a different
Analysis has been selected.
File | Save...

Allows you to save the contents of the Text Analysis window to a text file.
File | Print...

Prints the contents to your printer. Almost the same can be achieved by using the Print command
from the main Viewbox menu. However, the printing option that is available here will allow you to
print any comments or modifications that you may have made to the contents of the Text Analysis
window (remember that it is actually a small text editor).
Edit menu

This menu contains the usual Select/Copy/Paste commands.
Options | Show Normal Values and Show Graph:
Allows you to hide or show the Graph and the Normal values
Options | Word wrap

If checked, the lines wrap around to the next line if the width of the window is not wide enough.
This will properly display lines that are center-aligned but will destroy the proper alignment of the
numbers. It is recommend to have this option checked only if you can enlarge the width of the
window enough to avoid wrap-around.
Options | Save Layout

Selecting this option will save the current layout (column widths, word-wrap option) of the Text
Analysis window for future sessions. Alternatively, the Show Normal Values, Show Graph and
Word Wrap options can be set from the Dataset page of the Options dialog box.

4.5.3

View the Extended Report
To display the extended report, open the Extended Report window by selecting the Extended
Report entry from the Windows menu:
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The Extended Report can contain 5 different sections. These sections can be configured from the
Extended Options dialog box, which can be reached from the View | Options... menu of the
Extended Report window, or from the Printing page of the Options dialog box.
The Extended Report window shows its contents as they will be printed on your printer. Doubleclick inside the window to change the view from Whole Page to Page Width.

4.5.4

Extended Report options
The Extended Report Options dialog box gives access to numerous customization options for the
Extended Report window. The Options dialog box is divided into 7 sections:

Page
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Set the options for the orientation of the page, the size of the margins and the header and footer. If
you want to include the page number in the header or footer, use the code word: @p, as show in
the picture above. The red lines show the boundaries outside which the printer cannot print. Make
sure that the header and footer are inside the red lines, by adjusting the From Top and From
Bottom values.

Layout

Set-up the sections that compose the Extended Analysis. You can enter only the sections you
desire in any order you wish. To make sure that a section starts at the top of the page, insert a
page break before it. Use the Move Up and Move Down buttons to re-arrange the sections.
The Extended Analysis can show up to four datasets. Select the desired option from Show
analysis of:.
Each of the four datasets is colour-coded according to the colors listed on the right. Click on the
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colors to change them.

Headers

This page sets the options for the Headers section, which shows various data for each dataset (e.g.
name, sex, etc.) and the time interval between the datasets. The headers are printed using the text
style specified in the Text Style drop-down list.
The Headers section can include a Heading, as specified in the Section Heading entry. If you
want the heading to break to two or more lines, use the code: @#

Tracing

The Tracing section shows the tracings of the datasets. Set the Width and Height of the
rectangle in centimeters. The Zoom value adjusts the size of the tracings. Set to 100% for a 1:1
ratio.
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If the tracing is not positioned properly inside the page you can drag it with the mouse in the
Preview panel.

Measurements

This section shows the measurement results in text format. You can set the colors for each value
that is displayed. Setting different colors for alternating lines makes the text easier to read, as the
following example shows:

Variable Graph
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The Variable Graph section shows the measurements in a bar-graph format, as shown in the
example below:

The colour of each bar corresponds to one of the four datasets, as set in the Layout section above.
The vertical dotted lines represent standard deviation intervals.

Radiograph Graph
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This section shows the measurements of the datasets side by side as shown in the example below:

The colour of each bar corresponds to one of the four datasets, as set in the Layout section above.
The vertical dotted lines represent standard deviation intervals.

4.6

Print
Selecting Print... from the File menu will open a dialog box from where you can select to print the
tracing of the dataset, the detailed text analysis, the extended report and/or the 3D display:
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For each type of print-out you can set the options by clicking the appropriate Options... button.
Options for the Tracing analysis
Options for the Text analysis
Options for the Extended report
Options for printing the 3D Display

Tip:
Use the Print button to print according to the preferences last set in the Print dialog box:

Notes:
The area that will be printed can be shown in the Display by grey rectangles. Use the View |
Show Print Area menu command to turn them on or off. There are three rectangles that are
shown. The dashed one shows the area that will be printed if Tracing is selected above. The
dotted rectangle is the area that will be printed if the Print Tracing option is set in the Text
Analysis options. The dashed-dotted rectangle is the area that will be printed by the Extended
Report. Both rectangles change size and shape according to various parameters. such as the
specific printer selected, the zoom values, the margin settings, etc.
You can move the page rectangles to print other parts of the Display, by using the File | Move
Print Area menu command. Just select which rectangle you wish to reposition, and drag it with the
mouse. Double-click to reset it to the upper left corner. Print areas are remembered for the next
time you use Viewbox.

4.6.1

Tracing Analysis options
The Tracing Analysis Options dialog box is accessed from the Print dialog box or the Printing page
of the Options dialog box, and allows you to set the margins and other options for the printed
tracing analysis.

Page Options
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Set the margins in centimetres. The margins are shown with the dashed grey line. The red lines of
the Preview show the maximum extents that your printer can print, so make sure that the margins
do not go outside these extents.
Use the mouse to drag inside the Preview area in order to reposition the dataset.
A header and footer can be printed on each page. The header and footer can contain information
related to the dataset. Use the following codes to print such information:
Use this:

to print this:

@i

Patient's ID

@n

Patient's name

@a

Patient's age

@s

Patient's sex

@b

Patient's date of birth

@d

Date dataset was taken

@c

Comments of dataset

@p

Page number

For example, the picture above shows that the name, comments of the dataset and age of the
patient (separated by dashes) would be printed as the Header, because the code @n - @c - @a is
used.

Options for the Tracing Analysis
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If you want the tracing to print at the same size as the original dataset, set the Zoom to 100%.
Otherwise set the Zoom slider to the desired value.

4.6.2

Text Analysis options
The Text Analysis Options dialog box is accessed from the Print dialog box or the Printing page of
the Options dialog box, and allows you to set the margins and other options for the printed text
analysis.

Page Options

Set the margins in centimetres. The margins are shown with the dashed grey line. The red lines of
the Preview pane show the maximum extents that your printer can print, so make sure that the
margins do not go outside these extents.
Use the mouse to drag inside the Preview area in order to reposition the dataset.
A header and footer can be printed on each page. The header and footer can contain information
related to the dataset. Use the following codes to print such information:
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Use this:

to print this:

@i

Patient's ID

@n

Patient's name

@a

Patient's age

@s

Patient's sex

@b

Patient's date of birth

@d

Date dataset was taken

@c

Comments of dataset

@p

Page number

Options for the Text Analysis

You may include the tracing of the current dataset together with the text analysis. Just check the
Print Dataset box. The tracing will be printed in a space, whose size is specified by the Width
and Height values. The tracing can be printed at any of the predefined positions specified in the
Position drop-down list.
If you want the tracing to print at the same size as the original dataset, set the Zoom to 100%.
Otherwise set the Zoom slider to the desired value.

4.6.3

Extended Report options
The Extended Report Options dialog box gives access to numerous customization options for the
Extended Report window. The Options dialog box is divided into 7 sections:

Page
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Set the options for the orientation of the page, the size of the margins and the header and footer. If
you want to include the page number in the header or footer, use the code word: @p, as show in
the picture above. The red lines show the boundaries outside which the printer cannot print. Make
sure that the header and footer are inside the red lines, by adjusting the From Top and From
Bottom values.

Layout

Set-up the sections that compose the Extended Analysis. You can enter only the sections you
desire in any order you wish. To make sure that a section starts at the top of the page, insert a
page break before it. Use the Move Up and Move Down buttons to re-arrange the sections.
The Extended Analysis can show up to four datasets. Select the desired option from Show
analysis of:.
Each of the four datasets is colour-coded according to the colors listed on the right. Click on the
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colors to change them.

Headers

This page sets the options for the Headers section, which shows various data for each dataset (e.g.
name, sex, etc.) and the time interval between the datasets. The headers are printed using the text
style specified in the Text Style drop-down list.
The Headers section can include a Heading, as specified in the Section Heading entry. If you
want the heading to break to two or more lines, use the code: @#

Tracing

The Tracing section shows the tracings of the datasets. Set the Width and Height of the
rectangle in centimeters. The Zoom value adjusts the size of the tracings. Set to 100% for a 1:1
ratio.
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If the tracing is not positioned properly inside the page you can drag it with the mouse in the
Preview panel.

Measurements

This section shows the measurement results in text format. You can set the colors for each value
that is displayed. Setting different colors for alternating lines makes the text easier to read, as the
following example shows:

Variable Graph
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The Variable Graph section shows the measurements in a bar-graph format, as shown in the
example below:

The colour of each bar corresponds to one of the four datasets, as set in the Layout section above.
The vertical dotted lines represent standard deviation intervals.

Radiograph Graph
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This section shows the measurements of the datasets side by side as shown in the example below:

The colour of each bar corresponds to one of the four datasets, as set in the Layout section above.
The vertical dotted lines represent standard deviation intervals.

4.6.4

3D Display Printing options
The 3D Display Printing Options dialog box is accessed from the Print dialog box or the Printing
page of the Options dialog box, and allows you to set the margins and other options for printing the
3D display.
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Set the margins in centimetres. The margins are shown with the dashed grey line. The red lines of
the Preview show the maximum extents that your printer can print, so make sure that the margins
do not go outside these extents.
A header and footer can be printed on each page. The header and footer can contain information
related to the patient and dataset. Use the following codes to print such information:

4.7

Use this:

to print this:

@i

Patient's ID

@n

Patient's name

@a

Patient's age

@s

Patient's sex

@b

Patient's date of birth

@d

Date dataset was taken

@c

Comments of dataset

@p

Page number

Work with Objects
Move and resize objects in 3D
Using the Position / Rotation / Scale dialog box:
Select the Object | Position / Rotation / Scale... menu command, or right-click the Object
Widget tool button

and select the Position / Rotation / Scale... command from the pop-up menu. The Position /
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Rotation / Scale dialog box will open:

Enter values in the X, Y, Z boxes to position the object. Rotation can be changed using the track
bars or the edit boxes.
The Set to None button

will reset all positions and rotations to zero and all scalings to 1. To

copy all entries to the clipboard for pasting to other programmes, use the Copy button
. The 4
x 4 position/rotation/scaling matrix can be copied using the Copy Matrix to Clipboard button.
Using the pop-up menu
Right-click the Object Widget tool button
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Using the pivots and object handles
When the Object Widget button is depressed and an object is visible on the screen, the pivots
and object handles appear, as show below:
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The Screen Pivot is the one on the lower centre and it can be used to rotate and translate the
object relative to the plane of the screen.
The Main Pivot is the one at the upper right and it can be used to rotate the object around the point
at which the Pivot is positioned. To reposition the Pivot without moving the object, hold down the
Alt key while dragging the mouse.
The object handles are used to rotate the object around its own coordinate axes.

4.8

Work with Images
Note: Images in Viewbox are always associated with a Patient. It is not possible to
load an image without a patient.

Images
Images are 2D data and are usually viewed and manipulated in the 2D Display.
Viewbox has a menu section dedicated to images:
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Images can be manipulated using the Adjust Image functions.

4.8.1

Acquiring an image
Images are associated with patients, so in order to load an image, you need to
have a patient loaded and selected first.
Images can be loaded from files that reside in your hard disk, or can be acquired from a scanner.

To load an image from an image file:
Use the Image | Open... menu command or click the
load the following file types:
File type

button on the Toolbar. Viewbox can

Notes

Bitmap files (BMP)
JPEG files (JPEG and JPG)
PNG files
Khoros VIFF files
TIFF files (TIFF and TIF)

Compressed TIFF files are not supported

PGM files
DICOM files (DCM)

Some versions are not supported

Canon RAW CR2 files

Very limited support

Very large images may cause problems when loading. This may be due to insufficient memory or
may be a problem with Windows or some graphics cards. As a rule, images smaller than
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1500x1500 pixels should load without problems. Image size is not always related to file size. An
image may have a lot of pixels but occupy less space on the hard disk than another image with less
pixels. This may happen because some image files compress the image before writing it to the hard
disk. Cephalometric radiographs scanned at 150 dpi have approximately 1000 x 1000 pixels.
DICOM files may contain the name of the patient, the date of birth, the acquisition date of the
image and other data. Viewbox can read this data and update the patient's properties, if desired. To
specify how Viewbox should respond when finding such data, set the Update patient data from file
option, in the Image page of the Options dialog box.

To paste an image from the Clipboard:
Use the Image | Paste from Clipboard menu command.

To get an image from a scanner:
Use the Image | Acquire | Acquire... menu command, or click the
button on the Toolbar.
Viewbox will try to communicate with the scanner and open the scanner's software for you to scan
the photograph, radiograph or slide. The scanner should be turned on and connected to your
computer before Viewbox is started, otherwise an error may occur (some scanners need to be
turned on even before the computer is). Viewbox uses the TWAIN interface to communicate with
the scanner. The same interface is used by some digital cameras, so it may be possible to get an
image directly from a camera. Otherwise, you will have to save the camera's image to the hard
disk first, and then load it into Viewbox. Again, keep in mind that very high resolution images may
cause problems.
Viewbox can acquire scanned images at more than the usual 8-bit colour depth.
If you have more than one scanner connected to your computer, you can select the one to use by
the Image | Acquire | Select Source... menu command.

4.8.2

Saving an image or the Display
To save the image to a file, select Save... from the Image menu or click the
button on the
Toolbar. The Save dialog box will open. Images can be saved as bitmaps or JPEG files. JPEG files
are compressed images. They take up much less space than bitmap files, but the compression is
lossy, meaning that the quality of the image will decrease. If you elect to use a JPEG format, you
can set the compression factor:

A value close to 100 will result in low compression and high quality. A value close to zero will
result in a very small image file size but the quality will also be low. The default value is 90, which
usually results in imperceptible quality loss. It is recommended to check the Greyscale option if
the image is a black and white image (e.g. radiograph).
The Image | Save... menu command will only save the selected image and not what may currently
be visible in the Display. If you want to save the whole contents of the Display, choose the File |
Export | Export as Image... command instead. This will open the Export Image dialog box:
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Note:
File | Export | Export as Image... will export the 2D or 3D Display, depending on which is visible

at the time. To export the 3D Display in a format that enables separation of background from
objects, check the Include Transparency option and save the image in a file format that
supports transparency, e.g. PNG or Bitmap ARGB 32bit:

4.8.3

Repositioning an image
An image can be positioned anywhere in the Display by using the mouse or by entering the position
values with the keyboard.

Using the mouse:
Select the Object Widget tool:

To reposition the image, drag it with the mouse to the desired location (the mouse can be anywhere
within the Display, it doesn't have to be on the image, see the picture below). If you want to
position it at the top left corner, double click anywhere in the Display.
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To rotate the image, drag the rotation markers: . The image is rotated around the Rotation
Center. To reset to zero degrees, double click on one of the rotation markers. If you want to
change the position of the Rotation Center, drag it with the mouse, or use the Rotation Center tool.
The resizing markers can be used for resizing.

Using the Object Scale / Rotation / Position dialog box:
Select the Object | Scale / Rotation / Position... menu command, or right-click the Move Object
tool button

and select the Scale / Rotation / Position... command from the pop-up menu. The Object Scale /
Rotation / Position dialog box will open: (some of the controls may be disabled if you are working
in 2D mode)
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Enter values in the X and Y boxes to position the image so that its upper left corner is a the X and
Y coordinates.
Enter a value in the Z axis box (in degrees) to rotate the image.

Note:
Rotating an image as described above does not change the image in any way, it just shows it at a
rotated position. If you want to create a resampled image, use the Image | Rotate - Downsample |
Rotate Arbitrary... menu command. This will modify the image (change the pixels). Resampling
the image in this way may deteriorate image quality. Using the Arbitrary... command you can
resample the image at any rotation:

If the image is already shown in a rotated position, clicking the Set to Z-angle will resample the
image at its current rotation and then set its rotation position to zero degrees.

Note:
It is possible to move the image and the dataset together. Click the Link icons next to the image
and dataset in the Icon area:
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Any objects that are linked are moved together with any other linked objects of the same patient.

4.8.4

Resizing an image
An image can be resized by using the mouse or by entering the size values with the keyboard.

Using the mouse:
Select the Object Widget tool:

Markers appear in the Display. Drag the markers to resize the image:
: Dragging on a corner marker enlarges or reduces the image keeping the aspect ratio
constant, unless the Ctrl key is simultaneously pressed.
: Dragging the markers on the side of the image changes the width or height of the image
altering the aspect ratio (deforms the image).
Images that have been deformed by changing the aspect ratio will appear with a warning icon in
the Icon Area:

Using the Scale Image dialog box:
Select the Object | Resize... menu command. The Scale Image dialog box will open:

You can adjust the size of the image in three ways:
Specify the Resolution.
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Specify the Image Scaling factors (see also Image Scaling options).
Specify the Width and Height in millimeters.
Click the corresponding Apply button to change the image size.

Notes:
When resizing an image, the image is not resampled, that is, the number of pixels is not changed. It
is only 'zoomed' so that it appears a different size in the Display. Therefore, if you make an image
smaller there is no loss in image quality.
One of the common mistakes made by novice Viewbox users is to scan a radiograph at a higher
resolution than usual (e.g. 300 dpi instead of 150 dpi) and not inform Viewbox about it. The
resulting image will have a larger size (number of pixels) than usual and take up the whole Display
area, sometimes extending beyond it, resulting in inability to digitize the landmarks and grossly
erroneous measurements. The solution to this problem is to open the Scale Image dialog box and
Apply the correct Resolution. Alternatively, use the Ruler tool, as described in Images and
Magnification.
In case you wish to resize and align a tracing with a photograph of the patient's face, Viewbox has
the Align Tracing option that can be used to automatically resize and align an image with a tracing.
Do not use the Scale Image dialog box for this.

Downsample
Downsampling changes the resolution, i.e. the number of pixels of the image and results in loss of
quality. This feature is useful if you have very large images (e.g. from a high resolution digital
camera) and you want to reduce the resolution in order to increase the speed of various slow
functions (e.g. adaptive Equalisation or morphing), or the general responsiveness of the program. It
is not possible to increase the number of pixels of an image. To downsample an image, select
Image | Rotate-Downsample | Downsample... to open the Downsample dialog box:

Downsampling can be reversed by Image | Undo.

4.8.5

Adjust image functions
Viewbox has a set of functions for changing and enhancing the image. Use the Image | Image
Adjust menu, or the buttons in the Objects Panel:
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Levels...:
See Image Levels function for a detailed explanation on how to use this function.

Histogram Equalise:
Performs a histogram equalisation of the image, which aims to improve contrast and enhance the
image. This function should be used for radiographs only, because it destroys colour information
converting every image to a greyscale.
Initial image:

After Equalisation:

Adaptive Histogram Equalise:
Performs a histogram equalisation of the image, but each pixel is adjusted according to the local
area around the pixel. This allows detail to show both at hard and soft tissues. The size of the area
used for equalisation can be set from the Image page of the Options dialog box.
Initial image:

After adaptive equalisation,
with size set to 10%:

After adaptive equalisation,
with size set to 30%:

Contrast Limited Adaptive Equalise (CLAHE):
Similar to Adaptive Histogram Equalise, but gives better results because areas with noise and poor
contrast are not enhanced so much.
Initial image:
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Auto Levels:
Expands the greyscale values of the image to cover the whole dynamic range from white to black.
As default values, the brighter and darker 5% of the pixels are set to white and black respectively,
and the remaining intermediate brightness pixels are expanded to cover the total range. This can be
adjusted from the Image page of the Options dialog box.
Initial image:

After Auto Levels:

Adaptive Auto Levels:
As Auto Levels, but done locally. The size of the area used for adaptive auto levels can be set
from the Image page of the Options dialog box.
Initial image:

After adaptive auto levels,
with size set to 10%:

After adaptive auto levels,
with size set to 30%:

Brightness / Contrast / Gamma:
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Change the brightness, contrast and gamma of the image. Use the sliders to adjust and click OK if
satisfied, otherwise click Cancel to return the image to the original condition. To adjust only one or
two of the three settings, check or uncheck the appropriate boxes.

Negative Image:
Inverts the colours of the image.

Colourise:
This function uses Look-Up Table (LUT) files and converts a greyscale image to colour for better
visibility of the structures, as shown in the examples below:

Notes
Equalise, Adaptive Equalise, Contrast Limited Adaptive Equalise, Auto Levels and Adaptive
Auto Levels convert the image to greyscale loosing all colour information.
All of the above functions can be reversed by using the Image | Undo Image or Image | Reset
Image menu commands.

4.8.6

Image Levels function
The Levels dialog box allows you to adjust the histogram extents and the gamma of the image.
Open the Levels box from the Image | Image Adjust | Levels... menu, or from the Levels button
of the Objects Panel:
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The Adjust Levels dialog box:

The Adjust Levels dialog has two panes:
The upper pane shows the histogram of the original image as it was loaded from the disk file or
acquired from the scanner. The numbers above the upper pane show the number of intensity
values of the original image. 8-bit images have 256 intensity values and the numbers show 0 - 255.
16-bit images have 65536 different values and the numbers show 0 - 65535.
Between the upper and lower panes is the zoom area. Use the mouse to drag the two extent
markers in order to zoom-in on part of the histogram. The numbers below the markers will show
the zoomed intensity range.
The lower pane shows the section of the histogram of the upper pane that has been zoomed-in by
the extent markers.
Below the lower pane are the adjustment markers. Use these to adjust the image to the desired
part of the histogram. The left marker sets the black range, the right marker sets the white range
and the middle marker is the gamma adjustment (also set in the lower right edit box).
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Click here to see an example of adjusting a 16-bit CT-scan image of the head.
If you do not want to do the adjustments based on the original image, but on the image as it is at the
present moment (after it may have been already changed by other functions), select the Current (8bit) option. The upper pane is then hidden:

4.8.6.1

Image levels - Example

The example shown below is based on a 16-bit CT-scan of the head. The original 16-bit image has
a potential of 65536 different intensity levels, but as show by the histogram, only a few at the
center are used. Because the histogram is concentrated in the center of the total range the image
appears grey with very low contrast:

The next picture shows the image after moving the extent markers to encompass the central part
of the histogram. Observe how the histogram has been expanded in the lower pane and now
ranges from almost black (on the left) to almost white (on the right). The image has much better
contrast:
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To achieve the best contrast we move the adjustment markers (black and white triangles) to the
edges of the lower histogram. The edges can be seen better if we check the Log axis scaling.
Observe that the image contains approximately 2500 different intensity levels, far more than can be
stored in a regular 8-bit image. Also observe that the histogram shows three distinct sections.

We adjust the markers to the left section of the histogram, which contains approximately 250 levels
of grey. This section shows parts of the CT-scan machine and the patient's hair.
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Now we adjust the markers to the middle section of the histogram. This section shows the brain.

Finally, the right part of the histogram shows the bony anatomy.
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Show / Hide / Close an image
An image can be temporarily hidden from view by clicking on the eye icon in the Icon area:

or by using the View | In View menu command.
If you want to remove the image, select Object | Close . This will unload the image from Viewbox.
Images can be made transparent by moving the Transparency slide bar on the Objects Panel:
Transparency can be set from 0% (opaque) to 100% (completely transparent):

Transparency allows structural superimposition.

4.8.8

Align an image with a dataset
It is not easy to achieve a perfect fit when superimposing a cephalometric tracing on the
photograph of the same patient. The only common registration area between a tracing (dataset)
and a photograph is the soft-tissue outline. However, this is seldom exactly the same between the
tracing and the profile photograph, because the angle from which the two records were taken may
be different and the soft-tissue posture of the patient may be different. Viewbox offers the
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following ways to superimpose a dataset and an image:

Manually
Use the various tools to resize, move and rotate the image or the tracing.
To move and rotate the image, use the Object Widget tool
from the toolbars. This tool also
enables you to resize the image by dragging on markers in the Display. Alternatively, use the
Object | Resize... menu command.

Using the Align Dataset tool
Select Image | Align Dataset... from the menu or click the Align Dataset button on the Objects
Panel:

The Align Dataset - Image dialog box will appear:
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The digitizer tool
is selected automatically.
Select the Orientation, if one has been defined (see Orientation Types). The Orientation
determines which points are pre-selected in the remaining drop-down lists, but these can be
changed if desired.
Click on two points on the photograph that correspond to two points of the dataset (in the above
example these points are Soft Nasion and Soft Menton, and can be changed from the drop-down
lists). Viewbox then calculates the appropriate scaling factor and adjusts the size of the image to fit
the dataset. It also moves and rotates the image (or the dataset) so that they fit.
After manual alignment by clicking on two points on the photograph:

Automatic fit
Once a rough fit between tracing and photograph has been achieved, you can refine this by clicking
the Auto Refine button. You may need to use this button two or three times, until the fit between
the soft tissue outlines of the tracing and the photograph coincide, as shown below:
After Auto-refinement:
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Auto Refinement works as follows:
The photograph is searched for the most prominent outline. This usually happens to be the outline
of the soft tissues. Searching takes place in a zone around the outline of a pre-defined line
(Drawing to match on the image), in the example above, the soft-tissue outline of the tracing
(Whole Soft tissue).
The width of the zone used for searching the image is specified in the Hot zone box. Increase it if
the initial fit is bad, so that it includes the soft tissue outline in the photograph. Decrease it if the fit
is good, so that the process works faster and is not distracted by other prominent edges in the
image.
Interpolate points: This option allows you to use more closely spaced points for adjusting the fit.
Repeat: Specifies the number of times to repeat the fitting procedure for every click on the Auto
Refine button.
During the alignment procedure, Viewbox needs to move, rotate and change the size of the tracing
or the image. Specify which of the two to change in the Options boxes.

Tip
Even after proper aligning, the soft tissues between tracing and image may not be exactly
coincident, because of different patient posture. You can adjust the points of the tracing to match
the soft tissue of the image, by using the Adjust Points button. First select the appropriate item in
the list box (e.g. Lower soft tissue, or Upper soft tissue) and then click Adjust Points.
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Work with Meshes
Meshes are surfaces composed of many triangles.

A mesh holds information that specifies the coordinates of the vertices of the triangles, the
colour of the triangles, the direction of the normals at each vertex and each triangular face, and
the connectivity between the triangles.
Normals
A Normal is a vectors perpendicular to the triangle, as shown below:

Normals can be viewed by selecting Show in the Modify functions.
Normals are used to calculate the lighting (colour shade) of the triangles. The default setting uses a
different normal at each vertex of the triangle giving a smooth appearance:

Using only one normal per triangle will give the 'triangulated' appearance. This is the Faceted
rendering option (see Mesh Rendering for more details):
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Connectivity
Connectivity is information about how triangles connect to each other, i.e. which vertices and edges
are shared by which triangles. Connectivity information is important for finding adjacent triangles
and performing a lot of the advanced mesh functions.
Manifold Meshes
Manifold meshes are meshes that are locally flat, i.e. an edge is shared by two triangles at the
most. Also, a vertex is shared by only one surface.
Viewbox cannot work with non-manifold meshes. In specific cases, Viewbox can convert a nonmanifold mesh to a 2-manifold mesh. Click the Repair button:

Note: Meshes in Viewbox are always associated with a patient. It is not possible to
load a mesh without a patient.

4.9.1

Load and Save Meshes

Load a Mesh
To load a mesh use the Object | Open | Open Mesh... menu command, or click the Load Mesh
button
Meshes can be loaded from files of the following types:
OBJ
OBJ files contain the coordinates of the vertices of the triangles, the direction of the normals and
other data. Viewbox loads the vertices and the triangles and the normals, if present, but ignores
additional data. Support for textures is limited.
OFF

© 2020 dHAL Software, Kifissia, Greece

110

Viewbox Help

Files of the Geomview OFF format (www.geomview.org).
OPM
OPM files are used by the OrthoProof software (OrthoProof B.V., Nieuwegein, The Netherlands).
PLY
PLY files, also know as Stanford Triangle Format files, can be plain text files or binary files (which
are smaller in size). They also contain coordinate and triangle information.
SUR
Plain text files that contain the vertex coordinates and triplets of vertices to define the triangles.
Used by the Edgewarp software by Bill Green and Fred Bookstein.
STL
These files are used in stereolithography and contain triangle information but without connectivity.
When loading STL files, Viewbox attempts to infer connectivity from the coordinates of the
vertices.
TSB
Files produced by the 3dMD scanner (3dMD Limited, London, UK).
VIFF, XV
These files are produced by range scanners and contain the distances from the scanner to each
point on the surface of an object. There is no direct triangle information. Viewbox constructs
triangles automatically when reading these files. The following options can be set for reading VIFF
and XV files:

Triangle
Threshold

It is recommended to skip triangles that are much longer in the depth
dimension than they are in the X and Y directions, because this means that
the surface of the object at that location is tilted at a large angle to the
scanner and the triangle may not represent the actual surface. Default
value is 4.

Skip Vertices at
Zero Depth

Usually vertices at zero depth are those farther away from the scanner
and are not needed.

Depth Units per
mm

You should check your scanner documentation to get this value. Default
value is 1000.

Save a Mesh
Meshes can be saved in OBJ, STL and PLY formats. For each format there are corresponding
saving options:
OBJ
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Check this box to save the normals of the mesh (see Normals). If normals are
not saved, then they will be calculated when the mesh is loaded again. Note that
the calculated normals may be different than the present normals, so the object
may appear different. However, the difference will be in appearance only, as
the underlying geometry will not change.

Save Texture The OBJ format allows saving the texture (if present), as well. The texture is
saved in two additional files with extensions MTL and PNG. If files of the
same name are already present in the folder where the mesh will be saved,
these will be overwritten.
Include
Selections

Check this box to include any selections. For details of selections see Select
Mesh Parts.

OBJ is the recommended format for saving mesh objects.
STL

The Binary format is recommended as it results in smaller files.
PLY

The Binary format is recommended as it results in smaller files.
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SUR
There are no options for this file format.

4.9.2

Create Meshes
Meshes can be created from volume data or by merging other meshes together. Simple geometric
shapes can also be created.

Create from Volume
To create a mesh you need to have a volume loaded. The mesh can be created either by
thresholding the volume or by the segmentation data:

Before creating the mesh, make sure that the correct volume has been selected. Then select
which Threshold to use for the mesh (Primary, Secondary or Adaptive) and click the Create
button. Checking High Quality will result in better quality but may be significantly slower.
To visualize how the mesh will look like, it is recommended to render the volume using the
Isosurface method. Meshes are created using a variant of the Marching Cubes algorithm.
If the volume has been segmented, then a mesh can be created from these data. Usually such
meshes have a blocky appearance because they reflect the underlying voxels of the volume.

Shapes
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The Shapes menu allows creation of cubes and spheres:

Merge Meshes
A mesh is created by merging all loaded meshes that are visible in the Display. Mesh merging is
accomplished by a volumetric method which subdivides space into voxels and computes a weighted
average of all meshes inside each voxel. The algorithm needs a lot of available memory, so if it
does not succeed, select a lower number of voxels.
Mesh merging is appropriate for creating a single mesh of an object, from a number of meshes
acquired by a range scanner from different angles.

4.9.3

Mesh Rendering
Rendering (visualising) meshes is supported by several options:

Normal Rendering (Fill)
This mode does not show the actual geometry of the surface. The surface may appear smoother
than it actually is, because rendering is affected by the direction of the normals.
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Faceted Rendering
The mesh does not appear smooth because each triangle is rendered using one normal at the
centre, instead of three normals at the vertices, so each triangle appears flat (as it actually is). This
mode shows the actual geometry of the surface.

Wireframe Rendering
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The edges of each triangle are rendered:

Fill and Wireframe

Transparent Rendering
The mesh is shown transparent. This is not true transparency and may show artefacts.
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Rendering of Normals
Checking Show Normals will draw the normals at each vertex of the mesh. This is sometimes
useful in order to diagnose problems related to mesh rendering, e.g. if flipping of normals is
required. Normals should point outwards, as shown below:

Ambient Occlusion
Ambient Occlusion creates realistic images of meshes by calculating areas of shadow. When first

© 2020 dHAL Software, Kifissia, Greece

How to...

117

applying ambient occlusion to a mesh, Viewbox needs to perform time-consuming calculations.
Subsequent draws do not incur any delay. Ambient occlusion may need to be recalculated if the
shape of the mesh changes, if cropping is applied, or if smoothing and decimation are applied. Use
the Recalculate command from the drop-down Ambient Occlusion menu to recalculate
ambient occlusion. Ambient occlusion data are not saved and need to be recalculated every time
the mesh is loaded.

The Ambient Occlusion effect can be adjusted using the Light controls (right-click on the light-bulb
at the top part of the Display and select Adjust Light... from the pop-up menu):

Ambient occlusion depends on the direction of the normals. If applying ambient
occlusion results in a black mesh, flip the normals and calculate again.

Texture Rendering
To apply a texture to a mesh, first load the texture from a file. Then select the texture mapping
(Cube, Sphere or Reflection). Below are two examples:
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Mesh Modify Functions
To modify a mesh use the following commands:

Modify Vertices
Smooth
Smooths the surface of the mesh by averaging the position of the vertices. See Smooth a Mesh for
details.
Smooth Along Normals
Smooths a mesh but restricts the movement of the vertices in the direction of the normals. This
procedure changes the geometry of the mesh to match the appearance of the mesh when rendering
with the faceted option turned off. Similarly to the Smooth procedure, the mesh may shrink.
This procedure is effective on meshes that have been created from CT or CBCT data.
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The following options are available:

Example
Close-up of the ramus area of a mesh created from CT data. The mesh appears smooth because it
is rendered with Facet turned off and lighting is mainly affected by the direction of the normals,
which are locally smooth:

The same mesh, with Facet turned on, to show the actual geometry. Notice the step appearance, a
result of the Marching Cubes algorithm:
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After smoothing along the normals, with Facet still turned on. The steps have been reduced
considerably, at the expense of some shrinking. Applying a Fair modification (see below) may
improve this result even further:

After fairing:
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Smooth Selection boundary
Smooths the boundary of a selection by moving the vertices to avoid sharp angles. This is useful if
you wish to cut the mesh or extract the selected part as a new mesh. There are no options and the
procedure is executed immediately.
Example
Part of a mesh selected:

After smoothing the selection boundary. This procedure may create thin triangles at the border of
the selection:
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Fair
Moves the vertices in an attempt to change the triangles towards a more equilateral shape.

Mesh triangles before fairing. Note the thin triangles, commonly resulting from creation of a mesh
from CT or CBCT data:
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After fairing. Shape of the mesh may change slightly:

Decimate
Reduces the number of triangles by merging triangles together. For details see Mesh Decimation.
Subdivide
Subdivides the triangles into smaller triangles:
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Use Uniform to subdivide all triangles. Adaptive will only split a triangle if the edges are longer
than the specified percentage. This option is useful because it splits only the large triangles and
makes triangle size more uniform within the mesh.
Interior triangles, single triangles and triangles with two open edges are divided into 3 new triangles.
Triangles having one open edge will be split into two.
Project
Will project all mesh vertices onto the surface of another object. After selecting the Project menu
item, select the object to project on from the Icon Area. Each vertex is projected to the closest
point of the other object.

Crop
See Clip, Crop and Slice for details.

Mesh Operations
The following operations between meshes are supported:
Separate
Separates a mesh into its constituent parts. If a mesh contains unconnected parts, then new meshes
are created, each one containing one of the unconnected parts of the original mesh. Be careful
when using this function because a large number of meshes may be created. If the mesh is
composed of only one part, it will just be duplicated.
Add All Visible, Add...
Adds all other meshes, or a selected mesh, to the current mesh. The current mesh will include the
other meshes as parts that can later be separated using Separate.
Intersect with...
Removes part of a mesh that is intersected by another mesh. The meshes need to overlap. In the
figure below, the green sphere is hidden in the last panel, to show the result of the procedure.
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Zip with...
Combines a mesh with another mesh by filling-in the space between them. Each mesh must have
one hole and the holes must be close to each other and of approximately the same size.

Boolean Union with...
Computes the Boolean union of two meshes.
The figure below shows the result on two intersecting spheres. The last panel in the figure is a cutout of the resulting mesh.

Boolean Difference with...
Computes the Boolean difference of two meshes.

Boolean Intersection with...
Computes the Boolean intersection of two meshes.
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Inset / Offset surface
This function will create a surface that is offset relative to the original mesh, either towards the
outside or the inside of the mesh. This function requires that the mesh is a closed (watertight)
mesh.
Specify the parameters:

Set the Direction to create a hollowed object, or to offset the surface outwards. The Detail
setting will determine how closely the created surface follows the original. For hollowing objects
that are to be printed, a value around 100 should be adequate. Increase this value for Offset
surfaces, where the created surface will be visible.
Example of a digital scan with an inset and an offset surface, both at a distance of 3 mm from the
original:
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A mesh operation may fail for various reasons. We are working to make these
operations as robust as possible. There is no undo function for these operations.

Normals
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Calculat Computes the normals at each vertex by averaging the normals of the adjacent
triangles. Use after decimating or smoothing the mesh for proper rendering. Does not
e
change the geometry of the mesh in any way.
Flip

Flip the direction of the normals. This may be required for proper Ambient Occlusion
rendering and other functions. Always check that the normals are pointing towards the
outside of the mesh surface.

Smooth Smooths the normals by averaging neighbouring normals. This operation can be
applied repeatedly for added effect. Smoothing of normals does not change the
geometry of the mesh but can be used to smooth the surface (see Smooth Along
Normals above).
Show

Display the normals as blue vectors.

Repair
The Repair button shows a warning icon if the mesh is non-manifold:
It is highly recommended to attempt repair of non-manifold meshes because some functions may
fail if attempted on non-manifold meshes.
Diagnostics

Reports number of unreferenced vertices, triangles with non-manifold
edges and triangles with non-manifold vertices.

Repair Mesh

Attempts to convert a non-manifold mesh to a 2-manifold mesh. May not
be successful.

Select Zero Area Selects all triangles that have zero area, so that they can be deleted.
Triangles
Selects all triangles that are folded one on top of the other and lie on the
Select Flat
Folded Triangles same plane.
Viewbox can attempt to repair any non-manifold mesh without prompting, if the option Autocorrect Mesh Topology is checked in the Options - Mesh page of the Options dialog box.
Note: There is no Undo for the above functions. Make sure you have saved the
mesh before modifying it.
4.9.4.1

Cut a Mesh

To cut a mesh, using the cutting tool:

Draw the cutting line
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Right-click at successive positions along the mesh to define the cutting line.
Adjust the settings
Right-click on the tool's icon to open a pop-up menu:

If the path is not closed, then you can extend it at its ends, so that it cuts past the ending points.
The Cut Options are:

Path Closed Closes the cut line by connecting beginning to end.
Path
Extensions

Extends the beginning and end so that the cut can be made all the way to the
edge of the mesh, even though the line points are within the mesh.

Cut Depth

If this too large, the cut line may extend to parts of the mesh that are close to
the surface on which the cut line is drawn.

Cut
Thickness

The approximate thickness of the cut. Setting this to a small value creates a
fine cut line, but is slow.

Make the cut
Use Ctrl-Right click (right-click, while keeping the Ctrl key pressed) to complete the cut, or
select Cut the Mesh from the pop-up menu.
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Clip, Crop and Slice Meshes

Clipping
You can use the Clip tool to cut away part of a mesh.
First select the Clip Object tool:

Then drag the red, green and blue clipping handles with your mouse:
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Then select the Crop Straight or Crop Jagged option from the drop-down menu of the Crop
button:

Crop
Straight

The result of the cut is a
straight line (plane). Any
triangles that happen to
fall on the cutting plane
are divided into two or
three parts.

Crop
Jagged

No triangles are
subdivided. The result is a
jagged edge. This method
is significantly faster.
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Same as Crop Straight,
Crop
Straight and but the cut surface is
capped to close any holes
Cap
that may have been
created.
Before cropping:

Crop Straight:

Crop Straight and Cap:

Tip
The clipping planes may not be aligned to the object as desired. You can change the orientation of
the clipping planes by repositioning and "freezing" the object. The object shown below has clipping
planes that are not positioned correctly. Notice that we are viewing the object from the direction of
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the Y axis, directly straight-on (Anterior, as shown by the house at the lower right corner):

Step 1
Move the object, using the Object Widget, and align it to the three coordinate axes, as desired:
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Step 2
Select Freeze Transform from the Object menu. The clipping planes will be aligned to the
coordinate axes:
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Slicing
To cut the mesh along any plane, use the method of slicing:
Create a Slice
Click the Slice button in the Create section, then click Create Slice:
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Reposition the slice
Position the slice as desired, using the Object Widget:

Cut the mesh
Select the Mesh object in the Icon Area and select Slice from the drop-down menu of the Crop
button:

The mesh will be sliced into two pieces and a new mesh will be created. Below we see the two
meshes, separated from each other to show the position of the slice. On the left, the three objects
in the icon area, Mesh 1 held the original mesh but now holds the left piece, Slice 1 is the slice used
to cut the mesh (hidden), and Mesh 2 is the new mesh, holding the right part of the original mesh.
The slice is a straight slice and the procedure may be slow for large meshes.
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Tip
The Slice can be used again to cut other meshes at the same position.
Note: There is no Undo for the above functions. Make sure you have saved the
mesh before modifying it.
4.9.4.3

Mesh Decimation

Reduces the number of triangles in a mesh by moving and merging vertices together. Use Mesh
Decimation to simplify the mesh and increase the responsiveness of the computer, in cases where
the mesh is too big.
Mesh decimation simplifies the mesh adaptively, i.e. it first merges those triangles that have little
effect on the shape of the mesh. However, detail is invariably lost.
The following options are available:

Reduce number of
vertices by: (%)

Set the percent reduction in number of vertices that you desire.
E.g., setting this to 80% will reduce the vertices of a 100-vertex
mesh to 20.

Do not remove border
vertices

Does not remove vertices that lie on the border of the mesh.
Select this to avoid changing the border of the mesh.

Prevent flipping
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Recalculate normals
after decimating

During decimation, the normals at each vertex are not changed,
therefore they do not represent the new position of the vertices
and need to be recalculated for proper rendering. Make sure this
option is checked, so that normals are automatically recalculated
after decimating.

Note: Mesh Decimation is not reversible. Make sure original mesh has been saved
before proceeding.
4.9.4.4

Mesh Smoothing

Smooths the mesh by moving each vertex closer to the average position of its neighbours. This
function tends to reduce the volume of the mesh and may produce unsatisfactory results when
applied repeatedly.
The following options are available:

Do not smooth border
vertices

Does not move vertices that lie on the border of the mesh.
Select this to reduce mesh shrinking and keep details along
the border of the mesh.

Selected part only

Smooths the selected part only. If nothing is selected, then it
smooths the whole mesh.

Aggressive

Smooths the mesh more and usually results in mesh
shrinkage. Leave unchecked to reduce the shrinking effect.

Smoothing Iterations and
Smoothing Effect

Increase these to smooth the mesh more. It is recommended
to start with low values and repeat if the effect is not as
strong as desired.

Recalculate Normals after
Smoothing

During smoothing, the normals at each vertex are not
changed, therefore they do not represent the new position of
the vertices and need to be recalculated for proper rendering.
Make sure this option is checked, so that normals are
automatically recalculated after smoothing.

Note: Mesh Smoothing is not reversible. Make sure original mesh has been saved
before smoothing.

© 2020 dHAL Software, Kifissia, Greece

How to...

4.9.4.5

139

Close Holes

A mesh may contain one or more holes. To see the holes, click the Holes button
mesh Modify panel.
The Mesh Holes dialog box will open:

in the

When this box is open, all holes of the selected mesh are highlighted with a red outline:

Holes that are checked in the list box have a bright red outline, the others have a dark red outline.
To close a hole, select it in the list box, or click on its outline to make it bright red, then click the Fill
button. The Minimize area option is recommended but can be slow for large holes:
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If Select new triangles is checked, then all triangles that are created to close the holes will be
selected. If the result it not satisfactory, it is easy to delete them and try again.

Splitting holes
In some cases you may wish to close only part of a hole, or close the hole in stages. In such a case,
select the hole first, then click the Edit Mode button. The vertices of the hole will be marked with
red spheres. Click on one of these markers, then on a second one. The two markers will be joined
by a line and the hole will be split into two parts. You can now fill each part separately.
The palate, and the red outline showing one 'hole':

Edit Mode has been turned on:
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Click on the posterior corners to split the hole in two:

Select and fill the posterior part only:
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Combining holes
A mesh may consist of separate pieces s shown here:

If we just fill these holes, then the result may not be what was intended:
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Instead, turn on Edit Mode and click on two opposite markers of the two segments. Viewbox will
join the segments with a thin bridge:

The two holes have been bridged, resulting in one hole that can be filled as expected:

© 2020 dHAL Software, Kifissia, Greece

144

Viewbox Help

Project to XY (Z = 0)
Clicking the Project to XY button will translate all vertices of the hole to the X-Y plane. This can
be useful for closing a mesh with a flat base. The following figures show a digital model before and
after projecting the hole outline on the XY plane:
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Select Mesh Parts
There are two tools that allow you to select parts of a mesh: The Area Select and the Painbrush
tools. These are accessed from the Selection panel in the Objects Panel:

Area Select
Click on the Area Select tool to select it. Then right-click or right-drag to outline the part of the
mesh you wish to select. In the example below, several points have been right-clicked around the
palate, creating a yellow outline:
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To select the part of the mesh that is inside the yellow outline, right-click inside it, while keeping
the Ctrl key pressed. The selected part will take the colour of the active selection (here: light blue):

To select the part of the mesh inside the outline, use Ctrl and right-click inside the outline.
To select outside the outline, use Ctrl and right-click outside the outline.
To de-select, instead of Ctrl, press Shift and right-click.
Note 1
The selection outline is not drawn on the mesh, but on the screen. If the viewpoint is changed (e.g.
zoom-in), the outline remains at the same position, but the mesh will move underneath it.
After selecting, the outline remains on-screen, in case you need to select the same area on another
mesh. To remove it, de-select the tool.
Note 2
The Area Select tool selects triangles, so the outline drawn on the screen and the actual selection
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will not match exactly.
Also, all triangles inside the outline will be selected, even if they are on the other side of the mesh,
not directly visible.

Paintbrush
Ctrl-right-click on the mesh to select a continuous connected section of the mesh. In the
example below, all teeth belong to the same mesh, but we can select them independently in one
click (Ctrl + right-click) because they are not connected to each other.

Right-click on the mesh to select a few triangles around the clicking point. The number of
triangles depends on the Paintbrush Size. Right-click on the Paintbrush button
and select the size of the brush.

to open a menu

The Paintbrush can be used as a Smart Brush to automatically select salient areas of the mesh.
See the Mesh selection tutorial.
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By Visibility
Use the Select by Visibility menu item from the Selection menu to open the Visibility dialog box:

If the slider is set at zero, then all completely hidden vertices will be selected. Setting to 100% will
select the whole mesh.
This method is useful to select, and then delete, all parts of the mesh that are not visible, because
they are in the interior of the mesh.
The procedure may be slow because visibility of all vertices needs to be calculated.

Selection menu
After a part of the mesh has been selected, you can use the Selection menu to delete it,
deselect it, invert the selection (deselect the selected and select the unselected triangles) and
create a new mesh that contains only the selected triangles:

Note: There is no Undo for Delete functions. Make sure you have saved the mesh
before modifying it.

Selection groups
On each mesh you can have up to 20 selection groups. Before selecting part of the mesh, select
the group that you want to use from the drop-down list:
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Also see the tutorial on mesh selecting

4.9.6

Mesh Registration
Mesh registration is useful for aligning meshes to each other. For example, assume that you have
acquired two partial meshes of an object that have a common region (here the incisors):

To align these two meshes we first do a manual registration by specifying a few corresponding
points on the two meshes. Click the Mesh Registration button:

This will open the Align Meshes dialog box:
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Assume we want to move the orange mesh to the blue mesh. The blue mesh is then our Target
mesh.
Select the digitizer tool:
Click a few points (at least 3 are required) on each of the meshes. The points should be on
corresponding points of the two meshes and they need to be clicked in the same sequence on both
meshes. You could click all the points on one mesh and then repeat for the other, or you could
alternate between the meshes. Viewbox will connect corresponding points with green lines:
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Click Align to align the meshes:

This is a rough alignment, based only on the position of the points. Click Clear All to delete the
points.
A better registration can be achieved using the Auto Pairwise section of the Align dialog box:
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First, set the mesh that is not going to move as the Reference Object:

Then set Estimated Overlap of Meshes (%) to a low value, because here only a small part of
the meshes is common between them. In this case we try 20%. Then click Align. You may need
to click Align several time, until there is no evident improvement in the fit:
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Notice the stippled appearance of the overlapping area, signifying a good fit between the two
surfaces.
For details, see Mesh Registration Details.
For aligning multiple meshes, see Global Mesh Registration.
For a tutorial on mesh registration, see the Tutorial: Superimpose casts on the palate.

4.9.6.1

Mesh Registration Details

Viewbox uses a variant of the Iterative Closest Point (ICP) algorithm for registration of mesh
surfaces. The original algorithm is by Besl and McKay [?1]. In the following, ‘source mesh’ refers
to the mesh that is moved and ‘target mesh’ is the mesh on which we wish to align the ‘source’.
Viewbox supports the following variations of ICP:
Random sampling of points: Instead of selecting all vertices of the source mesh the user can
specify a subsample of the vertices, either as a percentage or a fixed number. This speeds up the
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alignment. Vertices are selected randomly at each iteration.
Trimmed ICP [?2]: The distances between paired points are sorted and the largest ones are
rejected. The percentage of rejected points is specified by the user. Viewbox does not compute the
overlap parameter automatically [?2]. Trimmed ICP is useful if the meshes have areas that are
known not to overlap.
Point to Plane [?3]: In addition to the original ‘point to point’ correspondence search, where
vertices of the source mesh are matched to vertices of the target mesh, Viewbox supports ‘point to
plane’ matching, where each vertex of the source mesh is matched to the projection of that vertex
on the plane that is normal (tangent) at the position of the closest point of the target mesh.
The following options are available:

Selected area of If checked, only the part of the source mesh that is selected will be used
source mesh only for registration.
Exclude
overhangs

If checked, any vertices of the source mesh that match to vertices on the
border of the target mesh will be ignored (recommended).

Estimated overlap If the meshes are known not to overlap completely, then set this to the
estimated amount of overlap. This is the percentage of point
of meshes (%)
correspondence pairs that will be rejected, according to the Trimmed ICP
variant [?2].
Threshold (mm)

Distance between corresponding points: if this is set to a value larger than
zero, then only point pairs that are within the threshold are considered,
others are ignored.
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Matching: Point to ‘Point to point’ uses the original ICP variant. ‘Point to plane’ allows sliding
of the meshes to each other and usually results in faster and better
registration.
Point sampling

Set to a low value for fast results. For better accuracy set to 100%.
Values in the right column are absolute numbers (number of vertices).

Searching for the closest point is the most time consuming step of the ICP
Nearest
Neighbour Search algorithm. Viewbox uses a kd-tree for fast searching. The Approximate
setting does not guarantee that the closest point will be found, but is
substantially faster. The Exact with normal compatibility setting
searches for points that have compatible normals (within 45° to each
other), thus ensuring that surfaces which are oriented very differently from
each other are not matched.
Iterations

Number of iterations. The algorithm may stop earlier, if it detects no
further improvement in alignment.

The ICP algorithm is known to be sensitive to local minima and to the initial
Test different
starting positions position of the meshes. If this option is checked, Viewbox will try different
initial positions and perform ICP for each of these in turn, finally selecting
the best result.
Retain for Global If this is checked then the pairwise alignment results (the matching points)
will be retained for future global (multi-object) alignment.

Recommendations
Before aligning make sure that the meshes are close to each other and roughly aligned.
Alternatively, use the Test different starting positions, but this may be slow, so set it to a low
number (e.g. 10).
Prefer Point to Plane.
Start with Approximate and 1% point sampling, and repeat the alignment a few times, until
you get a good fit. Then, set to Exact and 100% and try again.
Estimated overlap should be 100% only if you are certain that the meshes should superimpose
fully. Otherwise set to 90% or 95%. If you want to align on only part of the mesh, then select that
part first (using the Selection tools), then use the Selected area of source mesh only.
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1. Besl PJ, McKay ND. A method for registration of 3-D shapes. IEEE Transactions on Pattern
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International Conference on 3-D Digital Imaging and Modeling (3DIM) 2001:145-152. doi: 10.1109/
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4.9.6.2

Global Mesh Registration

Global mesh registration allows registration of many meshes simultaneously. For example, assume
that we have scanned the upper and lower dental arch and we also have scanned the occlusal
relationship (bite registrations) on the right and left sides of a patient. There are four meshes:
Maxillary arch
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Mandibular arch
Left bite
Right bite
We wish to position the maxillary arch in relation to the mandibular arch, via the bite registrations.
The un-registered meshes:

Step 1 - Register all pairs
Use the pairwise mesh registration procedure to register each mesh to the others, in pairs. See
Mesh Registration, but make sure that Retain for Global is checked.
So, first register the right bite to the maxillary arch. We can select the maxillary part of the bite
mesh for faster results. We do it in two stages, first using an Approximate Nearest
Neighbour search with 1% point sampling, then switch to Exact and 100%, also checking
the Retain for Global option:
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This is the result:
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The red dots show matching points between the two meshes.
The second registration is the right bite to the mandibular arch:

Notice that this destroys the previous registration, but the matching points are retained, so it is
possible to return to it very easily.
Then, the left bite to the maxillary and mandibular arch, in turn:
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Note: in order to accomplish the 4 pairwise registrations, we need to change the reference object
accordingly.
After registration, the Global page of the Align dialog box shows the results, the numbers being
the number of matching points that were found:
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Step 2 - Align all meshes together
In the Global page of the Align dialog box, click Align. The meshes should align to each other as
shown below:
Before alignment:

After alignment:

After deleting the pairs from the Global alignment page (right-click for a pop-up menu):
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Dynamics
Viewbox features a basic collision detection system and a gravity-based dynamic simulation. This
applies to Mesh objects only. There are two modes available, Ground Plane and Reference Object.
When the Dynamics feature is activated, the selected mesh will either fall and land on a plane, or
on the reference object.

Ground plane
Select the direction of gravity (X, Y, or Z) and activate the Dynamics system by clicking the Run
icon. The selected object will land on the corresponding plane (YZ, XZ or XY). When the object
has landed and has stopped moving, click the icon to stop the Dynamics system. Click the toolbar
button to show contact points (small red cubes), centre of gravity and direction of the contact
forces.
Before and after dropping on the ground plane XY (contact points are marked by the vertical blue
lines):
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Reference object
This works in the same manner as the Ground Plane, but the object lands on the reference object.
The reference object must:
be a mesh
be closed (watertight)
Make sure that the reference object is in the direction of gravity. During Dynamics running you can
use the Object Widget to adjust the position of the object.
Before and after dropping on the reference object:
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Due to collision detection, there is no inter-penetration of the objects. Also, because rotation and
sliding are allowed, a stable position is reached, achieving good contact.
Settings for the Dynamics function can be adjusted in the Options dialog box.

4.10

Work with Point Clouds
Point Clouds are collections of points.
Point Clouds can be created from meshes or from volumes. When creating a point cloud from a
mesh, the vertices of the mesh are used as the points of the point cloud. When creating from a
volume, a mesh is first created (see Create Meshes) and the vertices of that mesh are used.
An example of a point cloud:
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The size of the points can be adjusted:

Clipping and Cropping is similar to meshes.
Rendering by points is very fast but the points may be difficult to see. There is also the option to
render each of the points using a small sphere. This is appreciably slower:
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If a point cloud that is rendered using spheres is saved, the resulting object will be a mesh
composed of many small spheres. Such an object can be very large, depending on the number of
spheres (points) of the point cloud and the quality of the spheres. Sphere quality is set in the
Options dialog box:

Get Points
Point Clouds can be expanded by importing points from other point clouds or from meshes.
To import points, click the Get Points... button:
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The mouse cursor will change into a left-arrow. Click in the Icon Area on the mesh or point cloud
from which you wish to import the points:

Note: Point Clouds in Viewbox are always associated with a patient. It is not
possible to load a Point Cloud without a patient.

4.11

Work with Volumes
Volumes are 3D data, usually acquired from computed tomography or MRI scans. Viewbox can
load volume data, display it in the 3D Display and allow you to locate points on the data so that 3D
measurements can be calculated.
As images are composed of pixels, so are volumes composed of 'voxels'. Each voxel can have a
'density' value, which usually ranges from 0 to 255 or from 0 to 65535. The density of a voxel is
related to the density of the tissue at the voxel's location: hard tissues, such as bone or enamel have
high densities whereas soft tissues have lower densities.
Note: Volumes in Viewbox are always associated with a patient. It is not possible to
load a volume without a patient.

4.11.1 Open a Volume
Volumes are associated with patients, so in order to load a volume, you need to
have a patient loaded and selected first.
Viewbox can load volume data from volume files or from multiple image files, each of which
represents a slice through the volume.

Volume files
Volume files that are supported are Analyze 7.5 files, NIfTI-1 files and GIPL files. Analyze 7.5
data are composed of two files, one with the .hdr extension and one with the .img extension. NIfTI
files have the .nii extension and GIPL files have the .gipl extension.
Volumes can also be loaded by opening slice images. Slice images can be BMP, JPEG, JPG, TIFF,
VIFF files or DICOM files (e.g. DCM files). DICOM files are usually accessed by a special
DICOMDIR file that contains information related to the individual slices.
To load a volume file select Object | Open | Open Volume... from the menu. If you wish to load
an Analyze file, select either the hdr or the img file. For DICOM files, select the DICOMDIR file,
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if available. Otherwise select any of the files that contain the slice images.
If you selected an Analyze 7.5, aNIfTI or a GIPL file, then the volume will be loaded without any
other prompting. Otherwise the Load Volume dialog box will appear:

The Load Volume dialog box will be different, depending on whether you have selected a
DICOMDIR file or an individual slice file:

Using individual files:

Using DICOMDIR files:

In case of individual slice files, the left side
of the dialog box will show the File Name
Pattern and the list of files that match this
pattern:

DICOMDIR files contain lists of DICOM files
(volume slices) taken during an examination
session of a patient. Select a Series of slices
from the DICOMDIR file or any image from
the series:

Names of files that constitute volume slices
usually contain a numeric part that increases
sequentially. The File Name Pattern
specifies which part of the name is the
numeric part. Viewbox will try to extract
this automatically. In the example above,
Viewbox has determined that the sequence
is eight characters long and is positioned at
the end of the file name (shown here as
[#8]). If this is not correct, change it and
click the Refresh List button.
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Sometimes, the files are not numbered in the
correct sequence. In such a case, use the
Sort by Image Number option.
Selecting an entry from the image list box will show the slice in the central viewer. Here you may
need to specify the orientation of the slice, so that Viewbox can assemble the slices and show them
correctly. If the slices are DICOM files, then Viewbox will most probably read the orientation from
the DICOM files and no intervention is necessary. Otherwise, use the buttons on the top and right
side of the slice. The example below shows that top side of the slice has been specified as the
patient's superior (S), whereas the right side of the slice (as viewed here) is the patient's left (L).

To crop the slices, so that only part of them is loaded, drag the red cropping lines in the preview
pane:

To adjust the brightness, contrast, gamma of the images, check the Use Manual Levels box and
use the available controls:
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The toolbar buttons will zoom the histogram and set the levels to those specified in the DICOM file
or to those that include the whole available range. The sliders underneath the histogram will allow
you to change the levels. The same settings will be used for all the images in the sequence.
These settings are for viewing the images before loading them. They do not affect the values of the
voxels.
The Volume section shows data for the volume:

The X, Y and Z Size data are read from DICOM files. If the slices are not in DICOM files, then
you should enter the values yourself.
The X and Y sizes show the size of the voxels in the x and y direction. Usually
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these values are read correctly from the DICOM files and should not be changed.
The Inter-slice Distance is calculated by taking the difference between the Slice
Location of two consecutive slices. Notice that Slice Thickness and Inter-slice
Distance may not be equal, because slices may be thicker than the distance
between them. Viewbox uses the Inter-slice Distance setting to position each slice
along the Z axis.
To load all slices, select All Slices and click the Build Volume button.
To load selected slices, enter the appropriate numbers in the Slice Range boxes, then click the
Build Volume button.
Loading of volumes is a time intensive process.

4.11.2 Volume viewing
Volume data can be displayed in Viewbox in two ways:
Ortho Slices
Volume Rendering
4.11.2.1 Ortho Slices

To show the principal slices of the volume, check the X, Y and Z boxes and move the slice sliders:

4.11.2.2 Volume Rendering Modes

Volume rendering shows the whole volume as a solid object. Some tissues can be shown semitransparent, in order to reveal the tissues beneath them:
Viewbox supports various methods of volume rendering which can be selected from the Render
section:
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Select the desired Rendering Mode and make sure that the Render box is checked.
Isosurface
An isosurface is a surface that passes between voxels that have lower and higher densities than a
particular value. The value is called an iso-value or threshold and is specified from the
Histogram window. Viewbox supports two iso-values and can show two isosurfaces, the Primary
and the Secondary. The pictures below show rendering using one isosurface and two isosurfaces.
Notice that the isosurface used for the soft-tissues is rendered here semi-transparent. Settings for
each isosurface are adjusted using the isosurface buttons:
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Transparent isosurface showing the softtissues.

Opaque isosurface showing the bones.

Both isosurfaces. Specular highlights have
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been added.

The properties of each isosurface are set from the Primary and Secondary buttons:

Transfer Function
Rendering using a transfer function assigns different colors and opacities to voxels depending on
the voxel density and gradient. This method allows visualization of all voxels:

Viewbox ships with sample transfer functions which can be selected from the drop-down box. The
MIDA slider adjusts the level of Maximum Intensity Difference Accumulation, which allows
viewing dense structures inside the volume, even if the transfer functions renders the surrounding
tissues opaque (see Calculation details):
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Maximum Intensity Projection (MIP)
Maximum Intensity Projection (MIP) shows the most dense voxel along the line of sight:

Average (X-Ray)
This method of rendering produces an image comparable to a plain radiograph:
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GPU or CPU rendering
Each of the volume rendering modes can be created using different algorithms. Viewbox supports
two methods, selectable from the Rendering Engine menu:

GPU Ray Casting Uses the Graphics Processing Unit of your graphics card for fast
rendering.
Recommended if your graphics card supports it.
Software Ray
Casting

Works with all graphics cards because it is completely software based.
Speed depends on your main processor.

If a Rendering Engine it is not supported by your hardware, or cannot be used for
the particular rendering mode selected, you will see a wireframe 'X' box, as
depicted below. In that case, select another Rendering Engine. Software Ray
Casting can handle all rendering modes.
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Volume rendering is a very computationally intensive process and may be very
slow depending on your computer capabilities. The fastest renderings are the
isosurface renderings.
Volume rendering using Transfer Function, MIP and Average cannot be used for
digitizing points. For that purpose you should use Isosurface rendering or Meshes
or Point Clouds.
4.11.2.3 Histogram and Transfer Functions

The iso-surface thresholds and the volume transfer function can be adjusted from the Histogram
and Transfer Function dialog window. Click the Histogram button
open the window:

to
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The Histogram window is divided into two panels. The relative height of each panel can be
adjusted by dragging the line that divides them.

Lower panel
The lower panel shows a histogram of the voxel densities. The minimum and maximum values are
displayed below the histogram.
To restrict the active range of voxel values that is displayed, drag the left and right sides of the
histogram towards the middle and click the Apply button.

Upper panel
The upper panel shows a 2-dimensional histogram of the voxel values. The horizontal axis
represents the density of the voxels, similarly to the lower panel. The vertical axis represents the
gradient of each voxel, i.e. how different each voxel is from its neighbours. For example, if the
voxel is located on the outside surface of bone, then it will have a high density, therefore it will be
located towards the right in the graph, but it will also have a high gradient because roughly half of
its neighbours are soft tissues, therefore is will be located towards the top of the graph. Bright
areas of the graph signify a high concentration of voxels. Usually, there are three bright areas at
the lower part of the graph, one corresponding to the air surrounding the patient's head, one
corresponding to the soft tissues and one to bone. These areas are connected by rainbow-like arcs
representing the external surfaces where air voxels, soft-tissue voxels and bone voxels have a high
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gradient.

Thresholds
The primary and the secondary thresholds can be set by dragging the two vertical lines. The
continuous line represents the primary threshold and the dotted line the secondary one. These lines
may not be clearly visible if they are all the way to the left or the right in the graph area.
Transfer functions
A transfer function determines how each voxel will be shown in the 3D display, depending on its
density and gradient. For each density and gradient combination, Viewbox assigns a colour and a
transparency value, based on the transfer function widgets that have been added to the graph area.
You can use the pre-defined transfer functions (menu: File | Open...), or create your own (menu:
Edit | Add Widget).
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The image above shows one of the pre-defined transfer functions ('warm bone'). The spheres on
the top border of the widget are used for specifying the colour. Right-click on a sphere to set its
colour, to delete it or to add a new sphere.
The spheres on the white line inside the widget are used for setting the opacity of the voxels. The
higher the white line is, the more opaque the voxels are.
In the example above, the left-most voxels are set as completely transparent (and black).
Therefore, the air voxels and almost all soft-tissue voxels will not be visible. The middle-range
voxels will be semi-transparent and orange in colour, whereas the voxels of high density (on the
right side of the graph), corresponding to bone, will be opaque and white. Notice that the widget
extends to the whole width of the histogram but has been positioned slightly higher than the
horizontal axis. Therefore, all voxels that are close to the horizontal axis, and all those that fall
above the widget, will be ignored (not visible).
It is not easy to create a good transfer function for a volume image. It is recommended that you try
the pre-defined transfer functions and adapt one of those. You can save the result for later use.

4.11.3 Volume Filters
Data from CT or CBCT machines can contain noise artifacts. Viewbox supports a few filters that
can be used to improve the data and result in better rendering. The filters can be accessed using
the Filter button:

The most useful filter to reduce noise without introducing too much blurring is the De-noise filter.
The radius over which each filter operates if specified in the rad. selection box. A large radius will
require a very long processing time. Values of 1 or 2 are recommended.
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4.11.4 Clip and Crop Volumes
You can use the Clip tool
to cut away part of a volume.
For example, to cut away part of this volume, select the Clip tool:

Then drag the red, green and blue clipping handles with your mouse:

Then click the Crop button:

The resulting volume:
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4.11.5 Segmentation
Segmentation is the process of selecting part of a volume or specific voxels, that can then be
deleted. For example, in the image below, we would like to segment the mask and remove it:

Initial.

Mask selected.

Mask removed.

Using the same patient as an example, we can select the mandible:
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Mandible selected.

Other structures deleted.

Mandible segmented.
4.11.5.1 Segmentation Details

To segment a volume use the Volume | Segmentation menu command or click the
Segmentation button:

Once the Segmentation procedure starts, Viewbox assigns some memory to store the segmentation
data. Each voxel can be assigned to one or more selection groups (there are 8 selection groups
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available). These can be edited in the Segmentation dialog box:

The dialog box has two modes, the Undo mode and the Multiple Selection mode. The image
above shows the dialog in the Undo mode.
Undo mode
Multiple
Selection mode

Voxels can be set to either selected or un-selected. There are seven levels
of undo available.
Voxels can be set to one of 8 selection groups. Selection groups can be
merged, added or subtracted from each other. There is no undo available in
this mode. To switch to this mode, check the Multiple Selections checkbox. In this mode, the dialog box can be expanded to the right, revealing
additional features.

The dialog box has 7 pages for adjusting the parameters of the various segmentation tools.
The first page allows selection of voxels at the global level, i.e. irrespective of their position in the
volume. The available options are:
Minimum
Threshold,
Maximum
Threshold

Set the minimum and maximum values for selecting voxels.

Fill from
Isovalues

Fills the minimum and maximum values from the current isovalues (primary
and secondary thresholds, see Volume Rendering)

Select

Selects the voxels. The topmost Select button selects all voxels that have a
value smaller or equal to the minimum threshold, the next Select button
selects all voxels that have a value between the two thresholds, and the
bottom-most button selects all voxels that have a value equal to or greater
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than the maximum threshold.
Dilate

Grows the selection by adding voxels around the already selected voxels.

Erode

The opposite of Dilate.

Statistics of
Selected...

Computes various statistics on the selected voxels, including volume and
surface area. The Average Density of the External Surface is the
average density of the voxels that are on the outer surface of the selected
region; selected voxels that are completely surrounded by other selected
voxels do not contribute to the calculation.

Clear

Deselects all voxels.

Invert

Inverts the selection.

Set Value

Sets the value of all selected voxels to the one chosen from the drop-down
menu.

The other six pages of the dialog box allow editing of the parameters of the region-growing tools
and the paintbrush.
The Paintbrush page

Region-growing pages
To use a region-growing tool you need to Right-click on a voxel (called the 'seed' voxel) and then
Viewbox will select voxels by spreading outward from the seed voxel, as long as some specified
criteria are valid. For example, the Threshold and Gradient tool will select voxels as long as
their value is within the range specified by the primary and secondary isovalues and their gradient is
less than the specified Gradient Limit. The maximum number of selected voxels is set by the
Spread control:
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Multiple Selection Mode
In this mode, the dialog can be extended to the right. Now, each voxel can be assigned to one of 8
selection groups and these groups can be merged together, subtracted, added, or their intersection
can be computed. There is no undo in this mode.
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Work with Slices
Slices are cut planes that can be positioned at any location and angle to show a cross-section of a
volume or a mesh. They are similar to Ortho Slices but they are not limited to orthogonal positions
and they can move along a user-specified path to explore the volume or mesh.
To create a Slice use the Object | Create from Object | Create Slice menu command. The slice
will be associated with the volume or mesh selected in the Attach listbox:

Example of a slice attached to a volume:

A slice at an arbitrary position within the volume.

Just the slice, without the rendered volume, showing
an impacted canine and a small odontoma.

To reposition the slice, use the Object Widget tool:

Alternatively, set the path of the slice, as shown in Slice Path.
To show the image of the slice in a separate window, click the Slice Viewer button:
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The slice viewer window:

Planes
Each slice has 3 planes, plus a panoramic plane. Select which plane is visible and active:
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The following image shows all three planes, with the X plane positioned posteriorly, as shown by
the slider in the above image:

The panoramic plane follows the path of the slice:
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4.12.1 Slice Path
A slice can move along a path specified by the user. To edit the path click the Edit Path button:

Change the number of points to make the path more complicated. Each point can be moved with
the mouse and the path can be twisted by dragging on the arrows along it. The whole path can be
rotated by dragging on the red wheel. The image below shows a slice path positioned on the axial
slice of a volume. There are 5 control points. The frame of the slice is shown as a blue rectangle:
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If the volume is rendered in Iso-surface rendering mode, or if the Ortho Slices are visible, you can
slide the path points on the volume. Alternatively, Right-click on the volume to set the position of
the path points. The point specified in Set Point is the one that will be set at the next right-click.
To set the position of the slice along the path use the position controls:

4.13

Perform a VTO
A dataset may be altered by translating or rotating skeletal and dental units. In this way a
simulation of growth or treatment can be performed, resulting in a Visual Treatment Objective
(VTO). Viewbox allows complete freedom in moving skeletal and dental components either
individually or in groups. Individual points can also be adjusted. Optionally, soft tissues can be
automatically adjusted to skeletal movements.
Movement of areas can be performed interactively by moving the mouse, by using the arrow keys
from the keyboard, or by specifying the amount of desired movement in the Move dialog box.
Before moving areas or points, they need to be selected. Movements can be reversed or repeated
by using the Undo and Redo commands from the menu or from the Main toolbar.
Selecting areas and/or points
Translating
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Rotating
Using the Keyboard
Using the Move dialog box
The Movement window
AutoVTO

4.13.1 Selecting areas and points

Using the Select Area dialog box:
Choose Select Area... from the Edit menu to open the Select Area dialog box:

Select the areas and points you wish to move. To select more than one, hold down the Shift and/or
the Ctrl key. To de-select an entry, hold down the Ctrl key and click on it. Remember that selecting
an area (e.g. Mandible) will select all the points that belong to that area (e.g. Pogonion, Gnathion,
Gonion, etc.).

Using the mouse:
Use the Select/Move tool

from the Objects Panel:

The Select/Move tool will select areas by clicking near a point that belongs to the area. For
example, to select the Mandible, click near Pogonion, or Gnathion, or any other point that belongs to
the Mandible. If the correct area is not selected, try holding down the Ctrl key and click again. To
select more than one areas, hold down the Shift key and click on each area in turn.
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Right-clicking in the Display:
If you right-click in the Display, a menu pops-up. The menu contains the commonly used tools
(Select, Translate, Rotation Centre and Rotate). Additionally, if you right-clicked over a point
belonging to an area, the area is also displayed. Multiple areas may appear if the point belongs to
more than one areas. You can select the desired area from this menu:

If you right-click on the Select/Move tool

, a menu pops-up:
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From this menu you can call the Select Area dialog box (see above), or choose Select All to
select all points. If Area Handles is checked, then a small marker appears for each area. These
markers can be used to move the areas without selecting them first.

Notes:
The selected area or point is shown in the Status Bar. If more than one area is selected the Status
Bar shows 'Multiple Selection'.
Once an area is selected, small markers appear on the points that belong to that area:

The colour, shape and size of the markers can be set from the View section of the Options dialog
box.
Once an area is selected, it can be moved with the Select/Move tool, or with the Translate and
Rotate tools. See Translate and Rotate for more details. The following animation shows how an
area can be selected, rotated and translated, all with the same tool (the Select/Move tool
which is also used to change the position of the Rotation point:
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4.13.2 Translating

To translate an area using the Select/Move tool:
This is the easiest method and, therefore, recommended.
Because translating an area usually follows its selection, the Select/Move tool
already the active tool. If not, choose it from the Tools panel:

is probably

Position the mouse cursor over one of the cross-arrows and drag the mouse to move the area. In
the animation below notice that the measurements change as you drag.

To drag a single point, place the mouse cursor over the point's marker (the red square) and drag.

To translate an area using the Translate tool:
To translate a selected area in the x- or y-direction, choose the Translate tool
. Position the
mouse anywhere in the Display and drag it in the direction of the desired movement. The amount
of translation is shown in the left panel of the Status Bar.

To translate a single point of an area:
First select the area, then position the mouse on top of one of the area's markers. The mouse
cursor changes to a thin cross
and the point's name appears in the Status Bar. Drag the
mouse to move only the point and not the whole area.
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Using the Area Handles:
Alternatively, turn on the Area Handles option from the View menu or from the pop-up menu of
the Select tool. Small markers will appear, one for each area. Position the mouse cursor exactly on
top of one marker and it will change to a thin cross
. Drag the mouse and the area will follow.
This method is faster because you do not have to select the area before translating it. The name of
the area that will be moved appears in the Status Bar when the mouse is on top of the marker.

Notes:
Movements can be undone by selecting Undo from the Edit menu, or by using the Movement
window, if it is open. Movements can also be repeated for the same or for another area.
Derived points cannot be moved directly. They are recalculated automatically and updated after
movement of the digitized points.
During translating, the measurements will be updated automatically.

4.13.3 Rotating

To rotate an area using the Select/Move tool:
This is the easiest method and, therefore, recommended.
Because rotating an area usually follows its selection, the Select/Move tool
already the active tool. If not, choose it from the Tools panel:
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Position the mouse cursor over one of the curved-arrows and drag the mouse to rotate the area. In
the animation below notice that the measurements change as you drag.

You cannot rotate a single point using the Select/Move tool. You will have to use the Rotate tool
(see below).

To rotate an area using the Rotate tool:
To rotate a selected area, choose the Rotate tool
. Position the mouse anywhere in the
Display and drag it in the direction of the desired movement. The amount of rotation is shown in the
left panel of the Status Bar.

To rotate a single point of an area:
First select the area, then position the mouse on top of one of the area's markers. The mouse
cursor changes to a thin double arrow
and the point's name appears in the Status Bar. Drag
the mouse to move only the point and not the whole area.
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Using the Area Handles:
Alternatively, turn on the Area Handles option from the View menu or from the pop-up menu of
the Select tool. Small markers will appear, one for each area. Position the mouse cursor exactly on
top of one marker and it will change to a thin double arrow
. Drag the mouse and the area will
follow (see: Translate).
This method is faster because you do not have to select the area before rotating it. The name of
the area that will be moved appears in the Status Bar when the mouse is on top of the marker.

Notes:
Rotations are performed around the Rotation Centre. To reposition the Rotation Centre, select the
Rotation Centre tool
and click on the Display at the desired position. Alternatively, use the
Move dialog box. The Rotation centre can also be dragged to a new position by the Select/Move
tool

as shown below:

Movements can be undone by selecting Undo from the Edit menu, or by using the Movement
window, if it is open. Movements can also be repeated for the same or for another area.
Derived points cannot be moved directly. They are recalculated automatically and updated after
movement of the digitized points.
During rotating, the measurements will be updated automatically.

4.13.4 Moving with the Keyboard
Pressing the Arrow keys will translate or rotate the currently selected area, depending on whether
the Translate

or Rotate tool

is selected:

Key combination:

Translate:

Rotate:

Arrow key

1 mm

1 degree

Shift + Arrow key

10 mm

10 degrees

Ctrl + Arrow key

0.1 mm

0.1 degrees

The right and down arrow key will rotate clockwise and the left and up key will rotate counterclockwise.
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4.13.5 The Move dialog box
Precise movements can be performed by entering the desired movement values with the keyboard.
Open the Move dialog box by selecting Move... from the Dataset menu:

Enter the amount of movement in the appropriate fields and press the corresponding button to
execute the movement.
The Rotation Center can be set to coincide with any point of a loaded tracing, by first selecting the
point from the drop-down list box and then pressing the Set To -> button.

PCA section:
The PCA section allows you to move points that belong to a PCA according to the directions and
weights of the specified Principal Component (PC).
First select the PCA, then the PC. Change the value of the PC, either by entering a new value in
the edit box and clicking Set To ->, or by dragging the slider control.
The button Match to Reference will change all PCs so that they are equal to the PCs of the
Reference Dataset.
Note: Any movements applied in the PCA section cannot be reversed, because
they are not logged in the Movement window.

4.13.6 The Movement window
The Movement Window records all movements that are executed during a VTO, so that it is
possible to undo or re-execute any of them. Open it by selecting Movement from the Windows
menu:
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The Movement window contains two panes. The top pane is the Undo List and shows
movements that can be undone, returning the dataset to its previous state. If a movement is
Undone, it is erased from the Undo List and placed in the bottom pane, the Redo List.
To undo or re-execute the last movement, select Undo or Redo from the Edit menu. The
movement will be erased from one of the lists and placed in the other.
Note: It is not necessary to have the Movement Window open in order to undo or redo
movements. Just use the Viewbox Edit | Undo and Edit | Redo menu commands.
To Undo or Redo a group of movements, select them from the Movement Window and choose
Reverse Selected or Repeat Selected from the Edit menu. This will not affect the movements in
the Undo and Redo Lists.
If you want to select the same areas and points that have been used previously for a movement,
select the movement and choose Select Area from the File menu.
If option Move: Original Area is selected, then the area that is specified in the Movement window
will be moved when undoing or repeating a movement, regardless of the currently selected area in
the Display. If option Move: Current Area is selected, then the currently selected area will be
moved. This may be quite useful if, for example, you have moved the maxilla and then you want to
move the mandible in the same direction and by the same amount. Just select the mandible as the
current area, make sure Move: Current Area is checked and select Repeat Selected.
If option Compile is checked, then all movements involving the same area will be added together
as they are executed. For example, if Maxilla is translated 1 mm to the right, the following
movement will be added to the Movement Window:
Maxilla: T: dx:1, dy:0
If the maxilla is again translated another 1 mm to the right and the Compile option is on, then no
new movement will be added, but the last movement will change to:
Maxilla: T: dx:2, dy:0
The Movement window options can also be changed by double-clicking on the panels of the status
bar:

4.13.7 Auto VTO
AutoVTO is for automatically adjusting soft-tissues to changes in hard tissues during a surgical or
treatment VTO. The 'Lateral ceph' Dataset Template that is supplied with Viewbox has such soft/
hard tissue ratios pre-defined. For example, moving the incisors or the mandible will affect the soft-
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tissue profile.
If the AutoVTO button is depressed
while translating or rotating an area, then additional
areas may also translate and/or rotate automatically. This will depend on the VTO Relationships
that have been defined for the Dataset Template.
When AutoVTO is on, additional movements may be logged to the Movement Window. Reversing
of the movements occurs in stages: first the soft-tissue movements and then the hard tissue ones.
You can change the pre-defined ratios, delete the relationships or add new ones. See Defining
Dataset Templates.
Notes:
If you want to translate or rotate the whole tracing, this can be done by selecting All Points and
then using the Translate or Rotate tool. For this procedure it is a good idea to turn AutoVTO off,
otherwise Viewbox will move the soft tissues twice: once because they are selected with Select
All, and a second time because soft/hard tissue ratios apply.

4.14

Morphing
The following steps are required for morphing of images:

1. Open the initial dataset and the image
Load the initial dataset from disk or digitize a new dataset. See Open a patient and How to digitize
for detailed instructions.
Next, load the photograph of the patient. Use the Image | Open... menu command.
The icon area should be like this:

2. Align the image with the tracing
The photograph of the patient must be registered with the tracing. See here for an overview of the
procedure and click here for details.
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3. Set the reference source
Make sure that the initial dataset is the Reference Dataset. This is shown by a marker next to the
dataset icon. You can set the reference source by right-clicking on the icon and selecting
Reference from the pop-up menu.
Also, make the initial image the Reference Object, by right-clicking and selecting the appropriate
command from the pop-up menu. The icon area should now look like this:

4. Make a duplicate to use for the VTO
Use the Object | Duplicate... menu command to make a duplicate of the initial dataset. The
duplicate will be used to construct the treatment prediction. It is a good idea to change the
Comments of the duplicate tracing to something that will show that it is a treatment prediction
(e.g. set the Comments to "Prediction tracing").
The icon area should now be like this:
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5. Make the treatment prediction
Use the Translate and Rotate tools to construct the treatment prediction. Make sure that Auto
VTO
is turned on, so that the soft-tissue outline automatically adjusts to the underlying hard
tissue movements.
During this stage, you can use the Interactive morphing feature to get a rough idea of the final
morphed image.

6. Create the morphed image
Select the initial image in the Ion Area, then select Image | Create Morph from the menu, or
click the Create Morph button
on the Objects Panel. Viewbox will
construct the morphed image.
The icon area shows the newly created image. Note that we have locked each image to its
corresponding tracing so that they can be moved together:

Notes
The morphed image is created 'underneath' the original image, so it will not be visible initially. You
can a) hide the original image, b) make the original image semi-transparent, or, c) drag the
morphed image icon to a higher position than the original image in the icon area.
Before doing the morph, make sure that the prediction dataset is the current dataset and the initial
tracing is the Reference Dataset.
Morphing can be done by four different algorithms. Exponential usually gives the best results.
Triangle interpolation is the fastest but may create artefacts if the treatment movements are
large. Parameters for the morphing algorithms can be tweaked in the Options dialog box.

The interactive morph window
This window can be opened from the Windows menu:
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The Interactive Morph window shows a rough preview of the morph, as it is being created while
you change the dataset. It uses the triangle interpolation method for fast results, so artefacts
may occur. Use the mouse to reposition the image and to zoom (mouse-wheel). The

4.15

Geometric Morphometrics
Several Geometric Morphometric (GM) functions are supported. Viewbox can compute a
Procrustes alignment, a Principal Components Analysis of Procrustes coordinates in both shape
and form space, it supports sliding semi-landmarks on curves and 3D surfaces, supports sliding by
minimizing the Procrustes distances or the Bending Energy, and can warp a shape and associated
mesh surface. Thin-plate spline grids are available in 2D and 3D. Permutation-based statistics are
available for comparing groups.

4.15.1 Procrustes and PCA
The Procrustes and PCA function calculates a Generalized Procrustes consensus and the Principal
Components from a sample. The data can be exported to a text file, to be analyzed by other
software, or to be imported into Viewbox for viewing the principal components of shape variability
in the PCA Viewer, or for the definition of PCAs.
1. Select Procrustes and PCA... from the Tools menu. The following dialog box will open:
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2. Select the datasets you want to use by clicking the Select... button.
3. Select the dataset Template and the desired PCA Shape.
4. If the data are 2D and will be used by other software, you may wish to check the Flip Y-axis
check-box, otherwise the points will be upside-down, because Viewbox uses a coordinate
system that has the Y-axis running from top to bottom. If you intend the data to be used for a
PCA definition, do not check this box.
5. Select the appropriate options. Analysis can be conducted in Shape Space or in Form
Space, where the natural logarithm of centroid size is added to the data. A Partial or Full
Procrustes superimposition may be used. Also, the specimens may be projected on the
tangent space by Orthogonal or Stereographic projection.
6. Check the data that you want to export. If the resulting file will be used for defining a PCA in a
Template, make sure that all required for Template options checked.
7. Stopping criteria for PCA can be calculated. Viewbox computes the broken-stick criterion, the
Rnd-Lambda and the Avg-Rnd (see Calculation Details). If this option is checked, the procedure
may take a long time to complete.
8. Click the Output File... button to select the file where the data will be written. It is best to
specify a new file, instead of using an already existing file.
9. Click on Calculate to start the process.
The resulting file is a plain text file that can be opened by any text editing software.
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4.15.2 PCA Viewer
The PCA Viewer shows data related to a Procrustes and Principal Component Analysis. Open
the PCA Viewer from the Tools menu (the menu is enabled only if the Dataset Template of the
current dataset contains a Shape, see: defining Shapes):

The PCA Viewer has five panels, Graph, Text, Plot, Data and Statistics.

The Graph panel
Allows visualization of the effect of each of the principal components (PC) on the points of the
shape under study. Options to specify what is shown in this panel are accessed from the Options |
Shape Options menu, or by right-clicking inside the panel:
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Depending on the options selected, the Graph page can show:
the position of the consensus points.
the position of the points of the current dataset, when superimposed on the consensus by
Procrustes superimposition.
lines showing the loadings of the currently selected Principal Component (PC) on each point. The
length of each line covers a 3 standard deviation effect in the positive (blue) and negative (red)
direction.
the position of the points at the currently set value of the PC (see below).
To see the effect of a PC, select it from the PC list box and change its magnitude by dragging the
slide bar. The points show how the shape of the consensus would change. The values that the PC
can take range from -4 to +4 standard deviations:

You can also see the combined effect of two or more PCs. Just adjust one PC first and then select
the Hold menu command from the drop-down menu of the PC Values button. The value of that
PC will remain set and other PCs can be subsequently adjusted. To reset all PC values to zero,
click the Reset All to Zero menu.
Clicking on Create Datasets will create three Datasets, one with the selected PC at its current
value, one with the selected PC at its opposite (negative) value and one with the PC equal to zero.
All three datasets are placed in the Viewbox icon area.

The Text panel
Contains text data related to the currently selected PCA.

The Plot panel
Shows the shape space and all the datasets in that space:
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You need to load a file of specimens to view them. This file needs to be created using the
Procrustes and PCA tool. Use the File | Load Data... menu command to load the file. The data
will be visible in the Data panel and can be edited there.
The shape space is shown as a 3D plot; each axis can be assigned to a PC using the drop-down
lists at the top of the plot. In addition, the centroid size (CS) or the logarithm of the centroid size
(ln(CS)) can be selected.
To view the plot using 3D glasses, click the icon at the top right corner. You will need cyan-red
glasses, as shown by the icon

.

Shape inspector
The shape represented by the markers in Plot page can be visualized by opening the Shape
Inspector, using the icon at the top right corner:
Move the mouse over any marker and the shape of the dataset will be shown in the shape window:
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The contents of the Shape window are the same as those of the Graph - 3D page (see above).
Plot options
To change the colours and other options of the Plot, right-click in the plot area, or select Options Plot Options... from the menu:
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Selected options are explained below:
Show
Individuals /
Average

Individuals are shown with markers, as specified for each of the 10
available groups. If Average is also included, then a marker for the
average of each group is added. This marker is of the same colour and
shape, but larger.

Join paired
markers of
adjacent groups

Draws a line from each marker of one group to the corresponding marker
of the next group. Pairings are made according to the ordering of he
datasets in the Data page. For example, the first dataset of group 0 will be
paired to the first dataset of group 1, then the next dataset of group 0 will
be paired to the next dataset of group 1, and so on. This option is useful, for
example, if you have pre- and post-treatment datasets. Assign the pretreatment datasets to group 0 and the post-treatment to group 1, then join
them with lines to visualize any tendency of shape change in shape space.

Standard
deviation units

If this is checked, then the axes units are in standard deviations, otherwise
they are in actual PC values. Note that the sample's shape variability along
each axis is better presented with this option un-checked.

Colour by X value If values for the X column of the Data page are available, then the markers
can be coloured by these values. Select one of the available colour
schemes.
Size axis

Will show the pure size axis, if the data correspond to form space (i.e.
shape space augmented by the logarithm of centroid size). See
Mitteroecker et al., in Calculation details and References.

The Data panel
Use this panel to edit the specimen data. You can assign each specimen to a group by doubleclicking in the Group column. Right-click for a helpful pop-up menu. After changing the data you
must click the Apply button for the changes to take effect.

The Statistics panel
This allows you to compare two groups of specimens using permutation statistics. You can also
calculate the average of a group and place it in the Viewbox icon area.
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Select the groups you wish to compare.

Create Patient Will create a dataset from the average of the selected group and place it in
from Consensus the Icon Area of Viewbox.
Test

Select the test to perform. All tests are permutation tests, with or without
replacement, running for the number of repetitions specified in the
Repetitions box.

Compare
Groups

The first two tests are used to compare two groups by shape. The third test
is a paired test.

Compare
trajectories

Tests for a significant angle between two linear regression vectors. The X
column in the Data panel needs to be filled.

Multivariate
regression

Computes the multivariate regression of the PCs on the X column.

Once the calculation is completed, the histogram shows the results from all repetitions; the green
lines show the 5%, 50% and 95% cumulative values and the red line shows the result obtained
from the specific sample.
4.15.2.1 PCA Movie

Using the PCA Viewer you can create a movie showing how the shape changes by changing the
value of selected PCs.
The movie shows the output of the Graph - 3D panel.
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Set-up the movie
To create a movie you need to place keyframes. These are added from the Graph - 3D panel or
from the Plot panel:
Add a keyframe from the Graph - 3D panel
1. Select the PC you wish to change and set its value using the slider at the top of the panel:

2. Click Keyframes and select Add from the drop-down menu:

For example, to create a movie showing the effect of changing PC1 from -3 to +3 standard
deviations, and back again:
1. Select PC1 and set the slider to -3.
2. Add a keyframe.
3. Set the slider to +3.
4. Add a keyframe.
5. Set the slider to -3.
6. Add a keyframe.
Add a keyframe from the Plot panel
Right-click on any of the patients in the Plot panel and select Add as Keyframe from the pop-up
menu:
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A green marker will be placed at the position of the keyframe.
Edit keyframes
Keyframes can be deleted, or cleared, from the Keyframes drop-down menu. The keyframes are
listed in the keyframes listbox:

In the example above, 4 keys have been defined. The numbers refer to the first 8 PCs and show
the values of each PC in standard deviation units (z-value).
Preview the movie
Use the slider in the lower panel to preview the movie. The preview is shown in the Graph - 3D
panel.

Movie Settings
Set the movie options from the menu Options - Movie Options...:

Number Set the number of frames. The movie plays at 25 frames per second, so 100 frames
of frames would result in a movie of 4 seconds duration.
Skip last
frame

The last frame of the movie is identical to the first. If you intend to play the movie as
a continuous loop, the two frames will play one after the other and the movie will
appear to pause momentarily. To avoid this, check this option to skip the last frame.

Width /
Height

Set the size of each movie frame.

Adjust
size

Some video codecs do not work properly unless the movie size is a multiple of some
number (usually 2 or 4). Set the Adjust Size to the appropriate value to make sure
the size will be compatible. If you are not sure, set it to a multiple of 4.
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Create the Movie
After setting the options, select File - Create Movie... to create your movie.
Note: Movies can only be created from the Graph - 3D tab output.

4.15.3 Thin Plate Splines
Thin plate spline (TPS) grids can be visualized using the Thin Plate Spline Grids dialog box (open
it from the Dataset menu):

Multiple grids can be created. To create a grid, click the Add button. A new entry will be added in
the Grids box. The Drawing Options of each grid can be changed once the grid is selected in
the Grids box.
Below is an example of a TPS grid:
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4.15.4 Sliding Semilandmarks
Sliding semilandmarks (SS) are described and explained in:
Bookstein FL. Landmark methods for forms without landmarks: morphometrics of group
differences in outline shape. Medical Image Analysis 1997:3;225-243.
Gunz P, Mitteroecker P, Bookstein FL. Semilandmarks in 3D. In: Slice DE (editor). Modern
Morphometrics in Physical Anthropology. Kluwer Academic, Plenum Publishers 2005.
Viewbox implements sliding semilandmarks in 2D and 3D. To use SS it is recommended to define
Sliding Groups, although they are not strictly necessary, as landmarks can be assigned to sliding or
not from within the Semilandmarks dialog box. To use SS, open the Semilandmarks box from the
menu Tools-Semilandmarks:
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The Semilandmarks dialog box in its fully opened form. Use the splitter button to open or close the lower
part:

To Slide points:
Select the appropriate Sliding Group. The assignment of each point to the 5 categories
(Fixed, On Curve, On Surface, Free, Ignored) is shown in the lower part of the dialog box.
Assignments can only be changed if the <Custom> group is selected.
Select the Sliding Surface, which will be used for all 'On Surface' points. This is usually a
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Mesh object.
Select which parameter will be minimized during sliding. The Bending Energy is the most usual
choice.
Click Slide. The points will be slid along their curve or surface. After sliding the points may not
lie on the corresponding curve or surface anymore.
Click Project to move the points on the corresponding curve or surface.
The Slide-Project procedure should be repeated a few times in order to arrive at the optimum
point position. Use the Repeat button and the associated drop-down control to automatically
repeat the sequence a specified number of times.
The Bending Energy and Procrustes Distance buttons will calculate the corresponding
parameter.

Notes
The reference shape that is used for sliding is the Reference Dataset. If no dataset has been set as
the Reference, then the Template's points of the current dataset are used.
To specify other sliding than that defined in sliding groups, use <Custom> in Sliding Group.
Additional options are available from the menu that pops-up when you right-click in the point
listbox:

4.16

Other functions

4.16.1 Properties of a Patient or Object
To change the properties of a patient or an object, select the menu command File | Patient
Properties... or Object | Properties..., or right-click on the object's icon in the Icon Area and
select Properties... from the pop-up menu.

Patient Properties
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Viewbox requires that you enter some data for the ID or the Name of the patient. You cannot
have both of these fields blank.
The patient’s date of birth must also be filled-in. The date format must be the same as that defined
in the Microsoft Windows Control Panel. If you use the wrong format, an error box will open,
showing you today's date as an example of the correct format.
Click the File for Saving... button to change the file into which this patient will be saved. The file
is shown next to the button.

Object Properties
The Properties dialog box depends on the selected object:
Dataset properties:

Magnification is entered as a percentage without the % sign. For example, if the magnification is
10%, enter 10. The magnification is used in case you receive radiographs from different machines
and need to superimpose them. Viewbox can display them by scaling each to life size according to
the magnification (see Dataset size and Scaling).
If you are not sure about the magnification value, you can use the Magnification tool to calculate it
directly from the radiograph, provided a reference ruler has been included.
It is not possible to change the dataset's Template. This can only be set when creating the dataset.
Other Object properties:
The Name and the Date Taken are common properties to all objects. Date Taken is a required
property. Other properties are specific to the selected object.
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4.16.2 Measure manually
Sometimes you may need to measure a distance or angle that is not included in a cephalometric
analysis. Viewbox offers two tools for measuring directly using the mouse.

Ruler
Select the Ruler tool
and drag the mouse from one point of the Display to another to measure
the distance between the points. The horizontal (x-direction), vertical (y-direction) and point-topoint distances are shown in the Status bar. Total distance is also shown next to the mouse cursor.
The ruler can show tick marks along its length at millimetre intervals. This option is set at the View
page of the Options dialog box.
Tip:
You can change the position of the displayed measurement by right-clicking the mouse while
measuring: Start the measurement by depressing the left mouse button and drag the mouse around
the Display. While still holding the left mouse button down, click the right mouse button. The
displayed distance between the start and end point cycles between four positions.

Ruler in 3D
The ruler in 3D works differently than in 2D. In 3D you need to Right-click to set one point of the
ruler (the red point) and Ctrl-Right-click to set the other point (the green point). Once the points are
set, you can drag them around with the mouse.

Protractor
Select the Protractor tool
Draw the first line:

to measure angles between two arbitrary lines:

Depress the left mouse button in the Display and drag the mouse in the desired direction.
Release the mouse button. The first line is drawn.
Draw the second line:
Depress the left mouse button and drag the mouse. The angle between the first and second lines
is shown (the supplemental angle (180-angle) is also displayed).
The Protractor cannot be used in 3D mode.
Tip
You can change the position of the displayed measurement by right-clicking the mouse while
measuring, as described above for the Ruler tool.
The colour used for drawing the Ruler and Protractor lines can be changed from the Options dialog
box.

4.16.3 Scaling

Datasets
To change the size of a Dataset, select Resize... from the Object menu:
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1. To reduce a dataset to the actual life size, select Reduce to life size. Viewbox will use the
magnification factor that was entered when creating the dataset (see: Properties) and calculate
the real size of the patient.
2. If you have reduced the dataset to life size, you can enlarge it back by selecting Enlarge to
dataset size.
3. To scale the dataset to any size, select Other and enter the desired scaling factor.
For example:
To reduce to half size, enter: 0.5
To enlarge by 10%, enter: 1.1
To enlarge by 50%, enter: 1.5
Notes
Do not confuse this function with the LIFE / XRAY size setting. The LIFE / XRAY setting does
not change the size of the dataset, it just changes the way Viewbox displays it (see Dataset size).
Viewbox does not keep track of scaling changes. You are allowed to repeatedly enlarge “to
dataset size” or reduce “to life size” and the dataset will become bigger and bigger or smaller and
smaller by the proportion specified in the magnification factor. However, scaling changes are
logged to the Movement Window and can be undone.

Images
To change the size of an image, select Resize... from the Object menu. See Resizing an image for
specific details.

Other Objects
To change the size of an object, select Resize... from the Object menu:

Set the appropriate scaling factors for uniform or non-uniform scaling. For example, to double the
size of the object, set Scaling factor to 2. Setting different factors in the X, Y and Z boxes will
result in deformation of the object.
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4.16.4 The Magnification tool
Viewbox can help you calculate the Magnification value by measuring a reference ruler directly on
the radiograph. This procedure requires that a) a reference ruler has been included in the
radiograph, and b) the radiograph has been captured with a scanner or camera and is digitized onscreen.
A cephalometric radiograph with a reference ruler for
measuring the magnification.

1. Select the Magnification tool:
. This tool is visible only when a Dataset is selected in the
Icon Area and is available from the tools in the Objects Panel on the right side of the Viewbox
window.
2. Using the mouse, measure the length of the reference ruler. It is best to zoom-in on the ruler and
measure between the two most widely separated marks (the largest distance) on the ruler, as
shown below:

3. Notice that the magnification ruler adjusts itself automatically to the actual ruler of the
radiograph by guessing the correct magnification. This makes it easy for you to check that it has
guessed correctly, because the tick marks align with the ruler of the radiograph. If the guess is
wrong, you can correct it at the next step, or, you can rotate the mouse wheel up or down to
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adjust the ruler.
4. After the measurement is taken, Viewbox shows the calculated magnification for confirmation.
In the example above, Viewbox correctly guessed that we measured a length of 50 mm. If this
guess is wrong, just enter the correct number in the Life Size box:

5. Click Set this Magnification to transfer the calculated value to the Dataset's properties.
Note: The magnification tool cannot be used in 3D mode.
Note: While dragging the mouse with the magnification tool active, right-click
(without releasing the left mouse button) to change the position of the
measurements.

4.16.5 Copy and Paste
Viewbox supports copying tracings and analysis results and pasting to other Windows programs
using the Windows clipboard. Alternatively, you can use the File | Send To menu command to
send data directly to Microsoft Word, Excel or PowerPoint.

Example: Copying a tracing to Microsoft PowerPoint
1. Make sure that the desired elements that you want to copy are displayed in Viewbox. If the
dataset has an associated image and you want this copied also, make sure it is visible. If you want
the analysis results, turn Analysis on.
2. Select Copy as Picture from the File menu. Viewbox copies the part of the 2D Display
extending 30 cm in the horizontal and vertical direction.
3. Switch to Microsoft PowerPoint and create a new Slide in your presentation. Usually you would
want a Blank slide, or one with a Title.
4. In Microsoft PowerPoint, select Paste from the Edit menu. The Viewbox tracing will be pasted
on the slide, but it may be too small or too large in size. You can use the mouse to drag on one of
its corners until the size is appropriate, or, better, use the Size and Position commands of
PowerPoint to set it to 30 x 30 cm.
5. If you want to edit the pasted tracing (e.g. change colours, line styles, etc.) you have to convert
it to a Microsoft Office drawing object first. To do this, use the Ungroup PowerPoint command.
After the selection has been converted to objects, ungroup them again:
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The pasted tracing on the
PowerPoint slide, after
converting to drawing objects.

Any images that are copied are pasted upright; if they were rotated in Viewbox, this rotation is
ignored. To place them in the correct position, read their rotation around the z axis from the Object
| Scale / Rotation / Position menu in Viewbox and transfer that to the image's rotation in
Powerpoint, reversing the sign from positive to negative and vice versa.
The entire process described above can be accomplished much easier by using the File | Send To |
Microsoft PowerPoint menu command. Options for this command can be adjusted at the Send To
page of the Options dialog box.

Example: Copying measurements to Microsoft Word.
You can copy and paste the measurements in two ways: a) You can use the Copy Results
command from the Dataset menu. This will only copy the measurement values. b) You can open
the Text Analysis window and copy the contents of that window. This will also copy the names of
the measured variable and can include normal data as well. This method is described below:
1. Open the Text Analysis window for the desired dataset:
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2. Select the data you wish to copy, either with the mouse, or with the Edit | Select All menu
command:

3. Paste the data into Microsoft Word. If you do not want to keep the formatting style (font,
colours), then use the Paste Special command from Word's Edit menu and select Unformatted
Text.
4. If you want to make a table, select the text and use the Table | Convert | Text to Table
command. Make sure you specify Separate Text at Tabs. Word will convert to a Table, which
you can format as desired.
Again, you may find it easier to use the File | Send To | Microsoft Word menu command.

4.16.6 Edit and Transfer Coordinates
Coordinates of a Dataset can be edited directly by selecting Dataset | Coordinates | Edit Point
Coordinates...

Other functions under the Coordinates menu allow you to transfer coordinates from a Reference
dataset or from the Template to the current dataset.

Get Selected Coordinates from Reference
This function is used to transfer the coordinates of selected points from one dataset to another. To
use this function you must have two datasets loaded into Viewbox. One of them must be assigned
as the Reference dataset. The other is the current dataset whose points you want to change. Select
the points you want to change in the current dataset. Then use the Dataset | Coordinates | Get
Selected Coordinates from Reference command. The selected points will move and align exactly
on the corresponding points of the Reference dataset.
An example of using this function would be to transfer a reference frame (e.g. the anterior cranial
base or the occlusal plane) from the initial to the final tracing, in order to use it for measuring
treatment changes. In such a case, you would superimpose the radiographic images using a
structural superimposition and then transfer the Sella Nasion points, or the occlusal points, from one
dataset to the other.

Get Remaining Coordinates via TPS Warping
This function gets the coordinates of all the points that have not been digitized from either the
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Reference dataset, if one has been set as reference, or from the Template, using a thin-plate spline
(TPS) warping. The TPS warping is based on the points that have been already digitized.

4.16.7 Export results
Use the Export function to send the results of a cephalometric analysis to Microsoft Excel or a text
file.
Select Export... from the Tools menu. The Export dialog box will open:

1. Click on File... and select the file that contains the datasets you wish to use. Select the datasets
and click Load.
2. Select the Template. Only datasets that belong to this template will be analysed.
3. Select the data to Export. You can select between the Measurements of a specific analysis
and the Point Coordinates of a graphic or a shape:
Analysis:
This option only affects linear measurements. If LIFE is selected, all
Export
measurements at measurements will be scaled according to the magnification setting of each
dataset.
LIFE or XRAY
size
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Full precision

Exports numbers with the maximum possible number of decimal digits.
Otherwise, each variable will be exported with the number of decimal digits
that appear in Viewbox. Full Precision does not necessarily increase the
accuracy of your measurements because most of the extra decimal digits
are spurious. One decimal digit is usually more than enough in
cephalometric analyses.

Skip labels

Exports only the numeric variables.

Z-values

Instead of exporting the actual measurement, the z-values are exported.
The z-value is the number of standard deviations that the measurement lies
away from the average.

Point Coordinates:
Reflect Y-axis

In the 2D mode, Viewbox uses a coordinate system whose y-axis runs from
top to bottom. If you want to use the data on a coordinate system where the
y-axis increase from bottom to top then check this option.

Set centroid at
origin

Align the dataset so that the centroid of the points is at the origin of the axes
(zero).

Skip datasets
with missing
points

Will not export any datasets that have not been completely digitized.

Each point on a
new line

The coordinates of each point will be exported on a new line. Usually this
option is left un-checked.

Include z
coordinate (3D)

Make sure this is checked, if the dataset is a 3D dataset, otherwise only the
x and y coordinates will be exported.

Resize to this
centroid size

In the edit box, set a centroid size, in mm, and the datasets will be resized to
that size.

Include
Besides the results of the analysis, Viewbox can also include other data, such as Name, Date of
Birth, Age, etc. The age of each patient is exported as a fractional year value and not as
years:months.
Headers: Variable or Point Names
Check this, if you want the names of the variables to be included as headers in the export file. If
you check the Abbreviated box, the variable names will be shortened to 8 characters and all nonletter characters (spaces, ‘-‘, etc.) will be removed. This option is useful, because some programs
(e.g. some versions of SPSS) cannot import names larger than 8 characters.
Select the Delimiter that will be used to separate the data. If you plan to import the data into Excel,
use Tab as the delimiter.
4. Select to send the data to a New Excel Worksheet or to a File. If File is selected then
specify the delimiter that will be used to separate the data, the character to use for the decimal
point, and the encoding. These settings should be configured according to the software into
which you wish to import the data, so consult that software's user's manual. If the file already
exists, any the data will be overwritten.
5. Click on Export. The progress of the procedure is shown in the status bar at the lower part of
the dialog box. When the procedure is completed, Close the dialog box.
When Viewbox has finished, you can open the resulting text file with Notepad or import it into a
spreadsheet program or a statistics program.
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Notes
The text file that is created with the Export procedure will be empty if no datasets of the type
specified in step 2 are found in the dataset file specified in step 1 above.
If the selected Analysis contains measurements of the [R] type, the results will depend on
whether there is a dataset currently loaded in Viewbox and assigned as the Reference dataset. If
no such dataset is loaded, then the results will be exported as N/A (not available), otherwise the
loaded reference dataset will be used for all datasets in the File selected in step 1 above.

4.16.8 Calculate the average
To calculate the average of a number of datasets, select Mean... from the Tools menu. The Mean
dialog box will open:

1. Click on Select... to open a dataset file and select the desired dataset (see Open a Patient).
2. Then select the Template and the Superimposition. When you click on Calculate,
Viewbox loads all datasets that have been selected and are of the designated template and
superimposes them according to the chosen superimposition. Then it calculates the mean of each
point and constructs a new dataset out of the means.
Notes
The procedure fails if the first dataset that is loaded does not have valid points for the
superimposition.
All datasets with missing superimposition points will be ignored.
If the superimposition points are valid but other points are not, then the resulting mean dataset
will have points, each of which has been calculated on a different number of datasets.
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4.16.9 Sort by shape
The Sort by Shape function can help you find datasets in your files that are most similar or least
similar to the current dataset. This function is best used if PCAs have been defined, but can also be
used with regular superimpositions. In such cases it is most meaningful if a superimposition of the
kind “Best fit” or “Best fit and scaling” is available (see Superimpositions).
When this function is selected, Viewbox searches through the datasets in your files, superimposes
each one in turn on the current dataset and measures the sum of squared distances of the points
between each dataset and the current dataset. The datasets with the smallest sum of squares are
considered the most similar to the current.
1. Select Sort by Shape... from the Tools menu (this function is enabled only if a dataset is
loaded). The Sort by Shape dialog box will open:

2. Select the datasets you want to search by clicking the Select... button.
3. You can use a PCA or a regular Superimposition or an Analysis as the criterion for shape
similarity:
Procrust A Generalized Procrustes fit on all points of the PCA will be applied and the
Procrustes distance will be used as the similarity criterion.
es
Superimp Each dataset read from the file will be superimposed on the current dataset using the
selected superimposition. Select the Graphic: the points of this graphic will be used in
osition
the calculation of the sum of squared distances.
Analysis

The measurements of the analysis will be used for calculating the sum of squares.

4. Select the desired Options.
5. If Exclude same patient is checked, then Viewbox will disregard any datasets that belong to
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the same patient as the current dataset.
6. Click the File... button to select the file where the best or worst matches will be written, if such
an option has been selected. This button is disabled if you have selected to load the matches into
Viewbox.
7. Click on Scan to start the process.
Notes
If the superimposition selected is of the 'Best fit and scaling' kind, then this is a generalized
Procrustes match.

4.16.10 Create Random Datasets
This function creates datasets that have points in random positions. However, the positions are not
completely random: the random datasets are based on a sample of real datasets and their points are
positioned in such a way that they resemble the real datasets from which they were derived. Such
random datasets are useful because they do not posses any biological information in the spatial
interrelationship between their points. Therefore, any correlations between cephalometric
measurements can be attributed to topographical (geometric) associations. Comparison of such
correlations to those of a real sample can reveal the true extent of biological associations in the real
sample.
Select Create Random Dataset... from the Tools menu. The Create Random Datasets dialog
box will open:
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1. Click on Select... and select the file that contains the real datasets on which the random
datasets will be based. When the file opens, select the datasets from the file.
2. Select the Template. Only datasets that belong to this template will be analyzed.
3. Select the Superimposition. The datasets will be superimposed using this superimposition
before any other calculations are done.
4. Select the desired Options :
Creation method:
Permut Each new random dataset will take point coordinates from the real datasets, in a
random way. For example, the coordinates for point #1 will be selected randomly from
ation
all points #1 of the real datasets, the coordinates for point #2 will be selected randomly
from all points #2 of the real datasets, and so on. Therefore, no new point coordinates
are created. Each new dataset is just a random permutation of the real datasets.
Enter the number of datasets to create and select the file where the datasets will be
stored.
Rando Each new dataset will be created by assigning random coordinates to each of its points.
However, the random coordinates follow a normal distribution. For each point, the
m
distribution has a mean value equal to the position of the average of the corresponding
points of the real sample and a standard deviation (along the x-, y- and z- axes) equal to
the standard deviation of the distribution of the corresponding points.
This method does not ensure that the distribution of the created points is similar to the
distribution of the points in the real datasets. The distributions will be similar only if the
distributions in the real sample are normal and are aligned along the x-, y- and z- axes.
This will probably be approximately true if the points are fixed landmarks (i.e. not sliding
semilandmarks) and the superimposition is of a Procrustes type. Otherwise, especially
when superimposing using conventional cephalometric superimpositions (e.g. SellaNasion), the distributions of the points in the real sample are usually elliptical and not
aligned to the axes.
Correla This option does not output datasets. It creates samples of datasets and calculates the
correlation matrix between measurements for each of the samples. The datasets are
tion
created by the Permutation method, as described above. If the number of
measurements in the selected Analysis is large, then this procedure may take a long
time to complete.

4.16.11 Shape from Numbers
This function attempts to create a dataset from specific measurements. This is generally not
geometrically possible, because the measurements may not contain sufficient information to
constrain the position of all landmarks; additionally, the specified measurements may be
incompatible to a geometric shape (e.g. you may have asked for the angles of a triangle to have a
sum larger than 180 degrees). Viewbox will move the selected landmarks to obtain the best
possible shape to satisfy the measurements:
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4.16.12 Template Browser
The Template Browser shows the definitions of all the elements of the Dataset Template to which
the current dataset belongs. There is no facility for editing the dataset template in the Template
Brower, but a cross-reference table is available for each element.
Open the Template Browser from the Tools menu:
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4.16.13 Convert Template
The Convert Template function allows you to convert datasets from one dataset template (the
original Template) to another (the target Template). The converted datasets are saved into a new
file. Each converted dataset has the same data (name, sex, etc) as the original. The coordinates of
each point of the converted datasets will be set to the coordinates of a point of the original dataset.
Usually this will be a point with the same name, but can be any point, or none.
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1.
2.
3.
4.
5.

Select Convert Template... from the Tools menu.
Select the datasets you want to convert by clicking the Select... button.
Select the original dataset template.
Select the target dataset template.
Set the point correspondences. The left column of the table shows the points of the target
dataset template and the right column shows the corresponding point that will be used to get the
coordinates. To set a different point, select it from the list box next to the table.
6. Click the File... button to select the file where the data will be written. It is best to specify a
new file, instead of using an already existing file.
7. Click on Convert to start the process.
The Convert Template function can also be used for other purposes. For example, if the original
and target templates are both set to the same template, then you can use this function to delete
points or to exchange points. If you want to delete a point from datasets, just set the
correspondence for this point to <none>. If you want to exchange the coordinates of two points,
just set the correspondence of one to the other (e.g. set Pogonion to Sella and Sella to Pogonion).

4.16.14 Send to...

Send to Microsoft Word, Excel and PowerPoint
Viewbox can send data to Microsoft Excel, Word and PowerPoint. The results of the currently
selected analysis are sent.
Microsoft Excel and Word
Viewbox sends the text results only (not the graphics or images).
Microsoft PowerPoint
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Viewbox sends all datasets and images, as shown in the 2D Display. The data are converted to
Microsoft PowerPoint objects so that these can be edited in PowerPoint, if desired. Also, the
datasets are scaled to fit in the slide and aligned at the centre of the slide, if the corresponding
options are checked.
This function works only if the 2D Display is active.
Note: Sending to data to these programmes may entail copying and pasting
through the clipboard. Data already on the Clipboard may be overwritten.

4.16.15 Create Movies
To create movies from the 3D Display, open the Timeline window from the Windows menu:

The Timeline window has two panels. The left panel contains general properties that can be
changed as the movie progresses and properties of any objects that are loaded. The right panel
shows the frames of the movie.
To create a movie:
1. Set the number of frames and frame size
Use the Edit | Movie Properties... menu command to open the Movie Properties box:

Movies play at 25 frames per second, so a movie of 100 frames will play in 4 seconds.
The size of the frames is set to the size of the 3D Display. However, it is recommended to adjust
this to a multiple of 4 or higher because some file formats are not compatible to any frame size.
2. Set keyframes
Double-click on a frame in the right-side panel to set a keyframe. The keyframe will be set to the
current properties.
For example, to make a movie of an object rotating around itself, set keyframes in the timeline of
the Camera: set one keyframe at frame 1, then rotate the 3D Display by approximately a quarter
of a turn, set a new keyframe at frame 25, rotate again and set a new keyframe at frame 50, and
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so, until you return to the original position setting the last keyframe of the Camera at frame 100.
3. Test the movie
Use the Play command to test the movie in the 3D Display.
4. Save the movie
Save the movie using the File | Create Movie menu.
Movies can be saved in different formats. A dialog box will open allowing you to choose the
desired format. Available formats depend on the codecs installed on your computer. The quality of
the movie and the file size may vary greatly between formats.

4.16.16 Batch Processing
Batch processing allows you to perform certain functions on all the patients of an XML file and
save the results to a new XML file. Open the Batch processing window from the Tools menu:

1. Select the patients
Click Select to select the file that contains the patients you wish to change. In the Load Patients
window, select the patients and click Open.
2. Select the actions
Select an action from the drop-down list and click Add Action to add it to the list box of actions to
perform. You can add more than one actions. All actions will be performed in turn on every patient
selected in step 1 above.
3. Select the output file
Select an output file to save the results, or enter a name to create a new file.
4. Perform the actions
Click Process and Save to perform the actions. Viewbox will load each patient in turn, perform
all actions that have been added to the list box of actions, then save the patient. The original file is
not changed. The procedure can be aborted at any time.
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4.16.17 Create 3D PDF File
To create a 3D PDF file of the objects in the 3D Display, select Export | Export as 3D-PDF from
the File menu. The PDF 3D Options dialog box has three pages:

General

Open PDF after
saving

Opens the pdf file after it is created, so you can check the result.

Compress U3D
data

It is recommended to leave this option checked, to reduce file size.

Save U3D file

This option will also save the corresponding U3D file and is only for
advanced users.

Sphere quality

The higher the quality, the larger the file will be and the slower the
response time when viewing it. Medium quality is recommended.

JPEG
compression

Affects the quality of textures and images.

Labels

Set the direction of labels relative to the coordinate axes.

Page
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This panel is for setting the page size and orientation of the pdf file.

Views

A 3D pdf file can contain several views. Some are predefined and are always present and some
can be added as custom views. In each view, you can set the lighting scheme and the objects that
are visible by default.

4.16.18 Mesh Similarity
The Mesh Similarity function compares meshes to each other and detects the meshes that are most
similar. Mesh similarity is based on the mesh registration functions.
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5

Tutorials

5.1

Adjust cephalogram to true size
How big is this?

Digital images are usually size-agnostic, i.e. it is not possible to know the size of the object depicted
in the image without additional information. This is a problem when loading cephalometric
radiographs and real-life measurements are required.
If the radiograph depicts a magnification ruler, then it is easy to adjust it to the correct size.
Step 1. Load the image
Use the Image - Open menu command or click the Open Image button:

If no patient is loaded or selected, Viewbox will ask you to create a patient first. Fill the appropriate
data:
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Step 2. Measure the ruler
Once the image is loaded, use the Zoom tool

Then select the Ruler tool
to the other:
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Notice that the millimetre markings of the two rulers do not coincide. This is because the image is
shown larger than its actual size. The Ruler tool has measured 53.62 mm. However, the actual
ruler on the radiograph is only 50 mm, as we can see from the markings.
Step 3. Adjust the image size
Right-click on the Ruler tool and select Resize to Ruler... from the pop-up menu:

In the dialog box, enter the actual size of the ruler of the radiograph (here 50) and click OK:
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The image will change size to adjust the measured distance to the actual distance. Repeat Step 2 to
confirm that the two rulers now match:

Note 1
Resizing of the image takes place from the centre of the image (which is kept at the same
position). Therefore, the borders of the image will expand or constrict and the image will not be
positioned at the upper-left corner of the Display. To reposition the image at the upper-left corner,
select the Object Widget tool:
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Then double-click anywhere in the Display, except on any of the icons:

Note 2
The above procedure will resize the image to the true life size of the patient's head, because the
ruler in the image is positioned at the mid-sagittal plane.
Note 3
Images saved as DICOM files contain size information and the above procedure may not be
required. However, not all DICOM files contain correct information. Also, the sizing information is
of the image detector, so the radiograph will be displayed at the size that the patient's head would
be projected on the 'film'. This is usually larger than true life size (see Note 2 above).

© 2020 dHAL Software, Kifissia, Greece

Tutorials

5.2

245

Mesh selection
Suppose we want to segment the following mesh and cut-out the molar and the two premolars:

Step 1: Select triangles
Use the Paintbrush tool and paint on each of the teeth, using a different selection group for each
tooth. Also, paint on the area surrounding the teeth, again with a different selection group colour.
Because this mesh is a high-detail mesh, we have used a Paintbrush size of 1000:
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Step 2: Use Region Grow
From the Selection menu, select Region Grow . Viewbox will expand your selections until they fill
the whole mesh (this may take some time). Selections expand according to the curvature of the
mesh. They expand quickly if the mesh is flat, but stop at strong folds. Because teeth are separated
from the palatal and buccal mucosa by a strong fold at the cervix of each tooth, the selections will
meet there:
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Step 3. Create meshes from the selections
From the Selection menu, select Create All. Viewbox will create a new mesh from each selection.
The original mesh is retained. Now you can move the teeth individually because they are separate
meshes. The picture below shows the 3 tooth meshes:

Alternative method using Smart Brush
Right-click on the Paintbrush tool and select Smart Brush. Also set the size to the approximate size
of the region you are interested in. In the example below, size was set to 5%.
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Select a Selection Group and right-click on a tooth. Viewbox will attempt to select the whole tooth.
The selections below were achieved with one click per tooth. A different selection group (colour)
was set for each tooth.

5.3

Structural superimposition
Structural superimposition is used for superimposing two tracings by aligning anatomical structures.
To do a structural superimposition you need two datasets (tracings) and their images (radiographs).
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Load the data
Open the Sample.xml file and load patient Helen Smith. This patient contains two datasets and
their corresponding radiographs (images).
The Icon Area should show the loaded patient and the four objects:

We are going to move the 'Before' tracing and image and superimpose it on the 'After'. From the
labels next to each icon it is easy to tell which is which.
Lock the Dataset with the Image
If each image is not locked to its corresponding dataset, click the appropriate Lock icons, so that
the Icon Area is as shown above. This will ensure that image and dataset will move together.
Select the Image
Select the image to move.
Notice that we have also hidden the datasets, so that the tracings do not cause visual clutter that
may make it difficult to see the areas we are going to superimpose:

The simple way (but not very good):
Set the transparency of the image to 50%:

Use the Move Object tool
to move the image and try to align the radiographs. See
Repositioning an Image.
However, because both images are usually black and white radiographs, it is very difficult to
discern which structures belong to one radiograph and which to the other. A more effective way is
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to first enhance the radiographs, colorize them and then reposition them. This process requires the
following steps:
The best way:
Select each image in turn and apply an Adaptive equalise filter or a CLAHE filter (see Adjust
image functions):

Select one image and Colorize it using the _green.lut colour scheme:

Select the other image and Colorize it using the _red.lut colour scheme. The Icon Area should
now show the images like this:
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Click the Blend button to activate the Difference blending mode (notice that Transparency is
now disabled):

Now the images are colored and are semi-transparent. This is a special mode that mixes the colors
making the images easier to see.
Use the Move Object tool
to move the image and try to align the radiographs (see
Repositioning an Image). The green and red colors will turn to yellow when they superimpose well.
Before and After Structural Superimposition on Sella:
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Superimpose casts on the palate
This tutorial show how you can superimpose two digital casts on the palate, in order to see
treatment changes.
Step 1: Create a patient and load meshes
We first create a new patient and load the two casts:

Step 2: Set the Reference
The Initial mesh has been set as the Reference object. This mesh will remain fixed and the Final
mesh will be moved to align it to the Initial:
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Step 3: Select the area of superimposition
We will use the anterior part of the palate as the valid superimposition area. This can be selected
using the Area Select tool (see Select Mesh Parts):

Step 4: Rough alignment
Open the Align Meshes dialog box and select the Manual Pairwise page. Select the Digitizer
tool
and click on corresponding parts of the meshes. Here the canine cusps and the palatal
molar cusps have been clicked. It is important to click the points on both meshes in the same
sequence, so that Viewbox can match them correctly. You can click all points on one mesh first,
then repeat on the other, or you can alternate from one mesh to the other at each point. Viewbox
detects on which mesh you click automatically:
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Click the Align button to perform the alignment:

Step 5: Refined alignment
Switch to the Auto Pairwise section and set the settings as shown below:
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Click the Align button to improve the registration. Repeat until no appreciable changes are
observed. Then set Point Sampling to 100% and Nearest Neighbour Search to Exact and
repeat once more.
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Step 6: Check alignment
To check the goodness of fit between the aligned surfaces, use the Distance Map section of the
Align dialog box.
Click Calculate, then click both double arrow buttons beneath the plot:

The plot shows a histogram of the distances from the vertices of one mesh to the closest point on
the other mesh. The double arrow buttons set the extents of the histogram to cover the whole
range. In the example above we see that the largest distance from one mesh to the other is 0.31
mm. Distances are colour-coded based on the <rainbow> scheme.
Click Apply as Texture to transfer the colour coding to the mesh:
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The image above was rendered using the settings as shown below. Notice that the texture shading
option is on (outlined in red), and the Selection Transparency slider (outlined in blue) has been
moved all the way to the right, to make the selection transparent, in order to make the texture
colours show through.

To create a colour map over the whole mesh, un-check the Select area of source mesh only
option and calculate again. Below, we have set the extents of the colour map from -2 mm to +2
mm, by entering these values in the boxes and pressing <Return>. Then, we click Apply as
Texture to transfer the colour coding to the mesh:
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Superimpose digital cast on CBCT
This tutorial assumes you are familiar with the mesh selection tools and mesh registration basics.
Cone-beam computed tomography (CBCT) images do not depict teeth with sufficient detail, due to
the relatively large voxel size (e.g. 0.3 or 0.4 mm). In cases where we wish to construct 3D-printed
surgical splints or implant guides, it is necessary to replace the teeth in the CBCT image with a
more detailed model, obtained by scanning the patient intra-orally or by scanning the dental casts.
Here we show how to do this, using a CBCT image and scanned casts of the maxillary and
mandibular teeth. If both arches need to be inserted into the CBCT image, then it is best to perform
the procedure with both casts in occlusion.
Step 1. Open the CBCT image
See How to open a volume for details.

Step 2. Threshold at a value appropriate for tooth crowns
Make the Z slice visible and move it to a position that corresponds to the teeth. Check Show Isolines and Show Gradient:

Open the Histogram window (from the main menu, or from the Histogram button):
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Adjust the iso-line (dotted vertical line in the picture above) until the lines on the Z-slice fall in the
centre of the outlines of the crowns:
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Rendering the volume using the secondary iso-surface now results in the following image:
Render settings:

Result:
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Notice that the bones are not rendered fully because this is a threshold for teeth, and enamel is
more radio-opaque than bone.
Step 3. Create a mesh from the threshold
In the Create panel, click Mesh..., then click From Volume, then select Secondary and click
Create (see Create Meshes for more details):

Once the mesh is created we hide the volume, then load the digital casts. The result is shown
below:
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Step 4. Combine the digital casts into one
We wish to align the digital casts to the CBCT mesh as a single entity, instead of one by one
separately. This will increase accuracy because there will be a larger area to superimpose. For this,
we need to combine the casts into a single mesh.
Select one of the casts in the Icon Area, then click the Union button, then click the other cast in
the Icon Area. Now the second cast has been copied and added to the first. Delete the second
cast, as it is not needed any more.
Step 5. Select the crowns on the cast
Use the Selection tools to select the crowns of the teeth on the casts. Here we have used Smart
Brush:
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Step 6. Align
Set the CBCT mesh as the Reference object, then select the casts in the Icon Area, as shown
below:

Align the casts to the CBCT mesh, see Mesh Registration for details. Here we need to check
Selected area of source mesh, to ensure that the alignment will be done on the selected tooth
crowns.
The result is shown below:
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The digital casts can be separated to maxillary and mandibular, by clicking the Separate button.
The casts are now in the reference system of the CBCT image.

5.6

Create mirror dataset
Assume we have digitized a face from a photograph and we wish to create a mirror image of the
dataset, then superimpose the original object and the mirror image and compute the average of the
two (which will be completely symmetric).
For example, assume the following has been digitized:
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This dataset consists of 122 landmarks and 16 curves. Some points have a symmetric counterpart
(e.g. the points of the eye) and some are points that lie on the symmetry plane (the mid-sagittal
plane), e.g. the tip of the nose. Similarly, some curves come in left and right pairs and some do not
(e.g. the outline of the face).
To create a mirror object:
Create a duplicate of the dataset
Use the menu function Object - Duplicate to create a copy of the dataset.
Flip the duplicate
Use the menu function Object - Mirror - Mirror X to flip the dataset in the X direction.
You should now have two datasets, as shown below:
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The mirrored face has the original left-side landmarks on the right side, and the original right-side
points on the left side. It is not possible to superimpose the two datasets properly. We need to
'relabel' the landmarks, so that they are on the correct side.
Relabel the landmarks and curves
Use the menu command Dataset - Coordinates - Relabel Symmetric Points and Curves. There
will be no noticeable change, but the landmarks have now switched sides, based on the Symmetry
Pair information that was set in the Template. It is very important that the Template has been
properly defined.
Superimpose
Superimpose the two datasets, preferably using a Procrustes-type superimposition:
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The average can be computed using the Tools - Average command, selecting the option
Datasets of loaded patients:
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Note that the resulting average is perfectly symmetric.
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Define Dataset Templates
See Dataset Templates for an explanation of what a Dataset Template is.

To create a new dataset template:
Select New Template... from the Tools menu. Viewbox will create an empty dataset template and
immediately open the Save dialog box, so that you can save it. The Template has been created but
is currently empty (i.e. it has no points, analyses, etc.). Save it using any file name you wish. Leave
the extension blank so that Viewbox can assign the default VBRX extension to the file.
Note: Dataset Templates should be saved in the Templates folder, otherwise
Viewbox will not be able to access them. If you want to use a different folder, you
must notify Viewbox by changing the Default Folder for Templates.
Enter a valid filename (use the VBRX or VBR extension) and click on Save. The new dataset
template is empty except for the default name ("Template") and the default icon
. It is
displayed in the Icon area. You can now go ahead and start defining points, variables, analyses and
other components.

To open an existing dataset template:
Use the Open Template... command from the Tools menu. Viewbox will present the Open dialog
box. Select the file which contains the dataset template you wish to change and click Open. The
dataset template will be loaded and placed in the Icon area.

To change a dataset template:
First create a new template or load an existing one, as described above.

To change the name or the icon of the dataset template:
Select Properties... from the Objects menu, or from the menu that pops-up when you right-click
on the icon in the Icon Area. The Properties dialog box will open:

Type a new name, or click the Icon... button to load a new icon that will be used for presenting
datasets of this template in the Icon area. You can use any bitmap (BMP) or icon (ICO) file as an
image, but icons are recommended. A few icons are supplied with Viewbox.

IMPORTANT:
The name, as entered in the Object - Properties dialog box, is most important because it will be
used to assign Datasets to this Template. You must use a unique name, not used by any other
Template. If two or more template files (VBRX/VBR files) use the same name, then Viewbox
may not be able to properly load the correct template for the Datasets. The Template Name is not
the same as the VBRX/VBR File Name. The Windows operating system will not allow you to
create two VBRX/VBR files that have the same name, but the Template names, which are inside
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the template files, could be the same. Make sure they are unique.
This may become a problem if you receive a template file from another user. The Template name
of the file may be the same as that of one of your own files. In such a case, remove one of the files
from the Templates folder so that Viewbox cannot access it.

To add, delete or edit the various components:
Use the Edit Template command from the Tools menu or right-click the icon in the Icon Area to
open the pop-up menu. Click on the various components below to learn how to change each one.
Before proceeding to edit the dataset template it is recommended that you load an image of a
radiograph to use as a template for defining points and curves. This will make the process a lot
easier.
Digitized Points
Curves
Derived Points
Areas
Graphics
Variables
Analyses
Superimpositions
Orientations
Protocols
VTO Relationships
Views
Shapes
Sliding Groups
Template components are edited by their specific dialog boxes. All dialog boxes share the same
toolbar for creating a new element, renaming the element, deleting or copying:

To create a new element
Click the New... button. The Input dialog box will open:

Enter the name of the new element. If you want the new element to be based on an existing one,
check the Create a Copy check box. Click OK to create the element.

To rename an element
Click the Rename... button. In the Input dialog box change the element's name. If you attempt to
enter a name that is already used, Viewbox will notify you.
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To delete an element
Click the Delete button.
Note: You cannot delete an element if it is used elsewhere, for example in the definition of another
element. You will have to remove it from every other component of the Dataset Template before it
can be deleted.
It is not recommended to delete digitized points. Remember that if you change a Dataset Template
by deleting points, all the datasets that you may have already digitized, will contain the deleted
points and you may see strange effects if you try to load them using the newly defined Dataset
Template. You may have to redigitize them.

To copy an element to another Template
To copy an element to another template you need to have both templates open in Viewbox. Click
the Copy button on the toolbar to copy the element, then select the other template in the Icon Area
and use the Paste menu command from the Tools - Edit Template menu. This command may
create additional elements if they are needed to support the copy operation. For example, if you
paste an Analysis that contains a Variable that is not defined in the template, a new variable will be
created.
The example below shows the result of attempting to copy/paste the Analysis 'Steiner' from the
template 'Lateral ceph' to another template ('Lateral ceph. 1.3'). In addition to the Analysis, several
other elements need to be copied. If an element with the same name is already present, Viewbox
will propose to use it; however, you can use the drop-down listboxes to specify which element to
use or create a new one:
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Note: The elements of a dataset template can be viewed in the Template Browser.
No editing is available there.

6.1

Digitized points
Digitized points are the points that you digitize on the radiograph, e.g. point Sella, Nasion, etc.
Digitized points are usually located by the user during the digitization of the radiograph. However,
Viewbox can be configured to auto-locate some of them. Points that can be auto-located are those
that fall on an anatomic outline and are defined by such rules as "the most anterior", "the most
posterior", etc. Examples include point B, Pogonion, Menton, Gnathion, and others. To have
Viewbox auto-locate a digitized point, you first have to define a curve. The curve will be adapted to
an anatomic outline during digitization and is used by Viewbox to tell the shape of the anatomic
outline, since computers cannot yet see and understand a radiograph. The outline of the curve is a
mathematical curve and it can be used by Viewbox to find the cephalometric points by following
the rules that define them. See Curves for an overview of curves and digitized points.
Digitized points are defined and edited from the digitized Points dialog box, which can be opened
from the menu that pops-up when you right-click on the icon of a Template in the Icon area (see
Defining a Dataset Template):
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To create a new point
Click the New... button on the toolbar, enter a name and click OK.
It is strongly recommended that you also digitize the point at this stage. Use a sample image of a
radiograph that you have loaded (if you haven't loaded an image, it is recommended that you load
one now). Select the digitizer tool
and use the mouse to click on the Display.
There are 15 types of digitized points available.

6.1.1

Digitised points: Definition
The Definition page of the Digitized Points dialog box allows you to define the Type of point and
the appropriate parameters to auto-locate the point.
If the point is to be used as a 3D point, make sure that the 2D Locked on XY checkbox is NOT
checked.
If the checkbox is checked, then the point's Z coordinate will always be fixed to zero, i.e. the points
will always lie on the X-Y plane. Use this option for 2D data, e.g. photographs, radiographs, etc.
The following point Types are available:

Normal
This is a normal point that you digitize yourself. Viewbox cannot auto-locate this point. No other
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parameters are needed. Examples in the supplied Template 'Lateral ceph' include Nasion, Porion
and the apices of teeth.

Preset
The point is placed at a pre-defined location. Preset digitized points are very similar to Fixed
derived points but they can be moved, while derived points cannot.

Extreme
Points of this type are located on a curve. They are the points defined by rules such as "most
anterior", "most anterior and inferior", etc. You need to specify the curve on which to locate the
point, the part of the curve to use, the direction points and the angle. These are explained here
using Soft Pogonion as an example (see supplied Template 'Lateral ceph'):

Curve 1: Select the appropriate curve ("Lower Profile").
Point 2 and 3: These two points specify which part of the curve to use. The part of the curve
between the two points will be used for locating Soft Pogonion, the rest of the curve will be
ignored. Here we use the part of the curve that starts from point Soft Labiomental Fold and ends at
Soft Gnathion. If we do not specify the start or end point (<none>) Viewbox uses the whole curve.
Points 2 and 3 do not have to lie on the curve. If they do not, Viewbox will find the closest point on
the curve to each of these points and use that.
Point 4 and 5: These points specify the direction along which to locate Soft Pogonion. Here we use
the Frankfurt Horizontal (Porion - Orbitale) because we want Pogonion to be the most anterior
point on the Symphysis.
Angle: Specify an angle by which to modify the direction specified by Points 4 and 5. Here we use
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0 (zero) because we want the same direction as that specified by points Porion and Orbitale. In the
definition of Soft Gnathion, we use 45 degrees, because Soft Gnathion is the most anterior and
inferior point.
Note: The Angle makes sense for points in 2D. In case the points are in 3 dimensions, the angle is
defined as a rotation around the z-axis.

First Extreme
This is the same as Extreme but Viewbox finds the first point on the curve that satisfies the
conditions. For example, point B is defined as a First Extreme because we want the most posterior
point on the anterior outline of the symphysis but not the most posterior point of the whole
symphysis, which would be on the lingual aspect. An alternative would be to define point B as an
Extreme type but restrict the active curve area between points Infradentale and Pogonion.

Self Extreme
This is the same as Extreme but points 4 and 5 are not used. Instead, the direction is defined by a
the curve itself. It corresponds to a line that best-fits through all the points of the curve. The
direction of the line is from the center of the curve (the average position) to the starting point of the
curve. See Pogonion for an example:

The large red arrow pointing up inside the symphysis shows the direction of the best-fit line of the
symphysis, starting at the center of the symphysis. The red arrow at Pogonion shows the direction
at 90 degrees to the symphysis arrow (as specified in Angle). This direction is used to locate
Pogonion on the symphysis curve, starting at point B and moving along the curve until an extreme
position is reached.

Self First Extreme
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This is the same as First Extreme but, as in Self Extreme, the direction is defined by the curve
itself.

Lowest Curvature - Highest Curvature
A point located on the lowest curvature (flatter) part of a curve, or on the highest curvature part
(most curved). An example of Lowest Curvature is Protuberance Menti, which is located on the
symphysis where the curvature changes from concave to convex.

Centered
Points of this type do not lie on the curve but at the center of the curve, as determined by the
average of all the points that make up the curve. Examples are Sella and point D. Point 2 and Point
3 specify which part of the curve to use.

Curve Intersection
A point on the intersection of a line and a curve. The line is taken from Point 2 and is extended
along the direction of the line Point 4 - Point 5, modified by the Angle. See Soft Menton for an
example. This type will work in 2D only.

Walk (%) - Walk (mm)
The point is placed on the curve at a specified distance along the curve. Walk (mm) will place the
point at the specified distance from Point 2. Walk (%) will place the point at the specified
percentage of the distance from Point 2 to Point 3.

Object Extreme
The point is placed on an object (a Mesh or a Point Cloud) such that it is at an extreme position
relative to a direction defined by Points 1 and 2. The object must be loaded and set as the
Reference Object.

Random on Object
The point is placed on an object (a Mesh or a Point Cloud) at a random position. The object must
be loaded and set as the Reference Object.

Area Centroid of Object
The point is placed at the centroid ('center of gravity') of a Mesh object. The Mesh must be loaded
and set as the Reference Object. The centroid is calculated based on the surface area of the mesh
and not on the volume.
Once a point that depends on curves has been defined, you can click the Recalculate button
to check if Viewbox locates it correctly. Click Recalculate All to
recalculate all the points.

6.1.2

Digitised points: Edge lock
The Edge Lock page of the Digitized Points dialog box allows you to define the Edge Locking
parameters of the point:
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The edge locking parameters are used for setting the directional cursor and for automatic edge
detection and locking.
Search Range
Specify the width of the directional cursor in millimeters. Set to zero if you do not want a directional
cursor for this point.
Search Angle
Specify the inclination of the directional cursor. This is relative to the direction specified by Point 1
and Point 2, unless these have been set to <none>.
If Point 2 is set to <digitizer>, then the direction is defined from Point 1 to the location of the
mouse cursor during digitizing and therefore changes dynamically as you move the mouse on the
screen.
This feature can be used for points such as the posterior tangent to the lower border of the
mandible (Mandibular Tangent Post.). This point has been defined with Point 1 set to Menton and
Point 2 set to <digitizer>, so that the orientation cursor is always at right angles to the line joining
the mouse cursor to Menton.
Transition
Specify the type of edge you want Viewbox to search for. Most edges are bony contours and the
brightness of the image goes from a high value (bone) to a low value (soft tissue). This would be a
White to Black or a Black to White transition, depending on the direction of the cursor. Setting
the appropriate transition enables Viewbox to correctly identify the edge and not be distracted by
other nearby edges. However, keep in mind that if you invert the image during digitization, Viewbox
will loose the edge because the transition will now be the opposite.
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Lock Bias
Usually edges are not abrupt but extend over some distance, changing gradually from dark to bright
or vice-versa. Set Lock Bias to 0 to have Viewbox locate the middle of the edge, or set a positive
or negative number (-100 to +100) to locate the edge towards one or the other side.
Orientation Cursor only
Check this box if you do not wish to use Auto-edge locking for this point, but still want to use a
directional cursor. This has the same effect as turning off Edge Locking

6.1.3

during digitizing.

Digitised points: Relocate and Misc
The Relocate page of the Digitized Points dialog box allows you to define parameters for automatic
relocation of the point:

Relocation entails moving the point after it has been digitized. Points can be translated along a
direction, repelled by other points, or attracted by other points. Relocation is usually performed on
a Mesh object and in 3D. An example would be the lateral poles of the mandibular condyles. These
could be defined to repel each other. The user digitizes the points at approximate positions on the
mandibular condyles, then relocates them. Due to their mutual repulsion they will eventually settle
at the most mutually distant points of the condyles, automatically.
The Misc page of the Digitized Points dialog box allows you to define miscellaneous parameters of
the point:
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Hint Drawing
A drawing that will be shown when this point is digitized. Useful for showing guidelines to help in
locating the landmark. The incisor apex points of the supplied Template 'Lateral ceph' use a hint
drawing to draw the incisor while the apex is digitized.
Symmetry pair
If the object has symmetry, then you can specify which point corresponds to which point, based on
the symmetry plane of the object. This information can be used for creating a mirror object and
then computing the average of the original object and its mirror, to produce a perfectly symmetric
average.

6.2

Curves
Curves are used during digitizing. They can be adapted manually by the user, or automatically by
Viewbox, to conform to an anatomic outline. Then, they can be used to auto-locate points along
that outline. See Curves for an overview of Curves.
Curves are defined and edited from the Curves dialog box, which can be opened from the menu
that pops-up when you right-click on the icon of a Dataset Template in the Icon area (see Defining
a Dataset Template):
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Redistribute: Redistributes all points of the curve to be at equal distances from each other.
Project: Projects all points on the Reference Object.
Once a curve is created you can add points, change its shape or set its properties. The tutorial
shows how to do this using the symphysis curve as an example.
The Misc tab allows one to specify a symmetry pair of the curve, in case the object has mirror
symmetry. For example, if the object is the face, as seen from the front, a curve representing the
left eye would have the right eye as its symmetry pair. If the curve is itself symmetric, for example
the outline of the face, then specify itself as the symmetry pair. Symmetry pairs can be used for
creating a mirror image of the object and superimposing the original object to its mirror image, for
creating a symmetric average of the two.

6.2.1

Define curves - Tutorial
The following tutorial shows how to create a new curve and edit its shape. The curve could be
used to locate points on the first cervical vertebra.
Note: It is assumed that you have opened a Dataset Template and have loaded an image to help
you adjust the curve.
1. Open the Curves dialog box by right-clicking on the Template icon:
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2. Create a new curve and name it "Atlas":

3. Add points to the curve using the digitizer tool

© 2020 dHAL Software, Kifissia, Greece

:

283

284

Viewbox Help

4. Adjust the curve:
Change the number of points:

Delete and add points:

Adapt the curve automatically or manually:
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Derived points
Derived points are points that are automatically calculated by Viewbox and are not digitized from
the radiograph. The position of derived points is based on other points (digitized or derived).
Derived points are defined and edited from the Derived Points dialog box, which can be opened
from the menu that pops-up when you right-click on the icon of a Dataset Template in the Icon
area (see Defining a Dataset Template):

There are 29 types of derived points available.

6.3.1

Types of Derived points
There are 29 types of defined points. Most of these are self-explanatory and are accompanied by a
drawing to facilitate the setting of the various parameters.
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Fixed
The point has a fixed position. Specify the position by entering values in the X and Y boxes. Values
entered should be in millimeters from the upper left corner of the 2D Display or from the axes
origin of the 3D Display.

Midpoint
The point lies between two other points.

Projection
The point is the projection of a point on a line defined by two other points.

Intersection
The point is the intersection of two lines. Each line is specified by two points. If the lines do not
intersect (in 3D) then the point lies midway of the shortest distance between the lines.

Sweep Angle (2D)
The point is defined by sweeping a point by a specified angle around another point. This type will
produce unpredictable results if used with 3D data.

Circle/Sphere Intersection
The intersection of a circle with a line. The circle is defined by its center and a point on its
circumference. If used in 3D, a sphere is assumed instead of a circle.

Extension
The point is defined by drawing a parallel line to a specified line and moving along this parallel by a
specified amount (in millimeters).

Perpendicular
The point is defined by drawing a perpendicular line to a specified line and moving along this
perpendicular by a specified amount (in millimeters).

Sum
The coordinates of the point are the sum of the coordinates of two other points.

Difference
The coordinates of the point are the difference of the coordinates of two other points.

Product
The coordinates of the point are the product of the coordinates of two other points.

Average
The point is the average of other points. The points are specified by including them in a Graphic.
The graphic does not have to be drawn but it can have the Draw on Demand attribute set.

Circle (3 point)
The center of a circle defined by three points. If used in 3D, a sphere is assumed instead of a
circle.

Angle Bisector (2D)
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The point lies on the bisector of an angle specified by four points. More specifically, it is on the
projection of point 2 on the bisector of the angle. This type will produce unpredictable results if
used with 3D data.

Best Fit Line
The point is the projection of a point on a line that is the best fit line passing through a number of
points. The points are specified by including them in a Graphic. You can specify how many points
are required as a minimum for defining the best fit line by entering the number in the min box. For
example, if 3 is entered, there must be at least three valid points in the drawing that specifies the
best fit line, otherwise the derived point will be invalid.

Best Fit Plane
The point is the projection of a point on a plane. The plane is the best-fit plane to a number of
points. The points are specified by including them in a Graphic or a Curves.

Best Fit Plane Normal
Same as Best Fit Plane, but the point is the projection on the normal to the plane (the
perpendicular to the plane), which passes through the average of the points (the centroid).

Mirror on Line
The point lies on the opposite side of a line at the same distance as the reference point.

Interpolation
The point lies at a specified percentage of the distance between two points. If the dL value is
greater than 100 or less than 0, then the point will lie outside the line segment.

Area Centroid (2D)
The centroid of a Graphic. This is applicable for 2D graphic only.

Extreme, First Extreme, Self Extreme, Self First Extreme,
Lowest Curvature - Highest Curvature, Curve Intersection,
Walk (%) - Walk (mm)
These types are identical to those for Digitized points.

6.4

Areas
Areas are collections of points that can be used for editing a dataset (performing VTOs).
Areas are defined and edited from the Areas dialog box, which can be opened from the menu that
pops-up when you right-click on the icon of a Dataset Template in the Icon area (see Defining a
Dataset Template):
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Graphics
Graphics are used to specify how the tracing will be drawn.
Graphics are defined and edited from the Graphics dialog box, which can be opened from the menu
that pops-up when you right-click on the icon of a Dataset Template in the Icon area (see Defining
a Dataset Template):

© 2020 dHAL Software, Kifissia, Greece

Define Dataset Templates

289

Editing a graphic
There are 30 types of graphics. All graphics are defined by points or curves:

To add points to a graphic
Double-click on a point in the All Points or Curves list box, or click on a point in the All Points
or Curves list box to select it and then click the Include button.

To remove points from a graphic
Double-click on a point in the Points or Curves In Graphic list box, or click on a point in the
Points or Curves In Graphic list box to select it and then click the Remove button.
Graphics are drawing in the order that they appear in the drop-down list box. So, the graphic that
appears first in the list box is drawn first, thus appearing behind all other graphics. If you want to
change that order, so that a graphic is not hidden beneath another one, select it in the list box and
use the Rearrange button:

Other options that apply to graphics can be found in the Format section of the Graphics dialog box:
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Show In: Specifies in which of the two Displays the graphic will be shown (2D, 3D, or both).
Draw: Always: The graphic is always shown (if it is present in the selected View)
Draw: On Demand: The graphic is not normally shown. This option is used for graphics that are
used in Analyses, or graphics used for defining Derived points, Orientations, Superimpositions and
other Dataset Template elements. The graphic will be shown only in special circumstances (e.g. if
it is included in an Analysis, and the specific Analysis is displayed).
Colour: Specify a colour for the graphic from the list box, or set the graphic to have the colour
used for displaying a measurement (variable). Colours of measurements are specified in the
Options dialog box and vary depending on the specific patient's value in relation to the mean value
and standard deviation (see Colour-coding).
Line Width, Line Style, Fill Style: Set these to your preferences. Note: in the 2D Display, line
styles other than a continuous line can only be used if Line Width is 0. Fill styles apply only to
closed graphics (e.g. Polygon). Patterns in the Fill Style cannot be applied in the 3D Display.
Use for Morphing: Check this box if you want to use this graphic for morphing. When
performing a morph, Viewbox will change the image according to changes in the graphics that have
the Use for Morphing box checked. Other graphics are ignored. This option is usually set for the
graphics that display the soft tissues.
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Types of Graphics
There are 30 types of graphics. Most of these are self-explanatory.

Line
A line is drawn, connecting the points. If a point has not been digitized, there is a break in the line.

Line (no breaks)
As above, but if a point is missing there will be no break in the line.

Line (pairs)
The points are read in pairs and connected by lines.

Polygon
As in Line, but the figure is closed by connecting the first and last points.

Spline
A smooth line. This is a cubic spline.

Spline (no breaks)
As in spline, but if a point is missing, there will be no break in the spline.

Spline (closed)
As in spline, but the figure is closed be connecting the first and last points with a straight line
segment.

Spline (cyclic)
As in spline, but the end segments are curved so that the spline can be closed smoothly, without
sharp angles. Set the last point to be the same as the first point, in order to achieve this effect.

Markers
A marker is placed at each point of the graphic. The markers can have the following shapes: cross,
square, circle, diamond, triangle or inverted triangle. If used in the 3D Display, these will appear as
3D solids, i.e. cube, sphere, etc.
Note: This type of graphic replaces the types of Cross, Square and Circle, which were available in
previous versions.

PCA Consensus Markers
A marker is placed at each of the consensus points of the PCA. The markers can have various
shapes (see Markers above). Viewbox calculates the position of the consensus points by doing a
Procrustes superimposition of the consensus on the current dataset.

PCA Join Points
A lines is drawn, from each of the consensus points (see PCA Consensus Markers above) to its
corresponding point of the current dataset.

Pie
A segment of a circle is drawn. The center of the circle is at the second point and the radius is
specified in the Size box.

Pie (variable)
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A segment of a circle is drawn. The center of the circle is at the second point and the radius is
specified by the position of the fourth point.

Arc
An arc is drawn. The center of the circle is at the second point and the radius is specified in the
Size box.

Arc (variable)
An arc is drawn. The center of the circle is at the second point and the radius is specified by the
position of the fourth point.

Teeth:
The following teeth graphics are available:
Upper Incisor, Lower Incisor, Upper Molar, Lower Molar, Upper Second Premolar, Lower Second
Premolar, Upper First Premolar, Lower First Premolar, Upper Canine, Lower Canine, Upper
Incisor Frontal, Lower Incisor Frontal, Upper Molar Frontal, Lower Molar Frontal
Each has a Right and Left version that is set by the R and L buttons
. Each tooth needs two
points.
Note: Teeth are 2D drawings and will always be parallel to the xy-plane, when drawn in the 3D
Display.

Curve
A curve graphic can contain one or more curves. Each curve will be drawn by a continuous line.

6.6

Variables
Variables are cephalometric measurements.
Variables are defined and edited from the Variables dialog box, which can be opened from the
menu that pops-up when you right-click on the icon of a Dataset Template in the Icon area (see
Defining a Dataset Template):
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To edit a variable
First set the type of the variable. There are 45 different variable types, most of which can also be
used for measuring between two datasets.
Additional properties can be set from the Display and Normals sections of the Variables dialog box.

6.6.1

Types of Variables
There are 45 types of variables. Most of these are self-explanatory and are accompanied by a
drawing to facilitate the setting of the various parameters.
Depending on the type, variables are either a numeric value or a text value. Variables that are of a
numeric value can be used for additional processing. For example, the value of the angles SNA and
SNB can be used to derive the angle ANB.
Types marked by [R] can be used to calculate measurements between two datasets. For example,
you may wish to find the change in SNA angle between an initial and final radiograph. You can
define a measurement of the [R] Difference type and use 'SNA' and '[R] SNA' as the defining
variables. Viewbox will subtract the SNA angle of one radiograph from the other and report the
result. Points and variables that are marked by [R] refer to the Reference Dataset.
Note: For an [R] variable type to behave as expected, at least one of its defining
parameters must be designated as an [R] parameter. Otherwise the variable will
function as a regular variable, i.e. it will report the measurement of the current
dataset.
Note: If the points or the variables that are used to define a variable are not valid
for the dataset (for example, some points may not have been digitized), then the
variable will be reported as N/A (not available).
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Label
The value of the variable is equal to its name. Variables of the Label type can be used as headings
in the Text analysis window.

Constant
The variable is equal to its name. This type is useful for defining constants that can be used for
further processing. For example, you may want to calculate half of the SNA angle. To do this,
define a constant and set its name to 2. Then define a new variable of the ratio type and use the
constant there to divide the SNA measurement.
Note: If the constant is a fractional value, always use the dot '.' as the decimal
separator.

Angle180
The angle between two lines. The lines are defined by two points each. The angle will be reported
as a value between -180 and 180 degrees.

Angle360
Same as Angle180, but the angle is reported in the range of 0-360 degrees.

3D Angle 180
The angle between two lines in 3D. Reported as a value between 0 and 180 degrees.

3D Angle 90
The angle between two lines in 3D. The acute angle (0 - 90 degrees) is reported.

Distance1
The distance between two points.

Distance2
The perpendicular distance of a point from a line. This distance can be positive or negative
depending on which side of the line the point lies. If you are measuring in 3D use 3D Distance2
instead.

Distance3
The distance between two points, as measured along the direction of a line. Example: Wits
measurement is the distance between points A and B, as measured along the occlusal plane. This
distance can be positive or negative depending on the relative position of the two position in relation
to the line.

Distance4
The distance between two points, as measured along a perpendicular direction to a line. Example:
Upper face height is the distance between points N and ANS, as measured perpendicularly to the
Frankfurt horizontal. This distance can be positive or negative depending on the relative position of
the two position in relation to the line. If you are measuring in 3D use 3D Distance 4 instead.

3D Distance2
The same as Distance2 but, in 3D, this distance is always positive (a negative distance of a point to
a line in 3D does not make sense).
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3D Distance 4
The same as Distance4 but, in 3D, this distance is always positive.

Sum
The sum of two variables.

Sum (any)
The sum of two variables. If one of the two is not valid, the result will be the value of the other.

Sum4
The sum of four other variables.

Sum4 (any)
The sum of four other variables. If some of the four variables are not valid, the result will be the
sum of the others.

Difference
The difference between two variables.

Product
The product of two variables.

Ratio
The ratio between two variables.

Ratio (%)
The ratio between two variables expressed as a percentage.

Absolute
The absolute value of a variable.

Minimum
The smallest of two variables.

Maximum
The largest of two variables.

Square Root
The square root of a variable.

X Coordinate
The X coordinate of a point.

Y Coordinate
The Y coordinate of a point.

Z Coordinate
The Z coordinate of a point.
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Patient ID
This variable is equal to the ID of the patient.

Patient Name
This variable is equal to the name of the patient.

Patient Sex
This variable takes a value of 1 if the patient is female and 0 if the patient is male.

Patient Sex (text)
This variable takes a value 'Female' if the patient is female and 'Male' if the patient is male.

Date of Birth
Returns the date of birth.

Patient Age
Returns the age of the patient as a numeric decimal value.

Patient Age (text)
Returns the age of the patient as text, in the format specified in the Dataset section of the Options
dialog box.

Date Taken
Returns the date that the dataset was taken.

Magnification
Returns the magnification of the dataset.

Comments
Returns the comments.

Area
Calculates the area enclosed by a graphic or curve (assumed to be planar). If the graphic contains
curves, the result will be the sum of the areas enclosed by each curve.

Area Semi-plane
Calculates the area enclosed by a graphic or curve (assumed to be planar) that falls on one side of
a plane, as defined by three points. If the graphic contains curves, the result will be the sum of the
areas enclosed by each curve.

Length
Calculates the length of a graphic or curve. If the graphic contains curves, the result will be the
sum of the lengths of each curve.

Centroid Size and Normalized Centroid Size
Calculates the centroid size of a dataset as the square root of the sum of the squared distances of
the points to the centroid. A Shape needs to be defined, and the Shape's points are used. The
Normalized Centroid Size is the centroid size divided by the square root of the number of points.
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Procrustes distance
Calculates the Procrustes distance of the dataset from the consensus, after performing a
Procrustes superimposition (and rescaling to a centroid size of 1).

[R] Procrustes distance
Calculates the Procrustes distance of the current dataset from the reference dataset, after
superimpositing and rescaling both to a centroid size of 1.

Principal Component
Calculates the score of the specified Principal Component.

Principal Component (z)
Calculates the score of the selected Principal Component as a z-value (i.e. how many standard
deviations from the average, which is always 0).

6.6.2

Variables: Display properties

This section of the Variables dialog box allows you to set various options regarding the way the
measurement is displayed.
Text Before, Text After
Enter any text that you want to appear before or after the actual value of the measurement. For
example, if the SNA angle is 82 degrees, you may want to display this as:
SNA is 82 degrees
To do this, enter 'SNA is ' in the Text Before box, and ' degrees' in the Text After box.
The symbols @m, @s, @z have special meanings. If you enter them in the Text Before or Text
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After entries, they are replaced with the variable's mean value, standard deviation and z-score
respectively. More examples:
Text Before

Text After

Result

Angle =

(degrees)

Angle = 82.56 (degrees)

Wits:

(mm)

Wits: 4.2 (mm)

SNA (mean: @m)

(St. Dev. @s)

SNA (mean: 82) 82.56 (St.
Dev. 2.5)

Format
Select the number format for the variable. Formats 0.0, 0.00, 0.000, etc. will force a fixed number
of decimal digits, even if these are not required, while formats 0.#, 0.##, 0.###, etc. will only
display decimal digits if they are not zero.
Anchor
Select the point next to which you want the variable's value to be displayed. For example, the SNA
angle is usually written next to point Nasion. If this is set to <none>, the upper left corner of the
Display will be used.
Offset X, Y
Enter the distance from the Anchor point to the variable's value. Remember that the Y value
increases from top to bottom in the 2D Display. You can use the digitizer tool
to click on the
2D Display at the position where you want the variable to be drawn and the X and Y values will be
set automatically.
Align
Align the variable's value left, center or right.
Show In
Select if the variable will be shown in the 2D Display, 3D Display or the Text analysis window.
Show Name
If you want to include the variable's name before its value, check this box. The same can be
achieved by entering the variable's name in the Text Before edit box.
Text Style
Select the style that will be used for this variable in the Text Analysis window, or when printing.
Styles are defined in the Options dialog box.
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Variables: Normal values

In this section of the Variables dialog box you can enter the normal values for the measurement.
Normal values are entered separately for Females and Males. For each, you need to enter an age
range, the mean value for that age range and the standard deviation value. In the From column
enter the beginning of the age range in years. In the To column enter the end of the age range in
years. Age ranges do not have to be in ascending order. However, if you have entered overlapping
or duplicate age ranges, Viewbox will always select the first.

Notes:
Any invalid or incomplete entries will be ignored. Make sure that you enter valid numbers and that
you fill all four fields (From, To, Mean, St.Dev.) of each entry.
Normal values are used by Viewbox to display measurements in colour-coded way. Also, the graph
in the Text analysis window is based on the normal values and will not appear if there are no
normal values for the specific age and sex of the patient.
Tab-delimited values can be pasted using the Paste button of the toolbars.

6.7

Analyses
Analyses are collections of variables and graphics.
Analyses are defined and edited from the Analyses dialog box, which can be opened from the
menu that pops-up when you right-click on the icon of a Dataset Template in the Icon area (see
Defining a Dataset Template):
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To rearrange the analyses
Click the Rearrange
button to open the Rearrange dialog box. Use the mouse to drag the
Analyses to the desired order.

To add variables to an analysis
Double-click on a variable in the Available Variables list box, or click on a variable in the
Available Variables box to select it and then click the Include button.

To remove variables from an analysis
Double-click on a variable in the Variables in Analysis list box, or click on a variable in the
Variables in Analysis list box to select it and then click the Remove button.

To add graphics to an analysis
Double-click on a graphic in the Available Graphics list box, or click on a graphic in the
Available Graphics box to select it and then click the Include button.
Graphics included in an analysis usually have the Draw on Demand property set, so that they only
appear when the analysis is selected for display.

To remove graphics from an analysis
Double-click on a graphic in the Graphics in Analysis list box, or click on a graphic in the
Graphics in Analysis list box to select it and then click the Remove button.
Note: The graphics of the Analysis are drawn in the order that they appear in the Graphics in
© 2020 dHAL Software, Kifissia, Greece

Define Dataset Templates

301

Analysis list box. Therefore, each graphic will be drawn on top (and may cover) the graphics that
are listed above it. If you want to change the drawing order, drag the graphics up or down in the list
box with the mouse.

6.8

Superimpositions
Superimpositions are defined and edited from the Superimpositions dialog box, which can be opened
from the menu that pops-up when you right-click on the icon of a Dataset Template in the Icon
area (see Defining a Dataset Template):

To rearrange the superimpositions
Click the Rearrange
button to open the Rearrange dialog box. Use the mouse to drag the
superimpositions to the desired order.
There are 6 types of superimpositions.

6.8.1

Types of Superimpositions
There are 6 types of superimpositions. Most of these are self-explanatory and are accompanied by
a drawing to facilitate the setting of the various parameters.

Point to point
Superimposes two or more datasets so that point 1 of each dataset is coincident with the
corresponding point of the other datasets, and point 2 of each dataset lies on the line defined by
point 1 and 2 of the first dataset.

Centered angle
Superimposes two or more datasets so that point 1 of each dataset is coincident with the
corresponding point of the other datasets, and the angle formed by points 2 - 1 - 3 is centered
between datasets.
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Point - Lines
Superimposes two or more datasets so that point 1 of each dataset is coincident with the
corresponding point of the other datasets, and the lines defined by points 2 and 3 are parallel.

Best fit
Superimposes two or more datasets so that the sum of the squares of the distances between
corresponding points is minimized. The points taken into account are those that belong to the
specified graphic. The graphic need not be visible (see: Draw on Demand).

Best fit and scaling
Same as Best fit, but the datasets are also changed in size in order to achieve an even better fit.

Procrustes
Same as Best Fit and Scaling, but instead of using a graphic to define the points, it uses a Shape for
convenience.

6.9

Orientations
Orientations specify how the tracing is positioned in the Display.
Orientations are defined and edited from the Orientations dialog box, which can be opened from
the menu that pops-up when you right-click on the icon of a Dataset Template in the Icon area
(see Defining a Dataset Template):

To rearrange the orientations
Click the Rearrange
button to open the Rearrange dialog box. Use the mouse to drag the
orientations to the desired order.
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To edit an orientation
Select the orientation type and set its properties and options. There are 6 orientation types.

6.9.1

Types of Orientations
There are 6 types of orientations. Most of these are self-explanatory and are accompanied by a
drawing to facilitate the setting of the various parameters.

Set Horizontal
Rotates the tracing so that the line defined by points 1 and 2 is horizontal.

Set Vertical
Rotates the tracing so that the line defined by points 1 and 2 is vertical.

Set to Angle
Rotates the tracing so that the line defined by points 1 and 2 subtends a specific angle to the
horizontal. Use a negative value for the angle to rotate counterclockwise and a positive value to
rotate clockwise.

Fix on Points
Translates the tracing so that point 1 lies on point 3. Then it rotates the tracing so that point 2 lies
on the line defined by points 3 and 4. Usually, points 3 and 4 are derived points of the fixed type.

Best Fit
Moves the tracing so that the points that belong to Graphic 1 are aligned as best as possible to the
points that belong to Graphic 2. The procedure minimizes the sum of squared distances between
corresponding points.

<Align to Image>
This orientation is of a special kind and is used for aligning an image with a tracing in the Align
Image dialog box. See Align an image with a tracing for details of the procedure.

Options
An orientation may reposition the whole tracing or only part of it. You can select between the
following options:
All (except Preset): Moves all digitized points except those of the Preset type.
Selected only: Moves only the points that are selected when the orientation is performed. Thus,
different parts of the tracing can be repositioned every time.
Area: Moves the specified area.

6.10

Protocols
Protocols specify the order in which points are digitized.
Protocols are defined and edited from the Protocols dialog box, which can be opened from the
menu that pops-up when you right-click on the icon of a Dataset Template in the Icon area (see
Defining a Dataset Template):
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To rearrange the protocols
Click the Rearrange
button to open the Rearrange dialog box. Use the mouse to drag the
protocols to the desired order.

To add points to a protocol
Double-click on a point in the Points and curves list box, or click on a point in the Points and
curves list box to select it and then click the Include button.

To remove points from a protocol
Double-click on a point in the Points In Protocol list box, or click on a point in the Points In
Protocol list box to select it and then click the Remove button.

To rearrange the points of a protocol
Select a point in the Points In Protocol list box and drag it with the mouse to a new place in the
list.

Other options that can be set in a protocol are:
Auto Advance: Check this box if you want to move to the next point immediately after digitizing a
point. Auto Advance does not work for curves.
Beep on Advance: Make a beep tone after digitizing a point.
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Error margin: Set an error margin for multiple point digitization. When digitizing a point more than
once, Viewbox will make a beep tone if the distance between multiple digitizations is greater than
the error margin.

6.11

VTO Relationships
VTO Relationships specify the ratios used for automatically adjusting the soft tissues when the
hard tissues are moved in a VTO (see: editing, Auto VTO).
VTO Relationships are defined and edited from the VTO Relationships dialog box, which can be
opened from the menu that pops-up when you right-click on the icon of a Dataset Template in the
Icon area (see Defining a Dataset Template):

To edit a VTO Relationship
Select the Master point from the list box. This is the point that, when moved, will cause the
affected points to move. Then add points to the Points Affected list:

To add points to the Points Affected list
Double-click on a point in the All Points list box, or click on a point in the All Points list box to
select it and then click the Include button.

To remove points from the Points Affected list
Double-click on a point in the Points Affected list box, or click on a point in the Points
Affected list box to select it and then click the Remove button.
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The final step in editing a VTO Relationship is to specify the ratios of the movement between
Master point and Affected points. This is accomplished in the Movement section of the VTO
Relationships dialog box:

Enter the values as percentages (without the % sign). The example above shows that the lip will
follow the movement of the mandible by 70% when the mandible moves forward, by 50% when
the mandible moves backward and by not at all, when the mandible moves vertically.
If Treat Rotation as Translation is not checked, then the affected points will move as
specified in the % Rotation box, when the master point is rotated.
If Treat Rotation as Translation is checked, then the affected points will not be rotated when
the master point is rotated. Instead, Viewbox will calculate the effective translation of the master
point in the horizontal and vertical direction and translate the affected points according to the values
specified in the Percent Translation boxes.

6.12

Views
Views can be used to specify which parts of the tracing are visible in the Display. Views are
collections of graphics and variables.
Views are defined and edited from the Views dialog box, which can be opened from the menu that
pops-up when you right-click on the icon of a Dataset Template in the Icon area (see Defining a
Dataset Template):
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To edit a view
Check the graphics and the variables that you want to include in the view. Leave the others
unchecked.

To rearrange the views
Click the Rearrange
button to open the Rearrange dialog box. Use the mouse to drag the
views to the desired order.

Notes:
Viewbox has two views pre-defined:
<all>: Shows all variables and graphics. This is the default view.
<none>: Hides the dataset completely.

6.13

Shapes
Shapes are groups of points, used for morphometric analyses.
Shapes are defined and edited from the Shapes dialog box, which can be opened from the menu
that pops-up when you right-click on the icon of a Dataset Template in the Icon area (see Defining
a Dataset Template):
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To add or remove points
Click the check-box next to a point to select or deselect it. You can also right-click in the list box
and use the pop-up menu to select all points, deselect them all, or invert your selection.

Import Data...
Shapes use various data for analysis. Such data include:
Consensus: Coordinates of the points of the consensus shape.
Variances: Variances of the Principal Components.
Loadings: Loadings of each component on each of the X and Y coordinates of the points.
The data can be loaded from a text file by clicking the Import Data... button. Viewbox expects
the file to have a specific format. Shape data files can be created using the Procrustes and PCA...
dialog box. The recommended procedure for creating a new Shape and loading it with the
appropriate data is the following:
1. Create the Shape in the Dataset Template and specify the points that it uses (see above).
2. Save the Dataset Template.
3. Use the Procrustes and PCA... dialog box and create a new text file containing the necessary
data (make sure all options marked with an asterisk have been checked).
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4. Use the Import Data... button to load the data into the Shape of the Dataset Template.
5. Save the Dataset Template.

6.14

Sliding Groups
Sliding groups are used to specify how landmarks will slide.
Specify sliding groups using the Sliding Groups dialog box:

A landmark can be set as:
Fixed: Fixed landmarks do not slide but are used for establishing the warping field (thin plate
spline) that will be used for calculating the bending energy.
On Curve: Such landmarks slide on a curve. You need to specify a curve for each landmark.
Curves can be 2D or 3D.
On Surface: For landmarks that slide on a surface in 3D. Only one surface can be specified,
which will be used for all 'On Surface' landmarks. The surface will be specified during sliding
and not here (see Sliding Semilandmarks).
Free: Such landmarks are moved according to the warping field and are not attached to curves
or surfaces.
Ignored: These landmarks are completely ignored.
You can create as many sliding groups as you wish, and each can specify a different role for each
landmark. Only digitized landmarks can be set in a sliding group. For application of sliding groups
see Sliding Semilandmarks.
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Options
The Options dialog box is the main entry point for changing most of the user-configurable options.
Open it from the Options | Options... menu.
The Options dialog box contains 13 sections or pages:
General
o Icon area
View
o 2D
o 3D
Patient
o Dataset
o Image
Morphing
o Mesh
o Volume
Digitizing
Printing
Styles
Export
o to Word
o to Excel
o to PowerPoint
Dynamics
Hardware

7.1

General
The following options are available:
Default Folders

These folders specify where Viewbox will first look for various files.
Templates (VBRX and VBR files), the Dataset definition files (see
Dataset Templates). It is recommended that you leave this entry to the
default values.
Patient files (XML and CSV files): The files where the patients, datasets
and other data are stored.
Image files: Digital images of radiographs, photographs or volume data
(CT scans).
Texture files: Image files used for texturing meshes.

Check for
Updates

Select how often to check for updates of Viewbox.
When checking for updates, Viewbox tries to connect to the internet and
queries the web site www.dhal.com for the latest version number. If the
version number is higher than the currently running version, you will be
notified and asked to download the new version.
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No information is transmitted from your computer to the internet during this
procedure.
It is recommended to check for a new version at least monthly. Checking
occurs when the programme starts.

7.1.1

Icon area
The following options are available:
Patient, Dataset Changes the information that is displayed under each icon in the Icon area.
and
Object Icon
Label
Age Format

7.2

Set the format for displaying the patient's age.

View
The following options are available:
Show Area
Handle Names

If checked, the name of each area is shown next to its handle, when area
handles are visible.

Show
Measurement
Hints

If checked, information about each measurement will be displayed as you
move the Select/Move tool over the measurement:

Measurement
Formatting

These settings determine how Viewbox displays cephalometric
measurements that are outside the normal range. There are three format
options:
Colour-coded: Measurements are colour-coded. Colour depends on
how many standard deviations the value is from the mean.
Asterisks: Asterisks are appended to the value of the measurement,
depending on how many standard deviations the value is from the mean.
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Colour and Asterisks: Colour-coding and asterisks are used. This is
the default and recommended setting.
Colour schemes can be selected from the Colours button. It is
recommended to select a colour-impaired safe scheme (see Safe Use). The
Custom scheme can be customized to the user's preferences.
Grid settings

Specify the grid spacing and the grid colour. Visibility of the grid can also be
set from the View menu.

Ruler settings

Specify the colour for drawing the Ruler and Protractor lines. If Tick
Marks is checked then the Ruler is displayed with marks at millimetre
intervals along its length.

Markers

There are options for setting the size, shape and colour of the various
markers that are used in Viewbox.
Selection Markers mark the selected area that is moved during a
VTO:

Area Handle Markers are used for moving areas (see Translate and
Rotate).
Curve Markers are used during digitization of curves.

7.2.1

2D
The following options are available:
Font

Click on Font... to select the font that you want to use for displaying the
measurements in the 2D Display. If you select a TrueType font (e.g. Arial),
then it will be scaled according to the Zoom value (larger when zooming in
and smaller when zooming out). Fonts that are not TrueType (e.g. MS Sans
Serif) are not scaled properly. If you do not want font scaling then select a
non-TrueType font and set its Size to a small value, e.g. 8.
Note: This font is not used for printing the Text Analysis. Text Analysis
results are printed using styles, which are defined in the Styles page of the
Options dialog box.

Transparent

If checked then anything that lies behind the letters will show through.

Outline Fonts

If checked, then the font will have an outline of a different colour around the
characters. This makes them easier to stand out when an image is loaded
(e.g. a radiograph), otherwise black letters on a dark background do not
show. Click on Outline colour to select the colour for the outline.
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3D
The following options are available:
Background

Select between a one-coloured background or a background with a gradient.
Click the colour panels to set the colours. For rendering volumes in MIP or
Average (x-ray) mode, it is recommended to use a black uniform
background.

Axes Options

The most common type is a tripod axis (so that it is easy to see which is the
positive direction along each axis drawn in the Red-Green-Blue scheme,
where red corresponds to the x-axis, green to the y-axis and blue to the z-axis.

Font

Sets the font for the 3D display.

Specular
Highlights

Renders objects with a specular highlight that simulates reflection of the light
on the object and makes it appear shiny. This applies to objects that do not
have a specular setting of their own, so it does not apply to meshes and
volumes.

Sphere Quality Set the quality of the sphere objects. Spheres are drawn as markers, e.g. in
the PCA Viewer. Setting a low quality will result in faster drawing.
Draft
Rendering

7.3

If this option is set, then objects will be rendered at a low quality when they
are moved, or when the view changes, and will be redrawn at the default
quality when the movement stops. Useful for slow computers.

Patient
The following options are available:
Patient Default
Values

These values are placed as default values in the New Patient dialog box
when you create a new patient.

Remember latest If this box is checked then the Patient Default Values specified above will
not be placed in the New Patient dialog box when you create a new patient.
entries
Instead, the entries that were last entered will be retained. This option is
useful if you will be creating patients that have similar data, so that you can
enter only the data that is different and not have to re-enter everything.
Load Linked
Volumes with
Patient

7.3.1

If this option is not checked then Viewbox will not load linked volumes when
loading a patient. Loading of volumes may be time consuming and it uses a
lot of memory, so you may want to un-check this option when you are not
interested in loading the volumes.

Dataset
The following options are available:
Dataset Default
Values

These values are placed as default values in the New Dataset dialog
box when you create a new Dataset.

Default Template

Select the Dataset Template that you use most often.

Auto Orientate on
Loading

Check this option if you want each dataset to be orientated
automatically when loaded from a file. The default Orientation is used.

Zoom to Best Fit on
Loading

Check this option if you want to have the zoom adjusted automatically
each time a dataset is loaded from a file, so that the whole dataset is
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visible. See Viewing a radiograph.
Zoom to Best Fit on
Selecting

Check this option if you want to have the zoom adjusted automatically
each time a dataset is selected and made current, so that the whole
dataset is visible.

Auto Scale to Life
Size

Check this option if you want all datasets to be displayed at true life size
and not at the digitized size. Digitized size is the size of the dataset
(radiograph), life size is the size of the patient’s head. If you want to
print a tracing and superimpose it on the original radiograph, do not
check this box. Check this box if you want to superimpose two
radiographs that do not have the same magnification factor (e.g. they
were taken with different x-ray machines), or if you want Viewbox to
scale all measurements to the true life size. See: Dataset size.

Drawing Styles

Viewbox defines ten drawing styles for drawing datasets. The colour,
line style and line width for each of these can be set here.

Text Analysis

Set default setting for the Text Analysis windows.

Snap Dataset
Movements

Constrain movements to 1 mm and 1 degree increments.

Text to show when Enter the text that will appear when a measurement cannot be
measurement cannot calculated (e.g. some points may not have been digitized). This is 'N/A'
by default, but can be set to anything you wish, even nothing.
be calculated

7.3.2

Image
The following options are available:
Smooth pixels of
images

If checked, the images will not appear pixelated when zooming-in. If you
wish to see the actual pixels of an image, leave this un-cheked.

Image scaling

Image scaling determines how large the picture of the radiograph or
other scanned image will appear in Viewbox. In order to measure linear
distances properly, image scaling should correspond to the resolution used
during scanning. Viewbox can communicate with your scanner and
detect the resolution that you used, if Auto-detect resolution from
Scanner is checked.
Auto-detect can only be used for images scanned from within
Viewbox. If you wish to use images that you have scanned previously
and saved to your hard disk, then you should set the appropriate values in
the X and Y boxes. To arrive at the proper values, divide the number 254
by the resolution that you use to scan the radiograph. For example, if you
use a resolution of 150 dpi (dots per inch), divide 254 / 150 = 1.693. Enter
the number that you found in the Default Pixel size boxes.
Notes:
Recommended resolution for scanning cephalometric radiographs is 150
dpi. Do not use excessive resolution (e.g. above 300 dpi), because the
resulting image may be too large and could create problems, such as not
displaying in Viewbox, or slowing down your computer.
The values of Image scaling that are set in the Options dialog box are
used for all images. They should, therefore, be set for the most frequently
used image types (e.g. cephalometric radiographs). If you wish to scan
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or load an image that requires other values, you can use the Image |
Resize... menu command after the image is loaded.
DICOM files may contain additional information that pertains to the
image.

DICOM files

Set brightness/ Viewbox can adjust the brightness and contrast of the image to that
contrast to file recommended by the settings included in the DICOM file.
settings
Update Patient
data from file
Image Adjust
Parameters

7.3.2.1

Viewbox can read the patient's name, sex, date of birth and the image's
acquisition date, and update the Properties of the patient. Select the
desired update method.
(See Image functions)

Adaptive Size

Sets the size of the local area for Adaptive Equalise or Adaptive Auto
Levels. Size is set as a percentage of total image width.

Auto Levels
Cut-off

Sets the percentage of bright and dark pixels that are set to white and
black during the Auto Levels function.

CLAHE Limit

Used in the Contrast Limited Adaptive Histogram Equalisation filter. The
optimum value depends on the image on which this filter is applied. A
high value will make this filter behave similarly to the Adaptive Equalise
filter. A small value will not produce as much noise as the Adaptive
Equalise filter. A value from 10 to 20 is recommended.

Morphing

The following options are available:
Warping function: Select the mathematical algorithm for performing the warp (morphing) of the
image. Viewbox warps an image by observing how much the soft tissue outline has changed
between the initial and the prediction tracing. Images are distorted more at areas close to the soft
tissue outline and progressively less at areas far from the soft tissue outline. The first three
algorithms are similar, except for the function used to fade-out the warping effect on the image, as
the distance from the soft tissue outline increases.
Linear: The effect fades linearly.
S-curve: The fade-out follows an S-curve.
Exponential: The fade-out follows an inverse exponential function. Usually gives the best
results.
Triangle interpolation: This is a completely different algorithm than the other three. It divides
the image into triangular areas and interpolates the pixels inside the triangles. It is faster but not
of very high quality. This algorithm is used for the interactive morph window.
Depending on the function selected, additional parameters for fine-tuning are available.
Block size is used only when Morph Quality is set to Low. A low value gives best results but
speed suffers.

7.3.3

Mesh
These options are applied to meshes:
Auto-correct
Mesh Topology

If checked, will detect and attempt to correct mesh topology every time it
may have changed (e.g. when loading a mesh, after deleting part of a
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mesh). See Mesh Repair.
Default units

Most mesh files do not specify the units and, therefore, the actual size of the
mesh. Set the defaults here.

Backside
drawing

Set the mode the backside of meshes is drawn. It is recommended to set it
differently than Same as front, so that it is easy to distinguish which side
is which. The front side is the side that the normal vectors lie (see Work
with Meshes and Mesh Rendering).
Selecting Colour will paint the backside with the selected colour and any
textures or selections will not be visible on the backside of the mesh.

Marching Cubes Sets the marching cubes table that is used for creating meshes from
volumes. See Calculation details.
table
Mesh Merging

7.3.4

The settings to use for creating a mesh from several other meshes. See
Calculation details.

Volume
These options are applied to volumes:
Ray Sampling

Used for volume rendering. A high setting produces high quality results
but is slow. It is recommended to use 1 or 2 for normal viewing and
increase this to 3 if you wish to export a high-quality rendering (e.g. for
publication purposes). This is the default setting but can be changed
when viewing a volume.

Ray Jitter, Adaptive
Ray Step

It is recommended to have this options set, in order to achieve better
quality results.

Stepwise Rendering This is applicable when rendering a volume using the Software Engine.
Default Iso Colours

7.4

The default colours for the thresholds.

Digitizing Options
The following options are available:
Auto Centre during Digitizing: (useful only if you digitize on-screen) When you digitize a new
dataset, Viewbox will attempt to scroll the Display, so that the point that you will digitize next is
roughly in the centre of the screen. This allows you to digitize while the dataset is zoomed-in (so
that you can see the area of interest better) but without having to scroll around all the time.
Show Hint Graphic during Digitizing: Show a hint graphic when digitizing certain points, in
order to facilitate point location.
Multi-scanning: If scanning a radiograph with a scanner, you can ask Viewbox to scan the
radiograph multiple times in order to decrease noise. Select the number of scans and the noise
reduction technique. Four scans and Average method usually work best. Multi-scanning assumes
that your scanner is connected to the computer and is turned on. Do not remove or adjust the
radiograph during the scanning procedure, let Viewbox complete the scanning process first. This
function will reduce noise in dark areas of the image. It is mainly recommended for scanners that
do not have very good optical density. See relevant references.
Other options related to digitizing:
Input Device
Digitizing Cursor
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Digitizer Tablets

7.4.1

Input device

Before digitizing a new Dataset, make sure that you have specified the input device that you are
going to use. Viewbox can work with a digitizer or a scanner, and it can also load a picture of a
radiograph from your hard disk. Your method of choice should be selected in the Options dialog
box.

The most common options are:
Use digitizer

Select this option if you are using a digitizer to digitize the radiograph. This
option will not allow you to take advantage of some of Viewbox's advanced
features, such as Auto edge locking. Digitizers are rarely used because most
images (e.g. radiographs) or 3D data (e.g. 3D scans or CBCT images) are in
digital format and can be loaded directly.

Load Image
from File

If this option is set, then Viewbox will open a File dialog box and ask you to
select a picture file from your hard disk. The file should contain the image of
a radiograph that has been scanned and saved previously.

Use TWAIN
Scanner

Select this option if you wish to scan and digitize the radiograph from within
Viewbox. If this option is checked, Viewbox will connect with the scanner,
open the scanner's window and let you scan the radiograph.

Ask me before
digitizing

If this option is selected, then Viewbox will present a dialog box asking you
which of the above input methods you want to use, before each new
digitization. This is the default setting.

If Ask me before digitizing is selected, then Viewbox will open the following dialog box once
Dataset - New Dataset is selected from the main menu and the dataset is created:
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Check Use the same source next time to avoid showing this dialog box in the future.

Note:
The digitizer or the scanner should be turned on and properly connected to your computer
BEFORE starting Viewbox. Some scanners that connect to the computer through a SCSI interface
need to be turned on before the computer is turned on. Viewbox will report an error if it cannot
connect with the scanner.

Ask for Positional Adjustment:
This option is applicable only if you digitize using a digitizer. Leave it unchecked otherwise.
When using a digitizer and you want to digitize a radiograph again a second time (perhaps to add a
few points that were not digitized the first time), then it is improbable that you will position the
radiograph at exactly the same place on the digitizer. Viewbox can adjust for misplacement by
asking you to digitize two points that had been digitized before. It uses the coordinates of these
points to calculate the change in position and adjusts all new points so that they are properly
positioned.
If this option is checked and you are digitizing a Dataset that has been digitized before (i.e. some
points have already been digitized) then Viewbox will first ask you to digitize two previously
digitized points.

7.4.2

Digitizing cursor

You can select a cursor that is used when digitizing radiographs. The cursor can be a plain cursor
or an animated cursor. Viewbox comes with some sample cursors that you can choose from. Click
the Select Cursor... button and select a cursor from those available:
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Red Cross.cur
Red Circle.ani (animated cursor)
Default cursor, used if no other cursor is selected.

7.4.3

Select and configure digitizer

If you are planning to use a digitizer to digitize your radiographs, select it from the list and click the
Set As Default button. If your digitizer is not included in the list, you will have to add it and set its
properties.
To add a digitizer to the list, click the Add... button and enter its name.

Digitizer properties
To change a digitizer's properties, first make sure that it is already connected to your computer and
turned on. Then select it from the list and click the Properties... button. The Digitizer Properties
dialog box will open so that you can configure the digitizer:

Make sure your digitizer is properly connected to the computer and is turned on.
Some digitizers need to be turned on even before the computer is turned on.
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Click on Start Test.
Click with your digitizer stylus or cursor on the digitizer surface. Each time you click you should see
the X and Y coordinates change. They should be close to zero when you click on the upper left
corner of the digitizer and increase as you click towards the lower right corner. For each
centimetre change, the coordinates should increase by approximately 100. If the digitizer does not
respond as expected, see the next section.
How to Configure a Digitizer
Viewbox will communicate with any digitizer that outputs the coordinates in metric units, and only
when the button of its cursor is pressed. Viewbox does not work with digitizers that output
coordinates continuously. It should be possible to configure your digitizer in the correct way by
setting DIP switches or by using initialization commands (see below).
Following is a brief explanation of the various digitizer settings that can be changed from the
Digitizer Properties dialog box:
Use
WinTAB
Driver

Most digitizers include a driver that connects automatically with Viewbox and
configures the settings without any user intervention. If a WinTAB driver is
detected, check this option; this is the recommended option. However, if no
WinTAB driver is available, leave the option un-checked and configure the settings
on the left panel of the dialog box as described below.

Port, Baud Select the appropriate baud rate, COM port, parity, data bits and stop bits to use.
These values can be obtained from the digitizer manual. Try each available port in
Rate,
Parity, Data turn.
bits, Stop
Bits
Control
String

Enter the control string of your digitizer, which can be found in the manual. The
control string is the string that the digitizer will send to the computer each time you
digitize a point. It usually consists of 12 to 15 bytes, which are:
a flag byte, which shows the mode the digitizer is in and the button that was
pressed.
or 6 bytes for the x coordinate
or 6 bytes for the y coordinate
a terminating carriage return - line feed sequence
The above may be separated by commas or spaces in the control string. Viewbox
needs to know the position of the x and y coordinate data. The other data in the
control string are ignored. In Control String enter a representation of the control
string, where x shows a byte corresponding to data about the x coordinate and y
corresponds to data about the y coordinate (note that the x and y are lowercase
letters). Fill all other bytes of the control string with any other character, except
commas and spaces.
For example,
If your digitizer sends: XXXX,YYYY,FCL then enter: xxxxCyyyyCFCL
If your digitizer sends: FXXXXXX YYYYYYCL then enter: FxxxxxxSyyyyyyCL
Viewbox works correctly if the digitizer uses ASCII format in the control string.
Limited support is provided for packed binary format as well, but this will only work
if each coordinate is represented by only two bytes in the control string. Such a
format is used by the Numonics JOE digitizer, which seems to emulate the
Summagraphics digitizer. The control string is five bytes long. The first byte
contains information on which stylus button is pressed. The next two bytes contain
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the x-coordinate and the other two bytes the y-coordinate. To instruct Viewbox to
use packed binary decoding of the control string, use uppercase X and Y letters in
the control string, which, in this case should be FXXYY.
Initializatio Enter any commands that need to be sent to the digitizer, before digitizing any
points. These commands are described in the digitizer manual and may be needed
n
Commands to change the origin, the resolution, the digitizing mode or the units (metric or
English). Commands to set Point mode may be B or :PT. Commands to set metric
units may be :MT or f.
Resolution Enter the resolution of your digitizer in lines per millimetre. This can be found from
the manual. It is usually 10 or 100.
Y Origin

Enter the negative of the number that is displayed in Y coordinate, when pressing
the digitizer stylus at the upper left corner of the digitizer.

If you have the Numonics 2200 digitizer, the DIP switches must be set as follows:
Switch Bank A

Switch Bank B

1

Off (Open)

1

Off (Open)

2

On (Closed)

2

Off (Open)

3

On (Closed)

3

Off (Open)

4

On (Closed)

4

On (Closed)

5

On (Closed)

5

Off (Open)

6

Off (Open)

6

Don't care

7

On (Closed)

7

Off (Open)

8

On (Closed)

8

On (Closed)

Digitizer Troubleshooting
If you have tried to configure your digitizer using the digitizer's manual and have failed, try
experimenting in the way described below.
1. Erase all Initialization Commands that may be present. Set Resolution to 10 and Y Origin to 0
(zero). Set Baud Rate to 4800, Parity to None, Data Bits to 8, Stop Bits to 2. Set Control String to
A123456123456AB.
2. Select COM1 for the Port setting. Click on Start Test. If you get a "Unable to connect with
digitizer" error, then change COM1 to COM2, COM3 or COM4 until you don't get this error when
you press Start Test. In this way you will find the correct Port setting.
3. Click Start Test but don't press the digitizer button yet. If you see the X and Y coordinate values
changing continuously and/or you get various errors, then your digitizer probably outputs data
continuously. Give up until you read the manual to find out how to change this. Maybe you need to
change the position of DIP switches or use Initialization Commands. The most common
initialization commands for setting the digitizer in Point Mode are B or :PT. Try these in turn.
4. To find the correct values for Parity, Baud Rate, Data Bits and Stop Bits you will have to
experiment a lot and note the errors that are reported. Errors are not always consistent. However,
'Parity' errors usually mean that Parity is wrong, 'Framing' errors usually mean that Baud Rate or
Data Bits are wrong. Try the following values first, as these are the most common ones:
Parity: Odd, Even or None (Mark and Space are almost never used)
Baud Rate: 4800, 9600 (values below 2400 are very unlikely)
Data Bits: 7, 8 (Don't use other values here, you may get a 'Unable to build DCB' error)
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Stop Bits: 1, 2 (1.5 is almost never used)
5. Concentrate on getting Parity right first. It is usually easiest to get rid of the Parity errors. Then
go for Baud Rate. If the Received data contain incomprehensible characters then Baud Rate is
probably wrong, or the digitizer does not output data in ASCII format.
6. Hopefully you have found the correct values and do not get any errors when you click Start Test
and press the digitizer button a few times. Next, concentrate in getting the length of the Control
String correct. If you see that the Received string changes length each time you click the digitizer
stylus, then the length of the Control String is incorrect. If the Received string get longer each time
you click the digitizer, then decrease the length of the Control String by deleting the last character.
If the Received string get shorter each time you click the digitizer, then increase the length of the
Control String by adding a character at the end (any character is OK except for spaces, commas
and x, y, X and Y). Change the Control String until the length of the Received string remains
constant at each lick of the digitizer.
7. Press the digitizer button and note the Received: string that is displayed. You should see two
numeric values, one changing when you move the digitizer stylus horizontally and one when you
move it vertically. Note the position in the string that these values occupy and replace the
corresponding part of the Control String with x's or y's.
For example, if the Received string is R+00356-00289 when the digitizer button is pressed at the
lower left corner of the digitizer and changes to R+00389+03026 at the upper left corner, then the
00356 and 00389 values obviously represent the x-coordinate, while -00289 and 03026 represent
the y-coordinate. Therefore, change the Control String from A123456123456A to
AxxxxxxyyyyyyA (do not forget to put an x or y in the position of the + or - sign as well).
8. The X coordinate and Y coordinate values should now be displaying the correct values, each
time you press the digitizer button. Use known distances on the digitizer to check that these are
metric units. They are usually tenths of a millimetre or hundreds of a millimetre. If, when you move
the digitizer stylus a distance of 10cm, the numbers change by 1000, then all is OK. If the numbers
change by 10000, then change the Resolution to 100. If the numbers change by 4000 then set
Resolution to 40 (but beware, this is unusual and the digitizer may, in fact, be in English units
(inches)). If the digitizer outputs values in inches and you cannot change this with Initialization
Commands or DIP switches, then you can use the resolution to scale the units to mm. Use a value
of 39.37 or 393.7 or 3.937 (one inch has 25.4 mm and 1/25.4=0.03937)
9. The last thing is to set the Y Origin value. Position the digitizer stylus at the upper left corner of
your digitizer and press the button. Note the Y coordinate that is displayed. Enter the negative of
this number in Y Origin. You should see the X coordinates increasing from left to right, and the Y
coordinates increasing from top to bottom, both coordinates being close to zero (values less than
200 or 300 are OK) at the upper left corner of the digitizer.
We hope you have managed to configure everything correctly. Press OK to save the changes.
Sometimes you need to enter different values than those mentioned in the digitizer's manual. For
the Numonics digitizer we have used different Parity settings, we don't know why this is so. If you
need Initialization Commands for configuring the digitizer, preferably enter these on different lines
in the list box.

7.5

Printing Options
2D..., 3D..., Text...,
Extended...

Click the buttons to gain access to the printing options for the 2D,
3D, Text and Extended analyses.

Show deviation from
normal values

These settings are similar to the Deviation from Mean settings that
apply to viewing the dataset in the Display, but they concern the
printing of the tracing on paper. They exist as a separate option,
because you may have a black and white printer and may wish to
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use asterisks on the printed page but colour-coding on screen.

7.6

Styles Options
Fonts and styles
Each measurement in the Text Analysis and Extended Analysis window is displayed and printed
using a certain style. Styles specify the font used, the paragraph alignment, the indents, the colour
and whether to show asterisks or not. Each measurement is assigned a specific style from the 10
available. Styles are assigned to measurements when defining a Dataset Template. See: Defining
Dataset Templates.
Styles can be changed using the following controls:
1. Select the style you wish to change from the Style list box.
2. To change the font of the style, click the Font... button. It is recommended to use a nonproportional font for measurements, such as Courier. This will ensure that the Graph in the Text
Analysis window will display correctly.
3. Alignment and indents can be set from the corresponding controls.
4. If Use Variable Colour is checked, then the style will be colour-coded in a similar way to the
measurements that are displayed on the tracing. Otherwise, the colour of the font will be used.
Two styles are reserved:
Default Printing Style 11 can be used for printing all measurements disregarding the specific
style of each. To enable this option, check the Use Default Printing Style in the Options
page of the Text Analysis Options dialog box.
Headers / Footers Style 12 is used for the headers and footers, when printing.

7.7

Export
These options are used when saving the results of an analysis to a text
file, or when copying them to the Windows Clipboard. The Delimiter is
used to separate the values from one another. Use the Carriage Return /
Line Feed sequence (CR-LF) to have each measurement value on a
separate line.

Delimiter for
saving results:

7.7.1

Send to
Viewbox can send data to Microsoft Excel, Word and PowerPoint.

Microsoft Word
Word options are:
Variable Names

Check to include the names of the variables.

Normal Values

Check to include the average and standard deviation that corresponds to
the patient's age and sex.

Skip Labels

Skip variables that are of type Label (see variable types).

Microsoft Excel
Excel options are:
Use Current

Specify where the data will be sent.
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Workbook
Start New
Workbook
Open a Workbook
Variable Names

Check to include the names of the variables.

Normal Values

Check to include the average and standard deviation that corresponds to
the patient's age and sex.

Skip Labels

Skip variables that are of type Label (see variable types).

Start writing at

Specify the column and row to start writing the variables.

Microsoft PowerPoint
Powerpoint options are:

7.8

Use Current
Presentation
Start New
Presentation
Open a
Presentation

Specify where the data will be sent.

Place on current
slide
Place on Slide #

Specify on which slide to place the data.

Align to Centre of
Slide

Will align all objects to the centre of the slide.

Scale to Fit Size

Will resize all objects so that they fit inside the slide.

Hardware
Gamma correction in Check this if colours do not appear correctly. Default is un-checked.
Requires a Viewbox restart.
shaders
Multisample
Antialiasing

Check this for better quality rendering of meshes and datasets in the
3D display. Does not change rendering of volumes. However, if
checked, requires significantly more computer resources for rendering
volumes; you may experience memory problems or graphics problems
when rendering volumes with this option set.Requires a Viewbox
restart.

Image multi-scanning When scanning from a flatbed scanner, the resulting image may
contain noise, especially if it is a radiograph, in the dark areas.
Viewbox can scan an image repeatedly and average out the noise.
Select the number of scans and the method of averaging.
Multi-axis controller
sensitivity

7.9

Sets the sensitivity of the multi-axis controller, e.g. the 3dconnexion
SpaceNavigator device.

Dynamics
Collision resolution
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Increase it if you have surfaces that are uneven and you need
accuracy. Recommended values are between 100 and 200.
Allowable penetration Set the amount of penetration that is allowed between colliding objects.
A very small value (but not zero) is recommended, e.g. 5 microns.
depth
Velocity damping

Set this to a high value for more stability, but slower response.
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8

Miscellaneous

8.1

Calculation details and References
Here are some details on the internal calculations performed by Viewbox. Also, some references
related to cephalometrics and digital imaging:

Age
Age is displayed as either years:months or years in fractional format. For calculating age in the
fractional format, the number of days between the date of birth and the date that the dataset was
taken is divided by 365.2425, which is the length of the average Gregorian calendar year.

Mesh Decimation
Viewbox uses a half-edge collapse system together with a random multiple-choice method for
selecting the next half-edge. Before collapsing, the topology is tested to ensure that it will not
change. Also, a test is performed to avoid collapses that would result in non-manifold meshes.
Vertices on the boundary are not removed.

Mesh Smoothing
Mesh smoothing is accomplished by moving the vertices towards the average position of their
immediate neighbours. This method tends to reduce the overall size of convex objects.

Mesh Merging
Merging of two or more meshes to produce a single mesh is based on the work of Curless and
Levoy:
Curless B, Levoy M. 1996. A volumetric method for building complex models from range
images. Computer Graphics 30, Annual Conference Series, 303–312.

Sliding Semilandmarks
Sliding Semilandmarks are based on the work of Bookstein, Gunz, and Mitteroecker from the
following sources:
Bookstein FL, 1997. Landmark methods for forms without landmarks: morphometrics of group
differences in outline shape. Med. Image Anal. 1 (3), 225-243.
Gunz P, 2005. Statistical and geometric reconstruction of hominid crania: reconstructing
australopithecine ontogeny. Ph.D. Dissertation, University of Vienna. (also published as
"Semilandmarks in 3D" by Philipp Gunz, Philipp Mitteroecker and Fred L. Bookstein in the
volume "Morphometrics in Physical Anthropology" pp. 73–98, edited by Dennis Slice).
Semilandmarks in Viewbox slide along curves (see curves) or mesh surfaces, or volume
isosurfaces, and not on tangents calculated from neighbouring points, as described in the above
publications.
For additional info on the matrix calculations, see http://www.dhal.com/teachindex.htm.

Shape space and Form space
See the work of Mitteroecker et al.:
Mitteroecker P, Gunz P, Bernhard M, Schaefer K, Bookstein FL. Comparison of cranial
ontogenetic trajectories among great apes and humans. J Hum Evol 2004;46(6):679-97.

Bending Energy and Thin Plate Splines
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Bending energy is calculated using the following radial basis functions:
For 2D data: r2 ln(r2 ), where ln is the natural logarithm and r the distance between two points.
For 3D data: r.

PCA stopping criteria
Viewbox calculates the following stopping criteria for the number of meaningful principal
components to retain: the broken-stick criterion, the Rnd-Lambda and the Avg-Rnd, as described
in:
Jackson DA. Stopping rules in principal component analysis: a comparison of heuristical and
statistical approaches. Ecology 1993;74:2204-2214.
Peres-Neto PR, Jackson DA, Somers KM. How many principal components? Stopping rules
for determining the number of non-trivial axes revisited. Computational Statistics & Data
Analysis 2005;49:974-997.

Volume rendering
The MIDA volume rendering method is based on the work of Bruckner and Gröller, as described in
their paper:
Bruckner S, Gröller ME, 2009. Instant Volume Visualization using Maximum Intensity
Difference Accumulation. Computer Graphics Forum 28(3):775-782.

Other References
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dimorphism of the human mandible and its association with dental development. Am J Phys
Anthropol 2011;145:192–202.
19.Bartzela TN, Katsaros C, Bronkhorst EM, Rizell S, Halazonetis D, Kuijpers-Jagtman AM. A
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8.2

Dataset size
If a dataset is created by digitizing points on a conventional radiograph (e.g. cephalogram), then the
dataset will be larger than what it would be if it were created by digitizing the points directly on the
patient, because the radiograph has an inherent magnification factor. Viewbox can display datasets
at either the size that they were digitized (this is called XRAY size), or at their true life size (the
size they would have if there were no magnification).
To change between LIFE size and XRAY size, double-click on the Status Bar. The default setting
can also be changed from the Dataset section of the Options dialog box.

Notes:
Using LIFE size enables correct superimposition of radiographs that have been taken under
different magnifications. You must have entered the correct values in the magnification entry of
the dataset's properties (see Properties and Create a new dataset).
Using XRAY size will allow you to print the tracing of a radiograph at the same size as the
radiograph, so that you can superimpose it on the original radiograph. It will also produce
measurements that are identical to what you would get by measuring directly on the radiograph
with a ruler. LIFE size will give you smaller linear measurements.
The size setting does not affect the way that the radiograph is stored to the disk. Datasets are
always stored in XRAY size.
This option does not affect Dataset Templates. Also, during digitizing, a dataset is always at
digitized (XRAY) size.
Do not confuse this function with the Scaling function. Scaling will permanently alter the size of
the tracing irrespective of the setting of LIFE or XRAY.

8.3

Languages
Translations of Viewbox to other languages than English may be available. Select Help |
Language to select another language.
Please visit our web site to check for language updates and new translations.
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